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1.1 Objectives 

• Understand what is a Civil Terrain Model 

• Download LiDAR information for a Project Location 

• Learn how to display an Existing Civil Terrain Model 

• Learn how to export an Existing Civil Terrain Model 

1.2 Definitions 

A Terrain Model is a set of three-dimensional triangles mathematically computed from point data 

collected on the surface being modeled. Models are used to define highly irregular surfaces, 

particularly the surface of the earth, but can be generated for proposed surfaces, subsurface 

geotechnical layers, and etcetera. Terrain models are also referred to as digital terrain models 

(DTMs), triangulated irregular networks (TINs), or triangulated surfaces. 

The MicroStation Terrain Model tools support importing and labeling terrain contours and spots 

on terrain models. You can import a terrain model into a DGN to use its data. Terrain models 

imported from the LandXML file format are supported within MicroStation. However, any 

manipulation or importing from Civil products must be done within Bentley Civil.  Importing in 

MoDOT should not be necessary, as the Survey department provides all existing terrain 

information into a separate DGN file.  

1.3 Geographic Coordinate Systems 

Geographic Coordinate Systems are important to set when importing Terrain files or creating 

geometry in OPENROADS DESIGNER.  This helps in referencing in Bing Maps and getting 

Google Map images and creating KML files.  The use of GCS ensures that the project is in the 

right location for different types of projection. 

Geographic Toolbar 

May be found in the following locations: 

 

 

 
 

The Geographic Tab contains tools for interacting with a Global Positioning System (GPS) or 

Google Earth.  In this chapter we will only be discussing the Coordinate System tool for selecting 

the correct GCS for the project. 
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Select Coordinate System 

 

Select Geographic Coordinate System  

This tool is used to open the Geographic Coordinate System dialog, which is used to select a 

geographic coordinate system (GCS) from a library of predefined geographic coordinate 

systems. 
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Details 

This tool opens the Geographic Coordinate System Properties dialog box.  It is used to display 

the properties of a geographic coordinate system (GCS) that is attached to the MicroStation file. 

 

 

From Library 

This tool is used to select a geographic coordinate system (GCS) from MicroStation's library of 

predefined geographic coordinate systems. 

This is useful when: 

• Existing data was drawn in a geographic coordinate system (for example a state plane or 

country grid coordinate system) and you want to make MicroStation aware of that GCS. 

• Data is correctly drawn in one specified GCS, but you want to reproject that data to a 

different GCS. 

• You want to designate the GCS for a new design file. 
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CADD Support has provided groups called MoDOT Geographic Coordinate Systems, Modified 

Geographic Coordinate Systems (NAD 83, and Modified Geographic Coordinate Systems 

(NAD 83\2011) which contain the most commonly used coordinate systems for MoDOT 

projects, depending on the district boundaries. 

For projects that use a “modified” coordinate system instead of the standard coordinate system or 

“county wide” coordinate system, you will need to copy and modified the standard coordinate 

system to match the applied projection factor (grid to ground factor) for the project.  These 

“modified” geographic coordinate systems will be saved to the User Defined Coordinate 

Systems folder for future use. 
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1.4 Bing Maps Display 

Bing Maps can be used to display a live streaming map of the project location, if the Geographic 

Coordinate System has been applied to the MicroStation file.  

 

 
 

Once Geographic Coordinate System has been applied to the drawing, the Background Map 

Type option will now be available in the View Attributes dialog.  If the User switches the 

Background Map Type to anything other than None the background will change to show 

roadways and other information in the area.  This can be very helpful in laying out a project by 

showing existing features in the project corridor. 

 

 

 

 

 
 

The above example shows the Big Horn corridor with the correct Geographic Coordinate System 

applied and a terrain model imported at the correct coordinates. 
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1.5 Terrain Models and Feature 

Definition 

The display of terrain model properties can be 

controlled by using a feature definition. You can apply 

it to any terrain model. 

 

 

 

 

 

 

 

 

 

 

 

 

1.5.1 Applying a Feature Definition to a Terrain Model 

1. Open the MicroStation file where the terrain model resides. 

2. Use the Element Selection tool to select the terrain model. 

 

3. In the Heads-up display toolbox, select Properties. 

 

The properties dialog box allows for the modifications of display, terrain Feature Definition name 

and the type of Edge Method being applied to the terrain model. 
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1.6 Referencing Terrain Models 

People in different job roles may want to see terrains displayed differently. For example, a 

designer of surfaces may need to see triangles, while a designer of drainage features may need to 

see contours. Rather than duplicating the terrain model in various places, the best workflow is to 

maintain a single terrain model and reference it into other DGN files. 

When a DGN file containing a terrain model is referenced into another DGN file, you can allow 

the terrain model to be displayed differently in the other file. This allows the presentation to vary 

for different purposes, without changing the terrain model display in the original DGN file. 

To Override the Symbology of a referenced Terrain Model 

If a Terrain Model is attached as a reference, to override the terrain symbology do the 

following: 

1. Select the terrain model and from the pop-up tools select Properties 
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2. Within the Terrain Model Properties switch the Override Symbology option from “No” 

to “Yes”. 

 

3. Change other display properties as needed. 

The display of the terrain model changes in your DGN file according to these settings, but not in 

the original DGN file. 

 

 

 

 

 



Chapter 1 - Terrain Model  OpenRoads Designer Road 1 

1-10 Missouri Department of Transportation 9/12/22 

1.7 Overview of Civil Terrain Model 

Terrains Models (TM) play a key role in Infrastructure and Mapping workflows. The data 

collection methods underlying these models are ever increasing in detail and coverage. Therefore, 

resulting terrains need to be accessible across a variety of Infrastructure and Mapping workflows. 

Data in a variety of formats including raw graphical elements 2D and 3D can be provided for 

consumption into the terrain model. The existing ground terrain model can also be used as the 

starting point for the creation of a proposed design terrain model using the Corridor Modeling 

tools. 

1.8 Terrain Model Features 

The concept of feature types is used throughout the Terrain Model tools. The available feature 

types are defined below. 

1.8.1 Spot or Spot Elevation 

Points (with X, Y, Z data) that have no functional relationship to any other point. Random survey 

shots in open terrain would be an example of random spots. Point elements such as cells, circles, 

and text strings are typical MicroStation elements used to graphically define spot elevations, lines, 

 

line strings, and other longitudinal elements are equally valid. The software creates a spot 

elevation for each vertex of each longitudinal element. 

If a section is cut through this digital terrain model at the location A-A, where the elevation of the 

triangle leg as linearly interpolated between the triangle vertices is plotted along the distance of 

the section, the section would look as shown in the picture below. 
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1.8.2 Break Line 

Breaks are used to designate linear features such as edges of pavement, ditch bottoms, ridges, 

etcetera where an abrupt change of slope occurs. Any longitudinal element may be defined as a 

break line. Triangles will not cross a break line in the terrain model. 

Adding a break line to the same set of points (used in the above illustration) will produce the 

terrain model as shown below. 

 

Cutting a section at the same location will produce very different results as shown in the section 

below. 

 

1.8.3 Soft Break Line 

A soft break line is a break line; however, if it crosses a break line, it will not affect the 

triangulation and is ignored.  This feature type is not frequently used.  It can be used during 

survey collection to identify a feature that is a breakline, but is known to cross another break line, 

resulting in crossing breaklines. 
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1.8.4 Contour 

A contour is an element or set of elements of the same elevation. Contours may be used as source 

data to generate a terrain model, or may be computed (drawn based on terrain model).  For 

example, you may want to create a terrain model from digitized contours from an old plan. 

 

1.8.5 Hole 

An area defined by a closed shape that demarcates a region where the current terrain is ignored 

and the underlying terrain is utilized.  For example, holes can be used for marking areas where 

you would not want to disturb during a design. 
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1.8.6 Boundary 

A boundary is the maximum external limits a terrain model can extend.  No triangles will be 

created outside of this boundary.  For example, a boundary can be changed on a terrain model by 

deleting triangles or changing the Edge Method.  A new boundary can be added to an existing 

terrain model using the Add Features command. 

 

1.8.7 Drape Boundary 

A drape boundary is a surface boundary that determines its elevations by draping on the 

underlying surface. For example, you may use a drape boundary to limit the extent of the triangles 

by drawing the boundary as an element, using the Add Features command to add the boundary to 

the terrain model.  The new boundary would use the elevations of the underlying surface as the 

boundary elevations.  

1.8.8 Voids 

An area defined by a closed shape that demarcates a region of missing data or obscure areas. No 

point or break data located within the void area is utilized and no triangles are created inside the 

void areas. The Void coordinates are included in the triangulation and void lines between 

successive void coordinates are inserted as drape lines on the surface. Therefore, they do not 

change the slope or elevations of the surface. 

 

 

 

 

 

 

 
VOID 

AREAS 
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1.8.9 Drape Void 

An area defined by a closed shape that demarcates a region of missing data or obscure areas. No 

point or break data located within the void area is utilized and no triangles are created inside the 

void areas. In the drape void, the void coordinates are not included in the triangulation. Voids are 

inserted post triangulation. The void coordinates and lines are draped on the terrain model surface. 

Even though a user must provide an elevation for Drape Void vertices, the user elevations are 

changed to the elevation of the terrain model surface at the XY Drape Void coordinate position.  

For example, if you don’t have accurate survey data for the void area, you may want to use the 

drape void. 

 

1.8.10 Break Void 

An area defined by a closed shape that demarcates a region of missing data or obscure areas. No 

point or break data located within the void area is utilized and no triangles are created inside the 

void areas. It differs from Voids and Drape Voids in that it utilizes the vertex elevations of the 

graphical element, while the void lines between successive void coordinates are inserted as break 

lines. Therefore, break voids change the slope and elevations of the surface.  For example, if you 

have accurate survey data for the void area, you may want to use a break void.  These could be 

used for surveyed building footprints or ponds where the points have been accurately surveyed. 
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1.8.11 Islands 

An area defined by a closed shape that demarcates a region of data wholly within a void. 

Example, islands in the middle of rivers, lakes, etcetera.  

 

  

ISLAND 
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1.9 Triangulation Options - Edge Method 

Several of the terrain model tools utilize the triangulation options section where the Edge Method 

is specified. 

Many of the external edge triangles are thin and narrow and not representative of the surface. This 

is particularly evident where the edge of the data set is concave in nature. One approach to 

eliminate these triangles is the use of the Edge Method. 

The Edge Method defines which triangles around the edge of a Terrain Model get created. 

There are two options to control the edge triangles. The terrain model is updated dynamically 

when the Edge Method changes so if the results are not acceptable, change the value until the 

results are acceptable. Only triangles along the edge of a terrain model are affected by this 

parameter. Interior triangles are never removed. 

There are three settings for the Edge Method option:  None, Remove Slivers, and Max Triangle 

Length. 

None - No external triangles are deleted. Note the Maximum Triangle Side Length is ignored. 

There are no user defined parameters 

Slivers - Long, thin triangles are dissolved based on a formula hard coded within the software. 

Note the Maximum Triangle Side Length is ignored. There are no user defined parameters. 

Max Triangle Length - External triangles whose external edge is longer in length than the user 

specified distance are deleted. Note the maximum length does not apply to internal triangles, only 

those on the edge of the model. Specify the Maximum Triangle Length in master units. 
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1.10 Terrain Models in Properties (Element Information) 

As a terrain model is a MicroStation element, a wealth of information can be found in the 

Properties (Element Information) dialog. One important option is display on/off of terrain model 

features. For example, you can turn on and off the display of the contours, triangles, and voids. 

The element information can be accessed by selecting Properties icon off of the OpenRoads 

Modeling menu or by selecting the properties option from the context sensitive toolbar that pops 

up when the mouse hovers over an element when the Properties tool is active. 

Some of the items in the Element Information dialog are informational and cannot be changed.  

Some of the items can only be changed if you are in the MicroStation file that contains the Terrain 

Model.  Following are descriptions of the functionality of each tab in the Properties dialog. 

1.10.1 General 

This displays the terrain model Description and Name.  It also identifies the display symbology of 

the terrain model.  The symbology is only used if the Feature Definition was not defined during 

the creation of the terrain model.  You can also select a Feature Definition in order to change the 

display of the terrain model within the General tab. 
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1.10.2 Extended 

Allows you to set the terrain to Snapable or Not Snapable, Lock or Unlock the terrain, and view 

the model it is in, its creation date, and the modification state of the terrain. 

 

1.10.3 Feature 

Element Information will list the feature name and feature definition of the selected terrain model. 

 

1.10.4 Information 

Lists the X, Y, Z range of the selected terrain model. In addition, it has the number of each type of 

source features, i.e., the number of points, voids, or break lines. 
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1.10.5 Edge Method 

This displays the Edge Method used when creating the terrain model. 

 

1.10.6 Calculated Features 

Turns the display off or on for any data in the terrain model that is not source data. Example, 

triangles, high points, low points, and flow arrows. The change is immediately visible on the 

screen, it is not necessary to exit the file and re-enter. 

 

1.10.7 Source Features Display 

Turns the display off or on for any data that was used to create the terrain model. The change is 

immediately visible on the screen, it is not necessary to exit the file and re-enter. 
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Quick Properties of Terrain Models 

Selecting the terrain model using the Element Selection tool and clicking on Properties opens the 

terrain model Properties pop-up where you can set the maximum triangle length, turn on/off 

various graphical features and change the feature name and definition. 
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1.11 Terrain > Create Ribbon Menu 

                     

Terrain Model Create - Contains tools to create a terrain model from graphical elements, ASCII 

files, point clouds, LandXML, and import existing surface files. Tools are also available to merge 

two or more models together and/or to clip models. 

 

 Create From File creates a Terrain Model by importing an existing 

digital terrain model file.  Import options include Import Terrain Only, Import Features Only and 

Import Both.  Importing features only writes the features to the design file as MicroStation 

graphics not tied to the Terrain Model. 
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 Create Terrain Model from ASCII File creates a terrain model by importing from an 

ASCII file type using customized user file formats. 

 Create Terrain Model by Graphical Filter is an automated way of storing search 

settings for graphic elements to automate Create Terrain Model by Filter Elements. Uses the 

settings stored by Graphical Filter Manager  to create the terrain. The Graphic Filter Manager icon 

is located in the Terrain > Miscellaneous Ribbon. 

 

 

 

 

 

 

 

 

 

 

 

 Create from Point Cloud creates a terrain model from MicroStation Point Cloud data.  

The Point Cloud has to be attached to the dgn prior to being able to create a Terrain Model. 

1. Select OpenRoads Modeling >Drawing>Primary>Point Clouds. 

 

2. In the Point Clouds dialog, choose Attach  
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After manipulating or editing the Point Cloud (as needed), the next step is creation of the terrain 

model. The entire Point Cloud can be used, or the Point Cloud Presentation can be used to limit 

the import to certain classifications, or a fence may be placed in the area of interest. The fence 

should be placed prior to starting the tool.  
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Two tools are supported in the upper left corner of the dialog:  

Settings  Description  

Rename Terrain Model  
renames the specified Terrain Model.  

Remove Terrain Model  
removes the specified Terrain Model from the list.  

The following options are supported in the right pane of the dialog:  

• Terrain Models -options if there is already a terrain model in the active *.dgn file and how to 

combine with the data to be imported.  

• Filter - Filtering may be a useful option for large datasets.  

• Feature Definition - feature definition to be used for imported terrain. If none is selected, the 

terrain model is drawn using the active symbology.  

• Geographical Coordinate Systems (GCS) - If the software can determine the geographical 

coordinate system of the file to be imported, the fields are populated. If set to Unknown, the 

software uses the MicroStation design units. This section is used if the resultant terrain model 

needs to be in a different GCS.  

Filter by Tile TIN  

This tool supports two filtering algorithms. One is Tile based and the other Tin or triangulation 

based. From empirical studies, the tiling algorithm is faster and typically produces a 30% to 50% 

reduction in file size. The TIN algorithm typically produces a 70% to 90% reduction.  

The tiling algorithm is a recursive divide and conquer algorithm that divides the LIDAR data set 

into tiles. A best fit plane is calculated for each tile and LIDAR points are removed if they fall 

within the user set Z tolerance to the plane.  
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The TIN algorithm filters LIDAR points if they fall within the user set Z tolerance of the triangle 

planes. The TIN algorithm first tiles the LIDAR points into tiles with a maximum of 2 million 

points and then repetitively triangulates each tile filtering out points. This algorithm running on a 

1.67 GHz machine with 1 GB of memory will typically take about 12 minutes to filter 30 million 

LIDAR points.  

Settings  Description  

File Option  Tile or TIN filter  

Z Tolerance  Z Tolerance is common to both algorithms and is basically the variation in the Z 

coordinate that the surface is allowed to move during the filtering process. 

Typically for the first invocation of the filtering function, the Z tolerance should 

be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 0.5 for metric 

data sets. Depending on the outcome and desired result, the Z tolerance can be 

varied up or down.  MoDOT aerial LiDAR flown in 2019 had a vertical 

tolerance of 0.3ft 

 

Min. Tile 

Points (Tile)  

A tile will not be subdivided if it has less than this number of points. Typically 

set this to five.  

Max Tile 

Divisions 

(Tile)  

Allowable level of recursion allowed and is the number of times the initial tiling 

set can be subdivided. Typically set this to five.  

Start Tile 

Length 

(Tile)  

The LIDAR data set is initially divided into tiles of this size, prior to recursion 

to the minimum tile points. The setting of this parameter requires some 

knowledge of the distance between the LIDAR points, which requires an 

inspection of the LIDAR points in MicroStation to determine. Typically set this 

to 10 times the distance between the LIDAR points.  

Coarse 

Filters (TIN)  

Filters more points with some blurring of ridges and valleys.  

Fine Filter 

(TIN)  

Filters fewer points with less blurring of ridges and valleys.  

Reinsert 

Points (TIN)  

Reinsert points adds points back if the iterative filtering on the terrain removes 

points which are within the tolerance. For example, this process could remove 

points at the top of a hill and the second iteration could remove points around 

the high point making the point out of the thinning tolerance. The iterative 

process can happen a maximum of five times.  
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Workflow:  

1. Open or reference the DGN file containing point cloud.  

2. Set the view attributes of the cloud to display all points which are desired in the terrain model  

3. Optionally make a fence around points to extract.  

4. Start the Terrain from Point Cloud command.  

5. Filter, if desired.  

6. Set the feature Definition and Triangulation Option.  

7. Datapoint to accept and build the terrain model, named Point Cloud Surface_1 by default.  

8. Rename the terrain model, if desired.  

 Create from Elements creates a terrain model from 3D graphical elements.  The elements 

can be in a reference file. 

 Create Complex Terrain Model creates a new Complex terrain model by 

merging/appending multiple terrain models. 

 Create Clipped Terrain Model creates a terrain model by clipping an existing terrain 

model and providing an optional horizontal or vertical offset.  

 Create Delta Terrain Model creates a new terrain model using the difference between 2 

terrain models or a terrain model and a plane (elevation).  Vertical offsets can be assigned to the 

Terrain Models in the Terrain Model to Terrain Model method. 

 Create Terrain by Text Interpolation creates a terrain model from 2D graphics which 

also contain an elevation label. 

 Create Corridor Alternate Surfaces is used to manage alternate surfaces in the template.  

This command is useful for the generation of surfaces to be exported to Automated Machine 

Control LandXML files. 
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1.12 Export to XML for Electronic Deliverables 

 

The Electronic Deliverables require the Existing Terrain in an XML format.  This is achieved by 

Opening the 3D Existing Terrain DGN supplied by the Surveyor and using the Export to File 

tool in ORD. 

1. Set the Workflow to OpenRoads Modeling 

2. Select the Terrain Ribbon group 

3. Locate the Miscellaneous task group 

4. Select Export to File  

 

 

 

 

 

 

 

5. Select the Terrain Model from the drawing  

6. Save the XML 
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1.13 Import from XML 

 

Creates a TM by importing from an external file type. The following formats are supported for 

import:  

The import process supports multiple files of the same type to be imported at once. The import 

settings that are defined are generic to all files selected for import.  

Import Terrain Model dialog  

The Import Terrain Model dialog is modal form and does not allow interaction with the graphics 

environment once open.  
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Four tools are supported in the upper left corner of the dialog:  

 

Select Files to Import  

Displays the Select Files to Import dialog.  

 

Rename Terrain Model  

Renames the specified Terrain Model.  

 

Remove Terrain Model  

Removes the specified Terrain Model from the listing. Note it 

does not delete the terrain model.  

 

Fit View  

Places the entire specified Terrain Model within the active 

view.  

Several options are supported in the right pane of the dialog:  

• Terrain Models - options if there is already a terrain model in the active *.dgn file and 

how to combine with the data to be imported.  

• Filter - Filtering may be a useful option for large datasets.  

• Feature Definition - feature definition to be used for imported terrain. If none is selected, 

the terrain model is drawn using the active symbology.  

• Triangle options - specifies how to address the external triangles of the created Terrain 

Model  

• Geographical Coordinate Systems (GCS) - If the software can determine the geographical 

coordinate system of the file to be imported, the fields are populated. If set to Unknown, 

the software uses the MicroStation design units. This section is used if the resultant 

terrain model needs to be in a different GCS.  
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Terrain Models  

Tool Setting  Description  

Append to existing Terrain Model  When toggled on, appends to the selected Terrain Model 

in the *.dgn.  

When toggled off, a new terrain model is created, 

ignoring any other Terrain Models in the active file or 

referenced.  

Terrain Model to append to  Type the Terrain Model name or Select from the list of 

available Terrain Models.  

Available when Append to existing Terrain Model is 

selected.  

Filter  

Note the settings in this section vary depending on the file type of the source data.  

Select to reduce the number of data points imported to the TM then enter the Maximum Number 

of points value in the field provided.  

Tool Setting  Description  

Source File Units  If the software can determine the units from the data file, 

this field is populated. If it cannot determine the units, 

Unknown is displayed. The user can specify Unknown, 

Millimeters, Centimeters, Meters, Kilometers, Inches, 

Feet, US Survey Feet, Miles. If Unknown, then the 

design file units are used.  

For details on filtering, see Filtering.  
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Feature Definition  

Tool Setting  Description  

Feature Definition  No Feature Definition is default. Select from drop down 

menu the feature definition.  

Import Options  Creates design file elements according to the styles 

defined in the source file. The DGN is scanned and the 

first 15,000 elements found are added to the rule that is 

attached to the terrain model that gets created. Changing 

one of these elements affects the terrain model. All other 

elements found in the DGN are added into the terrain 

model but not added to the rule. Changing one of these 

elements does not affect the terrain model. A warning 

displays in the Civil Message Center if the limit is 

reached.  

Import Both - Creates terrain with features.  

Triangulation Options  

Setting  Description  

Edge 

Method  

No removal - No external triangles are removed.  

Sliver - Long, thin triangles are dissolved based on a formula hard coded within the 

software.  

Side - External triangles whose external edge is longer in length than a user 

specified distance are removed. The side option does not apply to internal triangles, 

only those on the edge of the model.  

Note: Selecting Import Features Only or Import Both limits the amount of editing that 

can be done in a terrain model. Triangle edges cannot be switched along features, nor can 

vertices be deleted. Importing features only writes the graphics to the design file without 

creating a terrain. Importing both, as implied, imports both the terrain model and its 

features. The graphics are not tied to the terrain model. MDT Best Practice is to import 

the terrain only. 
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1.14 Group Exercise: Preliminary Surface from The USGS National 

Map LiDAR 

For preliminary surface data, MSDIS has certain areas of Missouri covered for LiDAR (Point 

Cloud) data as does the USGS site.  This data may be downloaded and manipulated to produce a 

terrain model that can be used to give the designer a starting point in the design process.  Later, 

aerial or survey data should replace the preliminary terrain for more accurate solutions.  In this 

exercise we will visit the National Map (USGS) website and learn how to download the LiDAR 

data, look at the metadata and develop an existing ground surface.  MSDIS (Missouri Spatial 

Data Information Service) is also another location for LiDAR data but is limited to certain areas 

of the state and can be found at the following link: http://msdis.missouri.edu/ 

 

1. Within Roadway/data-1 folder select the following USGS link: 

https://viewer.nationalmap.gov/basic/ 

2. In the right National Map window, zoom and then double-click into Missouri at an area 

close to the project. 

 

 

 

 

 

 

 

 

 

 

http://msdis.missouri.edu/
https://viewer.nationalmap.gov/basic/
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3. In the Left pane, place a check mark in Elevation Source Data (3DEP) – Lidar, lfSAR 
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4. Verify a check mark is next to Lidar Point Cloud (LPC) 

 

5. In the Left pane, click Search Products  

6. Wait a few seconds and the Left pane will populate with LiDAR data the is available in 

the windowed area. 
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7. Click on the Thumbnail option to see what area is available. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. When the desired product is found, click on Download LAZ 

Note: LAZ is the same as LAS but compressed.  LAS file is an industry-standard binary 

format for storing airborne lidar data 

9. Click YES to the security warning if it pops up 

10. You may also have to allow Pop-ups for this site – Click on Options for the Site, choose 

Always Allow 

Note: You may need to click Start Over and begin the process again after allowing 

popups if the window freezes. 

11. Save As… save the LAZ file to the Desktop, and then drag the file into PW. 
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Note: When downloading data from USGS or MSDIS, the User will have to determine what the 

projection/datum the data is based on.  To do this the User will need to download the 

Info/Metadata and search for this information.   
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Note: Within several of the metadata files, you can see the datum/projection for the LiDAR data.  

We will use this datum/projection when creating a dgn file so that when the User imports 

the LiDAR information it lands geospatially correct.  Once the LiDAR information has 

been imported, the User can then create the preliminary surface terrain model from that 

data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. Open the following dgn file: Project_Limits_Preliminary_J5P3181.dgn 



Chapter 1 - Terrain Model  OpenRoads Designer Road 1 

1-38 Missouri Department of Transportation 9/12/22 

13. Create a new file named J5P3181_Point_Cloud.dgn (Use a 3D Seed file for terrain 

models).  In this file we will store the projects preliminary LiDAR data. 

14. Open the Coordinate System tool by selecting the OpenRoads Modeling 

Workflow ➔ Utilities Tab ➔ Geographic Section. 

15. Select “From Library” icon. 

 

16. From the folder MoDOT Geographic Coordinate Systems, select:  

UTM83-15 – UTM with NAD83/2011, Zone 15, Meter; Central Meridian 93d W 
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17. Select the option below switching the Storage Units from English to Metric. 

  

   

 
 

18. In Open Roads Designer (ORD) select OpenRoads Modeling > Home > Primary tools 

click the down arrow for Attach Tools and click Point Clouds 

 

19. Click File > Attach from the pull-down menu of the Point Clouds dialog 

20. Change the File name filter to “laz”. 

21. Select the downloaded LAZ file and click Open 
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22. This will open the Convert dialog in order to convert he LAZ file to a POD (POint 

Database) file that will be recognized by ORD.  Click the OK button. 

 

23. No Wizard, if asked by ProjectWise. Click OK 

24. Select the project’s data-1 folder to save the POD file in 

25. Click Save to create the POD file 

26. Fit the View 

This will attach the POD file to the DGN.  

Note: If the POD file comes in Red, simply export the POD file from ProjectWise to your 

local machine and attach it to the drawing. 
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27. From the View Attributes drop down, change the Point Cloud Style to Intensity 

  

 

Add in Mapping with Bing Maps 

28. Because Geographic Coordinate System has been applied to the drawing, you can access 

Bing Maps by opening the View Attributes dialog and within the Background Map 

section select Background Map Type ➔ Street Map 
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Creating the Terrain Model from the Point Cloud 

29. Create a new file named J5P3181_Terrain_Existing_Preliminary.dgn (Use a 3D Seed 

file for terrain models).  In this file we will generate a Terrain model from LiDAR data. 

30. Open the Coordinate System tool by selecting the OpenRoads Modeling 

Workflow ➔ Utilities Tab ➔ Geographic Section. 

31. Select “From Library” icon. 
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32. From the folder Modified Geographic Coordinate Systems (NAD 83\2011), select:  

CD - Miller 2011 - NAD83/2011 Missouri State Planes, Central Zone, US Foot 

33. After verifying the Current Geographical Coordinate System, close the dialog. 
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34. Attach the J5P3181_Point_Cloud.dgn file.  Because the active and the referenced file 

have different Geographical Systems, when attaching use the Attachment Method of 

Interactive.  
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35. Continue:  Then select Geographic – Reprojected for the Orientation. 

 

Once attached select Fit View 
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36. Within the View Attributes ➔ Point Cloud Styles, switch the Style to Classification. 

 

         
 

 

37. Selecting the Styles Properties button turn off all Classifications except for “Ground” 
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38. In the next step we are going to place a fence around the area of our project.  We will use 

this fence to define the limit of our preliminary terrain model. 

Attach the J5P3181 Preliminary Project Limits.dgn file, this file already has our 

Preliminary Project Limits defined.  Because the active and the referenced file have same 

Geographical Systems, when attaching use the Attachment Method of Interactive.  

Then select Coincident - World. 
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39) In the View Attributes dialog toggle on 

Line Weights and switch the 

Background Map type to Street Map 

Review that all files are lining up.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

39. After verifying the data is lining up, go into View Attributes dialog and within the 

Background Map section select Background Map Type ➔ None 

40. From OpenRoads Modeling > Home Tab > Selection, select the Fence tool. 
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41. For the Fence Type, use Element (Currently a BUG in the Software, use Shape Option) 

and then select the blue shape. 

 

42. From the OpenRoads Modeling workflow, select the Terrain Tab 
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43. From the Create section, choose Additional Methods pull-down, and select Create from 

Point Cloud 

 

Note:  The Create from Point Cloud tool will only utilize the visible elements of the 

Point Cloud to create the Terrain Model. 

44) Fill out the Create from Point Cloud dialog as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT%20Edition-v13/en/GUID-DF0E2C2B-5B05-4453-A461-4F1D3358C19D.html
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Create from Point Cloud dialog option explained below: 

Global Options: Go with default settings below. 

 

 

 

 

 

 

 

 

 

a) Terrain Models -options if there is already a terrain model in the active *.dgn file 

and how to combine with the data to be imported. 

b) Geographical Coordinate Systems (GCS) - If the software can determine the 

geographical coordinate system of the file to be imported, the fields are populated. 

If set to Unknown, the software uses the MicroStation design units. This section is 

used if the resultant terrain model needs to be in a different GCS. 

 

File Options: 

a) Feature Definition:  Existing Triangles 
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File Options (Continued): 

 

 

 

 

 

b) Filter: Always use TIN Filter option - Much slower than Tile option but gives 90% + 

reduction rates while maintaining TIN accuracy within desired values. 

c) Z Tolerance: Z Tolerance is common to both algorithms and is basically the 

variation in the Z coordinate that the surface is allowed to move during the filtering 

process. Typically for the first invocation of the filtering function, the Z tolerance 

should be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 0.5 for metric 

data sets. Depending on the outcome and desired result, the Z tolerance can be varied 

up or down.MoDOT aerial LiDAR flown in 2019 had a vertical tolerance of 0.3ft, for 

this metric data use 0.3 feet 

d) Granularity: Use Coarse which will filter more points with some blurring of ridges 

and valleys  

e) Reinsert Points: Always use Re-Insert Points option - After all the points are filtered 

out, a ‘final’ TIN is built from the remaining points. At this point in the process, all 

the discarded points are draped on this ‘final’ TIN … any discarded points that fall 

outside of the vertical tolerance are added back in and the TIN is rebuilt. This is a 

safety measure, allowing the re-inserting of points that may have been mistakenly 

removed. 

f) Test Filter:  Filter results will vary depending on the size of the fence shape. 

Click the Test Filter to see how much the number of points will be reduced. 

Filter results will vary depending on the fence shape you drew to create the POD file. 
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Triangluar Option: 

 

c) Edge Methoed: No Removal 

1) We are using the No Removal option because the shape we are using has 

no external angles less than 180 degress, thus no unwanted trangles will be 

created. 

d) Incude Spot Features 

 

45) Click Import. 

46. Detach the J5P3181_Point_Cloud.dgn and 5P3181_Preliminary_Project_Limits.dgn 

47. If needed, turn off Line Weights in View Attributes for easier viewing. 

48. Review the resulting triangles. 

49. Go into View Attributes dialog and within the Display Style and select Smooth: 

Shadows 
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52. Rotate the view around using Rotate View and AccuSnap 

53. Once finished reviewing the 3D surface, rotate the view to the Top View 

54. Go into View Attributes dialog and within the Display Style and select Wireframe 

55. Data point on the boundary of the Terrain Model and wait for the context sensitive menu 

to appear. 

   

Select Properties. 

56. Set the Feature Definition to Feature Definition > Existing Boundary 

57. Select File > Update Server Copy 
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1.15 Exercise: Preliminary Surface from the “Topo Import” tool 

For preliminary surface data, Bentley has introduced a new tool in Open Roads Designer 

2020 Release 2 called Topo Import. Users can simply identify an area in which their 

project is located and download terrain data from three different sources 

• ESRI - Geographic information system company (Best) 

• USGS - United States Geological Survey (Better) 

• SRTM - Shuttle Radar Topography Mission (Good) 

This data will create a terrain surface ready for Users to start designing.  Of course, this 

not meant to replace field collected data but when a designer needs a quick start just to 

help a User understand if this a good location for their project, 

1. Create a new file named J5P3181 Terrain from Topo Import.dgn (Use a 3D Seed file 

for terrain models).  In this file we will store the projects preliminary LiDAR data. 

2. Open the Coordinate System tool by selecting the OpenRoads Modeling 

Workflow ➔ Utilities Tab ➔ Geographic Section. 

3. Select “From Library” icon. 
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4. From the folder Modified Geographic Coordinate Systems (NAD 83\2011), select:  

CD - Miller 2011 - NAD83/2011 Missouri State Planes, Central Zone, US Foot 

5. After verifying the Current Geographical Coordinate System, close the dialog. 
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6. Attach the J5P3181 Preliminary Project Limits.dgn file, this file already has our 

Preliminary Project Limits defined.  Because the active and the referenced file have same 

Geographical Systems, when attaching use the Attachment Method of Interactive.  

Then select Coincident - World. 

 

 

7. Turn on the Background Map to view location of project.  Because Geographic 

Coordinate System has been applied to the drawing, you can access Bing Maps by 

opening the View Attributes dialog and within the Background Map section select 

Background Map Type ➔ Hybrid 

 

8. Using the Place Smart-line tool trace the entire circumference around the Project Limits 
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9. Next we are going to create a Preliminary Terrain using the Topo Import tool located 

under Open Road Modeling workflow ➔ Terrain ➔ Topo Import ➔ USGS Terrain 

 

 

10. After selecting the Topo Import tool, define the following: 

 

 

 

 

 

11. Next, follow the heads up prompts and “Locate the Element” and left-click to accept: 

 

 

 

 

 

 

 

 

 

 

 

 

12. Turn off the display to the reference file and delete the Project Limits Smart-line. 

Feature Definition: Existing Triangles 

Name Prefix:    USGS Preliminary Terrain 
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13. Review the resulting triangles. 

14. Go into View Attributes dialog and within the Display Style and select Smooth: 

Shadows 

 

15. Rotate the view around using Rotate View and AccuSnap. 

16. Once finished reviewing the 3D surface, rotate the view to the Top View 

17. Go into View Attributes dialog and within the Display Style and select Wireframe 

18. Data point on the boundary of the Terrain Model and wait for the context sensitive menu 

to appear. 

   

Select Properties. 

19. Set the Feature Definition to Feature Definition > Existing Boundary 

20. Select File > Update Server Copy 
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1.16 Exercise: Export Terrain to LandXML file. 

 

At the end of your project the User will need to export all surfaces (Proposed and 

Existing) to a LandXML file.  These files will be part of the CADD/BIM Deliverables 

provided to Construction. 

What Is BIM? 

• A Digital collaboration that transfers and builds on information from design through 

construction. The goal is to enhance decision making and improve the owner’s ability 

to manage their assets more efficiently and effectively throughout their lifecycle. 

• In short it’s a digital information sharing and asset management process. 

 

1. Data point on the boundary of the Terrain Model and wait for the context sensitive menu 

to appear.  Select the Export Terrain Model Pull-down. 

   

2. In the Export Terrain Model Pull-down select LandXML 

 

 

 

 

 



OpenRoads Designer Road 1 Chapter 1 - Terrain Model 

  
 

 

9/12/22 Missouri Department of Transportation 1-61 

3. Project Name: J5P3181 Terrain Existing Preliminary 

Project Description: Existing Ground 

Export Options: Export Triangles Only 

 

4. Accept all of the prompts from the dialog by left-clicking on the screen. 

 

5. When saving the file if you get the following dialog select No Wizard and then select 

OK. 
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6. Fill out Export Terrain Dialog as follows: 

 

7. Select File > Update Server Copy. 

 

 

 

 

 

 

 

 

 

 

 

 



 

3/28/23   Missouri Department of Transportation  

Chapter 2 

Horizontal Geometry  
2.1 Objectives .............................................................................................................................. 2-1 
2.2 Definitions.............................................................................................................................. 2-1 

2.2.1 Coordinate System ........................................................................................................ 2-1 
2.2.2 Points............................................................................................................................. 2-2 
2.2.3 Lines and Linear Elements ............................................................................................ 2-3 
2.2.4 Curves ........................................................................................................................... 2-3 
2.2.5 Spirals ........................................................................................................................... 2-4 
2.2.6 Complex Elements ........................................................................................................ 2-4 
2.2.7 Profiles .......................................................................................................................... 2-5 

2.3 Open Roads Preferences ........................................................................................................ 2-6 
2.3.1 Preferences (ORD Updated) ......................................................................................... 2-6 

2.4 Design File Settings ............................................................................................................... 2-8 
2.5 Features and Feature Definitions ......................................................................................... 2-10 
2.6 Design Standards ................................................................................................................. 2-11 
2.7 Viewing and Accessing Horizontal and Vertical Standards ................................................ 2-14 
2.8 Civil AccuDraw ................................................................................................................... 2-15 

2.8.2 Civil AccuDraw Overview ......................................................................................... 2-16 
2.8.3 Simple Linked Favorite Civil AccuDraw Workflow .................................................. 2-19 
2.8.4 Simple Un-Linked Favorite Civil AccuDraw Workflow ............................................ 2-20 
2.8.5 Station-Offset Linked Favorite ................................................................................... 2-21 

2.9 Civil Horizontal Geometry Commands ............................................................................... 2-22 
2.9.1 Point Geometry ........................................................................................................... 2-23 
2.9.2 Line Geometry ............................................................................................................ 2-25 
2.9.3 Arc Geometry.............................................................................................................. 2-27 
2.9.4 Offsets and Tapers ...................................................................................................... 2-31 
2.9.5 Reverse Curves ........................................................................................................... 2-32 
2.9.6 Horizontal Geometry Spiral ........................................................................................ 2-33 
2.9.7 Horizontal Geometry Modify ..................................................................................... 2-34 
2.9.8 Creating Complex Geometry ...................................................................................... 2-36 
2.9.1 Geometry Common Tools........................................................................................... 2-41 

2.10 Editing Horizontal Geometry ............................................................................................. 2-42 
2.11 Horizontal Geometry Properties ........................................................................................ 2-43 
2.12 Exercise #1 (Group): Ramp 4 Alignment .......................................................................... 2-44 
2.13 Exercise #2 (Individual): Route 54 Alignment .................................................................. 2-51 
2.14 Exercise #3 (Individual): Ramp 2 Alignment .................................................................... 2-59 
2.15 Exercise #4 (Individual): Ramp 4 Alignment “Advanced” ............................................... 2-62 





OpenRoads Designer Road 1  Chapter 2 – Horizontal Geometry     
 

3/28/23 Missouri Department of Transportation 2-1 

2.1 Objectives 

• Understand and use Feature Definitions 
• Create PI based horizontal geometry using the Complex by PI tool 
• Use the OpenRoads Technology heads-up display and element manipulators 
• Associate Design Standards with alignment geometry and review feedback when design 

standards are violated 
• Import geometry from native geometry database 
• Discuss using manipulators and handlers 

2.2 Definitions 

Civil Geometry is a dynamic, interactive, rules-based approach to geometry that provides an 
unprecedented level of associativity by preserving design intent, snaps and Civil AccuDraw input. 
The results of the tools are intelligent MicroStation graphic elements which can be dynamically 
edited and associations between elements are automatically updated.   

In addition, the result of using the Civil Geometry tools are graphical geometry elements that are 
stored as MicroStation elements. No external geometry file is required. The MicroStation 
elements serve as the geometry elements with additional intelligence applied to store the rules and 
associations. 

2.2.1 Coordinate System 
The Coordinate system is defined with XYZ Coordinates.  The X and Y Coordinates define a 
horizontal plane, while the Z Civil defines the vertical dimension.  All points in a civil geometry 
element are defined by at least an X coordinate and a Y Coordinate.  If an elevation is to be 
stored, the Z Coordinate will also be defined. 
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The XYZ Coordinates can also be referred to in Northing (N), Easting (E), and Elevation (Z) 
Coordinates.  The Northing Civil refers to the Y value, the Easting Civil refers to the X value, 
and the Elevation refers to the Z value. 

 

The user must be aware of the Coordinate system the data is in, and the Coordinate system that 
GEOPAK is using.  When referring to the XYZ coordinate system, the Coordinates are listed as 
(X, Y, Z).   When referring to the Northing, Easting, Elevation coordinate system, the 
Coordinates are listed as (N, E, Elev.).  When translating this to the XYZ coordinate system, the 
Coordinates would be (Y, X, Z). 

2.2.2 Points 
Points are defined by a single set of Coordinates.  Each point will have an X and a Y Coordinate.  
The point may also have a Z coordinate if an elevation is defined.   

Points can be stored from a set of Coordinates, or located from other elements.  To define a point 
from another point, a distance and direction need to be defined. 

 

Modifiers can be added to the direction and distance.  An offset can be applied.  This will locate 
the point at the specified distance and direction from the starting point, then perpendicular to the 
specified direction for the specified offset distance.  A positive offset will go to the right of the 
specified direction, and a negative offset will go to the left of the specified direction. 
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2.2.3 Lines and Linear Elements 
Lines are defined by a location point and a direction, and are infinite in length. 

Civil Geometry Linear Elements are a portion of a line that is defined by a beginning and an 
ending point. 
 

2.2.4 Curves 
Curves are a segment of a circular arc.  Curves can be defined by either the arc method (central 
angle that produces a 100’ arc) or chord definition (central angle that produces a 100’ chord).  
MoDOT uses the arc definition for all new alignments; however the chord definition has been 
used in the past, and may still be shown on old plans.  This is configured in design file settings > 
Civil Formatting. 

A curve has several points associated with it.  These points help to define the curve, and are 
stored automatically when the curve is stored. 

PC – Point of Curvature; Beginning of the curve. 

PT – Point of Tangency; End of the curve. 

PI – Point of Intersection; Point where the two tangents meet. 

CC – Circle Center; Point at the center of the circle from which the curve is segmented. 
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2.2.5 Spirals 
Spirals are a transitional curve.  Typically a spiral will transition from a tangent (infinite radius) 
to a specified radius defined by a curve.  Spirals can also transition between 2 specified radii as 
defined by 2 curves. 

 

Several points are also stored with a spiral.  They are as follows: 

TS – Tangent to Spiral Point 

SC – Spiral to Curve Point 

CS – Curve to Spiral Point 

ST – Spiral to Tangent Point 

PISCS – Overall Point of Intersection for the spiral-curve-spiral combination. 

 

2.2.6 Complex Elements 
Complex Elements are a combination of other elements.  They can consist of linear elements, 
curves, spirals, or other Complex Element.  Complex Elements can represent horizontal 
alignments, or the horizontal location of some element.  Complex Elements have stationing 
associated with them.  Locations along the Complex Elements can be determined by the 
stationing.  If the stationing is adjusted along the Complex Elements a station equation is used.  
The stations from the beginning of the Complex Elements to the first station equation are referred 
to as Region 1.  The stations from the first station equation to the second station equation or the 
end of the Complex Elements are referred to as Region 2. 
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2.2.7 Profiles 
Profiles are vertical alignments defined by stations and elevations.  They are associated with 
some horizontal plan element.  Profiles can be stored with or without vertical curves.  Profiles 
without curves generally represent the existing ground profile, or a ditch profile.  Profiles with 
vertical curves are generally used as proposed corridor. 
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2.3 Open Roads Preferences 

The seed files delivered in the workspace have MoDOT design file preferences configured. 

2.3.1 Preferences (ORD Updated) 

 

This dialog provides settings for the cursor prompt, manipulators, and various operational toggles.  
Enable this dialog from the File > Settings – User > Preferences menu and selecting the View 
Options-Civil category. 
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Manipulator Settings 

These settings allow the user to control the settings and symbology of the civil geometry 
manipulators and any associated text. 

Superelevation Settings 

When the super elevation components are drawn into the design file, these two options allow the 
user to specify whether they are to be drawn as Color Shaded Fill or Boundary Only. 

Survey Locator 

This setting is used by the Survey tools to control the display and symbology of the locator. 

Survey Maximum Error Ellipse 

This setting allows the user to specify a major error ellipse value with regard to the standard 
deviation resulting from a Least Squares Adjustment. Any standard deviation exceeding this 
limit results in a graphical flag based on this symbology. 

Survey Medium Error Ellipse 

This setting allows the user to specify a medium error ellipse value with regard to the standard 
deviation resulting from a Least Squares Adjustment. Any standard deviation exceeding this 
limit results in a graphical flag based on this symbology. 

Survey Minimum Error Ellipse 

This setting allows the user to specify a minimum error ellipse value with regard to the standard 
deviation resulting from a Least Squares Adjustment. Any standard deviation exceeding this 
limit results in a graphical flag based on this symbology. 

Aquaplaning Settings 

This setting allows the user to specify a low risk upper limit up to a high risk upper limit. 
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2.4 Design File Settings 

  

Design File Settings dialog provides options for civil settings that control civil annotation within 
the design file. Enable this dialog from the File > Settings – File > Design File Settings menu and 
selecting the Civil Formatting category. 

• Coordinate Settings 

Controls the display and precision of their coordinates within any of the civil dialogs. In 
addition, this setting also controls how any inputted coordinates are interpreted. For 
example, if set to “X, Y” then all coordinates are interpreted and displayed as being in 
the “X, Y” format. If set to “Nothing, Easting” then the same applies. 

• Ratio Settings (Distance: Offset) 

Controls the display and precision of ratios within any of the civil dialogs. In addition, 
this setting also controls how any inputted ratios are interpreted. For example, if set to 
“1:D” then all ratios are interpreted and displayed in this format (1:100, 1:50, etcetera). 
If set to “D:1” then the ratios are similarly displayed and interpreted (5:1, 10:1, etcetera). 
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• Station Settings 

Controls the format, delimiter and precision of the station values to be used and 
displayed in the civil dialogs.  Equation can be set to: 

By Name - This is the standard InRoads presentation (A100+00, B105+00, etcetera). 

By Index - This is the standard GEOPAK presentation (100+00 R 1, 105+00 R 2, 
etcetera). 

• Radius Settings 

Degrees of Curve Method - Two options are available, Arc and Chord. 

Degree of Curve Length - This sets the standard definition of a 1 degree of curve. 

Radius Toggle Char - This allows the user to specify which character will be used 
within the civil dialogs to ‘toggle’ between a radius definition and a degree of curve 
definition. The letter d is the default setting. 

• Profile Settings - Controls the precision and display or input formats of slopes and 
ratios within a profile context. In addition, sets the default Vertical Curve Parameter 
Format (Radius, K Value or M Value). 
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2.5 Features and Feature Definitions  

Access the Feature Definitions Toggle Bar from the Geometry Ribbon in the OpenRoads 
Modeling Workspace.  

 

Having the Definitions Toggle Bar open and available is very useful for expediting the association 
of a feature definition to a new geometry feature. 

 

Feature definitions are used to define options when creating features. These are the items which 
are created in advance, usually used across multiple projects, and define symbology, annotation 
and quantities. The feature definition is assigned (usually) in the plan model, and optionally in 
profile and 3D feature definitions. 

A Feature is anything that can be seen or located and is a physical part of your design representing 
a real-world entity. Examples include curb and gutter, pavement, power lines, trees, etc. 

A feature’s definition is one of its properties. At any given time in the design process, the feature 
will have horizontal geometry, vertical geometry, 3D geometry or a combination to define its 
location. Generally, the feature’s definition is assigned at time of creation, but can be assigned 
after-the-fact. 
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Most Civil tools have entry fields for Feature Definition in their dialog as illustrated below. 

 

The rules applied to Feature Definitions are: 

• If no Feature Definition is selected, the active MicroStation symbology is used and no 
feature is defined, but you can define a Name Prefix. 

• If a Feature Definition is assigned, a Name Prefix is applied, and the symbology, 
attributes, and annotation defined in the feature definition are applied to the element. 

2.6 Design Standards 

 

Design standards are used to monitor required curvature and other alignment checks on horizontal 
Civil Geometry elements and slopes and K values on vertical geometry elements.  The standards 
are stored in a design library (DGNLIB) which can be read-only and stored in a central location 
for use by all users and referenced by the configuration variable MS_DGNLIBLIST. A DGNLIB 
is an empty file (does not contain any MicroStation elements) similar to a seed file where you can 
set up various MicroStation and Civil resources. An organization can utilize numerous DGNLIBs 
to facilitate management of their standards. For example, horizontal and vertical standards could 
be stored in one DGNLIB while other standards would be defined in other DGNLIBs. If utilizing 
both Metric and English units, you may want a separate DGNLIB for each. 

The standards are set up within the Explorer. Note the hierarchy from the Explorer is mirrored in 
the Design Standards Tool Bar pick lists. The hierarchy is customizable to conform to your 
organization’s standards.  As most organizations utilize AASHTO standards, the default libraries 
included in the installation package are based on the 2001 and 2004 versions of  ”A Policy on 
Geometric Design of Highways and Streets.” 

The Explorer is accessed by selecting The Drawing Ribbon > Explorer icon .It is more efficient 
to complete the vertical standards first, as they are referenced when building the horizontal 
standards. 
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Right-click on the individual entry and select Properties from the pop-up menu to review the 
settings 

 
Horizontal Design Standards Properties 4 Lane example 
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Vertical Design Standards Properties 
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2.7 Viewing and Accessing Horizontal and Vertical Standards 

The Design Standards branch lists the design standards that are available within the active design 
model or a DGN library. The Design standards defines Design standards that are used to assist the 
designer in maintaining required curvature and other checks when performing geometric layouts 
and are normally based on accepted standards for a geographic area or authority, these standards 
are stored in DGN libraries. 

The properties for each Horizontal standard are: 
• Design Values 

Speed - this is the design speed for the standard. 
Default Radius - this is the radius used to populate commands when initiated. 
Minimum Radius - this is the minimum radius for the corresponding design speed.  
Utilizing values lower than this radius will cause a warning to be displayed. 
Transition Type - can be by Table or Equation. 
Table - If transition type is table then this is used to populate the table.  
Include Transitions 
Check Tangency 

• Arcs 
Maximum Arc Length 
Minimum Arc Length 

• Tangents 
Maximum Tangent Length 
Minimum Tangent Length 
Maximum Deflection - the maximum angle between the lines where two tangents join 
without a curve. 

The properties for each Vertical standard are: 
• Vertical Design Standards 

Minimum slope 
Maximum slope 
Maximum difference in grade 
Vertical Table Type 
Table  
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2.8 Civil AccuDraw 

Civil AccuDraw performs many of the same functions as MicroStation AccuDraw but has greatly 
expanded capabilities for the civil designer. It allows the user to define a point location at any 
stage of any placement tool (MicroStation or Open Roads) and accept input that results in more 
sophisticated point locations. 

  Accessing Civil AccuDraw 

Civil AccuDraw can be accessed from Geometry Ribbon> Civil Toggle pull down > Civil 
AccuDraw 

 
 

Benefits 

There are many benefits in using Civil AccuDraw. 
1. It extends the drafting power of MicroStation by providing Civil point location 

methodologies in all the MicroStation and Civil commands. For example, a user 
will be able to place a cell at an offset using the normal place cell but invoking 
Civil AccuDraw to enter the station and offset. 

2. It will eliminate the need to create temporary construction geometries just to 
perform more complex point locations. For example, to place a line at a given 
distance from 2 points a user would need to draw 2 circles at each point with the 
desired offset as the radius of each station and then place a line tangent to these 
circles, and finally delete the unwanted circles. Civil AccuDraw provides a 
Distance from Point snap where the point can be identified, the offset entered, and 
the data point applied to the construction. 
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Sets the elevation ordinate 

ProfileOffset 

3. When used in conjunction with the Civil Geometry commands the resultant 
elements are constrained by rules set by the selection of the Civil AccuDraw 
ordinates. 

4. The Civil Geometry heads up display options are enhanced when Civil AccuDraw 
is active and the options available are determined by the method selected. 

Use Tips with the Geometry commands 
1. Selecting the Tab key while in an entry field will change focus. 
2. Selecting Enter will set the value in the field and lock it 
3. Selecting the End key will unlock the field 
4. Selecting the left or right arrow key will move through the favorite options. 
5. Selecting the down key will bring up the associated command entry dialog in 

addition to the heads up display. 
 
 

2.8.2 Civil AccuDraw Overview 

 Toggle Civil AccuDraw on/off. 

 

 Drop down list of various tools including Civil AccuDraw settings and common 
shortcuts.  This drop-down is also available by pressing space bar when any Civil 
AccuDraw field has focus. 

These are the ordinate systems delivered in a default installation.   

• Distance – Direction 
• Distance – Direction Unlinked with two origin points 
• Distance – Distance 
• X – Y 
• Dx – Dy 
• Station – Offset 
• DeltaStation-Offset 

In a three-dimensional design file there are two additional icons 
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Some differences between the MicroStation AccuDraw tool and the Civil AccuDraw tool:  
a. Civil AccuDraw compass will always point north regardless of view rotation. 
b. Civil AccuDraw uses a heads-up on-screen prompt at the cursor to allow 

precise key-in of distance and direction.  A fixed dialog box becomes 
available when the down arrow is selected. 

c. The Civil AccuDraw compass will always be circular.  MicroStation 
AccuDraw changes the compass to rectangular for Cartesian ordinate systems. 

 Civil AccuDraw Settings 

The Operation tab is like that of MicroStation 
AccuDraw. 

• Operations of the same name have the same 
function in both AccuDraws. 

• Selection or de-selection in one AccuDraw 
does not affect the selection in the other 
AccuDraw. 

• Selecting the Show AccuDraw Dialog will 
result in the dialog and the heads up display 
both being available to the user during element 
placement. 

 

 

 

 

The Display tab contains settings for: 

• Color of compass axis 
• Points configures the number of points in the 

compass circle 
• Color of the constraint lines 
• Whether you want to see the constraint lines 

and color of the constraint lines 

 

The shortcut button brings up the same shortcut list as 
used by MicroStation AccuDraw. 

Both MicroStation AccuDraw and Civil AccuDraw 
access the same shortcut.txt file. 
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The Coordinates tab contains the same round off and indexing settings as MicroStation 
AccuDraw and function the same way.   

• Civil AccuDraw has additional settings 
that are provided to allow the round-off 
of station and offset values. 

• The numbers must be changed to values 
other than zero to be accepted. 

 
 
 
 
 
 
 
 
 
 
 
 
 

The Favorites tab allows for the configuration of the most commonly used ordinate systems.  It is 
one of the primary differentiators between Civil AccuDraw from MicroStation AccuDraw.    The 
favorite selected determines what input fields are available during the placement of an element. 

Ordinate 1 and Ordinate 2 are the measurement methods used in determination of the 
coordinates. 
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Common Origin has a Yes/No option. 

• Yes indicates that both ordinate measurements come from the same origin location. 
• No indicates each ordinate has a different location.    

To add a new favorite: 
1. Select Add 
2. Key in the Name  
3. Select the Ordinates. 
4. Select whether the ordinates share a common origin. 

 

2.8.3 Simple Linked Favorite Civil AccuDraw Workflow  
A Linked favorite has two ordinates or measurement methods that share the same Point of 
Beginning (POB) or Origin.  

 
1. Ensure Civil AccuDraw is active.  If it is active then the first icon in the toolbox 

will have an orange 
background. 

2. Set the active symbology or 
active feature.  If no feature 
is assigned, the element will 
use Default. 

3. Start the tool of interest and 
place the first point.  This 
can be by XY= key-in or a 
data point.  If the Civil 
AccuDraw XY favorite is 
active the X and Y fields 
will be available in the 
heads up display. 

4.  Select the Dist-Dir 
favorite. Entries in the distance and direction fields present a dynamic circle and 
line feedback for the constraints. 

5. Key in a distance and then press the Enter key to lock the distance. 
6. As the cursor moves over one of the compass points (north, south, east or west) 

there is a color change feedback indicating a compass direction locks. 
7. To unlock a value use the End key. 



Chapter 2 - Horizontal Geometry  OpenRoads Designer Road 1    
 

2-20 Missouri Department of Transportation 3/28/23 

8. Data Point to accept the value. 

2.8.4 Simple Un-Linked Favorite Civil AccuDraw Workflow 
An Un-Linked favorite has two ordinates or measurement methods each with a unique Point of 
Beginning (POB) or Origin. 

 
1. Ensure Civil AccuDraw is active.  If it is active then the first icon in the toolbox 

will have an orange background. 
2. Select an element placement command. 
3. Set the active symbology or active feature. 

4. Start the tool of interest for example Distance-Direction.  
5. Place the first point.  This can be by XY= key-in or a data point.  If the Civil 

AccuDraw XY favorite is active the X and Y fields will be available on the Heads 
Up Display. 

6. With the focus in the distance field press the letter (O) on keyboard. Then left 
click on the position to set the origin for measuring distance.  This could be a 
graphical element, a terrain Model element, a Civil Geometry Element or a data 
point. 

 
7. The origin shortcut (O) in Civil AccuDraw waits for a data point before setting 

the origin.  This is to provide capability for the (O) shortcut to also choose the 
baseline for station offset ordinates. 
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8. Select the Tab key to move focus to the direction field, press (O) again, identify 
the location for the second ordinate point of beginning, and click a second data 
point to set the direction origin.  This results in two independent compasses to 
measure the distance and direction.  Both distance and direction can be locked as 
needed. 

 

2.8.5 Station-Offset Linked Favorite  
The Station and Offset linked favorite pulls the station and offset from the element identified 
after the origin shortcut (O) is entered.  Selecting Tab will lock the value. 
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2.9 Civil Horizontal Geometry Commands 

Civil Horizontal Geometry tools can be accessed by selecting the Geometry Ribbon from the 
OpenRoads Modeling workspace 
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2.9.1 Point Geometry 
There are  four point options; Place Point, Equal Space Points, Locate Point, and Modify Point.  

 

 

 

Point  

Constructs a civil point element.  

 

Equal Space 
Points  

Inserts a specified number of points, points at a defined interval, or a combination 
of both into the Vie 

 

Locate Point  

Store a new point based off three existing points using one of the three methods, 
Angle Resection, Points of Intersection, and Points on Curve. 

 

Modify Point  

Modify the elevation and/or Rotation of an existing Point 
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Locate Point (Methods) 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Points of Intersection: 

Points of Intersection: 

Points on Curve: 

Angle Resection: 
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2.9.2 Line Geometry 
There are various line placement tools (By points, To elements, From elements, Between Arcs, 
and Chamfers. 

 

 

 

Line Between Points  

Creates a line between two user defined points.  

 

Line to Element  

Constructs a line at a skew to a reference element.  

 

Line Between Arcs  

Constructs a line between two previously placed arcs.  

 

Line From Element  

Constructs a line at a skew to a reference element.  

 

Line from Element  

Constructs a line at a skew from a base element.  See below for 
extended tool options  

 

Chamfer Between Points  

Planes a corner, example, it alters an existing intersection by 
inserting a line between the elements.  
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Line to Element Tools 

 

Simple Line to 
Element  

Creates a line without any transition to another element at zero degrees skew 
angle, applicable only when the To element is a curve, Offset locked at zero.  

 

Spiral-Line to 
Element  

Creates a line with a spiral transition to another element at zero degrees skew 
angle, applicable only when the To element is a curve, Offset locked at zero.  

 

Curve-Line to 
Element  

Creates a line with an arc transition to another element at zero degrees skew 
angle, applicable only when the To element is a curve, Offset locked at zero.  

 

By Angle Line 
to Element  

Creates a line without any transition at user defined skew angle, Offset locked 
at zero.  

 

Line to Element  

Constructs a line at a skew to a reference element.  
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Line from Element Tools  

 

Simple Line from Element  

Creates a line without any transition from another element at zero 
degrees skew angle, Applicable only when the From element is a 
curve, Offset locked at zero.  

 

Spiral-Line from Element  

Creates a line with a spiral transition from another element at 
zero degrees skew angle, applicable only when the From element 
is a curve, Offset locked at zero.  

 

Curve-Line from Element  

Creates a line with an arc transition from another element at zero 
degrees skew angle, applicable only when the From element is a 
curve, Offset locked at zero.  

 

By Angle Line from Element  

Creates a line without any transition from another element at a 
skew angle you define, Offset locked at zero.  

 

Line from Element  

Constructs a line at a skew from a base element.  

 

2.9.3 Arc Geometry 
Various arc placement tools (By points, To elements, From elements, Between Arcs, 2 Center and 
3 Center and Complex Transitions). 
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Circle  

Draws a circle.  

 

Arc Between Points  

Creates an arc between points.  

 

Arc to Element  

Constructs an arc based on a selected base element which controls 
tangency at one end.  

 

Arc Between Arcs  

Constructs an arc between two previously placed arcs. This tool has the 
ability to optionally apply both a back and/or forward transition 
between the base arcs and the constructed arc.  

 

Arc From Element  

Constructs an arc based on a selected base element that controls 
tangency at one end. The construct may also include an optional spiral 
transition or arc transition (2 center curve).  

 

Arc Between Elements  

Constructs an arc between two previously placed elements. This tool 
has the ability to optionally apply a back and/or forward transition 
and/or taper between the elements and the constructed arc.  

 

Complex Transition 
Between Any Element 
and Arc  

Constructs an arc between two previously placed elements. This tool 
has the ability to optionally apply a Back Spiral and/or Ahead 
Transition between the elements and the constructed arc.  

 
 
 
 
 
 
 
 
 
 
 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-10133C5D-28FE-4308-9A4B-CD55A82933BB.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-F5905F50-30E0-4CA4-9B25-B05594D932C2.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-9C8C4DE3-D33F-4F11-8D08-74D6CAD94A24.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-049F2A39-04ED-44EF-9D20-CFC3DEF2A2C7.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-7B51DC6B-6FE7-46F8-BB72-ED22D0DF729A.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-7E53E1BF-E4D5-44AB-9F90-955A319FCA39.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-4B03C92E-1DD3-4FEF-8DAC-4E7F42E97B58.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-4B03C92E-1DD3-4FEF-8DAC-4E7F42E97B58.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-4B03C92E-1DD3-4FEF-8DAC-4E7F42E97B58.html
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Arc to Element Tools  
 

 

Simple Arc to 
Element  

Creates a simple radius arc without any transition to another element, Offset 
locked at zero.  

 

2 Center Arc to 
Element  

Creates an arc with an arc transition to another element, Offset locked at 
zero.  

 

Spiral Arc To 
Element  

Creates an arc with a spiral transition to another element, Offset locked at 
zero.  

 

Reverse Spiral Arc 
To Element  

Creates an arc with a reverse spiral transition to another element, applicable 
only when the To element is a curve of opposite hand, Offset locked at zero.  

 

Arc To Element  

Constructs an arc based on a selected base element which controls tangency 
at one end.  

 

Arc from Element Tools  

 

Simple Arc From 
Element  

Creates a simple radius arc without any transition to another element, 
Offset locked at zero.  

 

2 Center Arc From 
Element  

Creates an arc with an arc transition from another element, Offset locked at 
zero.  

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-9C8C4DE3-D33F-4F11-8D08-74D6CAD94A24.html
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Spiral Arc From 
Element  

Creates an arc with a spiral transition from another element, Offset locked 
at zero.  

 

Reverse Spiral Arc 
From Element  

Creates an arc with a reverse spiral transition to another element, applicable 
only when the From element is a curve of opposite hand, Offset locked at 
zero.  

 

Arc From Element  

Constructs an arc based on a selected base element that controls tangency at 
one end.  

 

Arc Between Elements Tools  

 

Simple Arc  

Creates a radius arc without spirals or tapers at both ends, Offsets locked at 
zero.  

 

Spiral Arc Spiral  

Creates a radius arc with spiral transitions but no tapers at both endsl, Offsets 
locked at zero.  

 

Taper Arc Taper  

Creates a radius arc with tapers but no transitions at both ends, Offsets 
locked at zero.  

 

3 Center Arc  

Creates a radius arc with radius transitions at both ends, result is a three 
centered curve, Offsets locked at zero.  

 

2 Center Arc  

Creates a radius arc with radius transitions at one end, result is a two 
centered curve, Offsets locked at zero.  

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-7B51DC6B-6FE7-46F8-BB72-ED22D0DF729A.html
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Arc Between 
Elements  

Constructs an arc between two previously placed elements.  

 

2.9.4 Offsets and Tapers 
 

 

 

 
Single Offset Entire 
Element  

Offsets the selected element by a constant value along the entire 
length  

 
Single Offset Partial  

Offsets the selected element by a constant value along a user selected 
station range  

 
Variable Offset Taper  

Offsets the selected element by a variable amount along a user 
selected station range  

 
Ratio Defined Taper  

Offsets the selected element by a ratio along a user selected station 
range  
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2.9.5 Reverse Curves 
Tools to assist in the layout of a horizontal alignment in which a curve to the left or right is 
followed immediately by a curve in the opposite direction. 

 

 

 

Select in the 
Toolbox  

Description  

 
Reverse Curve by 
Angle  

Constructs reverse curves between previously drawn elements.  

 
Reverse Curve by 
Radii Ratio  

Creates a reverse curve where the second curve radius is a ratio of the first 
curve radius. Offsets locked at zero.  

 
Reverse Curve by 
Tangent  

Creates a reverse curve where the two radii are equal and you may specify 
a tangent length between the curves, Offsets locked at zero.  

 
Line at Angle  

Creates a simple linear element at a deflection angle measured from the 
first picked element, Offsets locked at zero.  

 
Reverse Transition  

Constructs reverse curves between previously drawn elements with an 
optional tangent length between the two curves.  
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2.9.6 Horizontal Geometry Spiral 

Various spiral placement tools. (From elements, Between Elements)  

 

Select in the 
Toolbox  

Description  

 

Spiral From 
Element  

Constructs a spiral from a previously placed element, using this base 
element to determine tangency at one end.  

 

Spiral Between 
Elements  

Constructs a spiral (or spirals) between two base elements that determine 
tangency.  

 

 

 

 

 

 

 

 

 

 

 

 

 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-F4BE5F9E-CAB4-4767-AB4B-8A12C60AF016.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-F4BE5F9E-CAB4-4767-AB4B-8A12C60AF016.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-C53139BF-2F40-4711-AFE6-ED48EA83050C.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-C53139BF-2F40-4711-AFE6-ED48EA83050C.html
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2.9.7 Horizontal Geometry Modify 
Stationing, Station Equations, working with Civil rules and copying civil elements. 

 

 

 

 

 

Start Station  

Assigns stationing to an element.  

 

Add Station Equation  

Defines a station equation at a designated location on an element.  

 

Add Internal Station 
Equation  

Add station equation(s) to an offset alignment in order to keep its 
stationing matching the primary alignment. 

 

Add Single Internal 
Station Equation  

Add a single station equation to an offset alignment in order to keep 
its stationing matching the primary alignment. 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-04837D09-69DA-4C46-8C28-DA8A6A91BC95.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-D3FDDDBD-3AD3-4331-8FB7-8558CCEB0CE1.html
https://youtu.be/L5pHK-jhihI
https://youtu.be/L5pHK-jhihI
https://youtu.be/L5pHK-jhihI
https://youtu.be/L5pHK-jhihI
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Copy Element  

The Copy Element tool creates a new instance of visible geometry 
only.  

 

Transpose Element  

Reverses the direction of the element. 

 

Horizontal Insert Fillet  

Constructs a complex element by appending additional elements in a 
previously established complex element.  

 

Append Element  

Constructs an element that best fits a course defined by a selected 
linear object.  

 

Geometry Builder Edit 

Edit Geometry in a Spreadsheet type dialog called Geometry Builder.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-150AF28B-2F41-4808-80B9-4FC19441252E.html
https://youtu.be/gx0EbEtTLv8
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-4CEE82D0-23FE-488A-AD9A-7BD4A9B43007.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-2975FDF4-F385-4F81-8853-33E00949B8D6.html
https://youtu.be/tIp2Legdlhg
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2.9.8 Creating Complex Geometry 
Creating and redefining Complex alignments, Best Fit, Offset tools (copy parallel) reverse curves, 
and Create Geometry by Template. 

 

 

 

 

Complex by 
Element  

Constructs a complex element of previously placed elements by joining them in 
sequence.  

 

Complex by 
PI  

Creates a linear element with curves based on user input of PI (point of 
intersection) locations. The curves can include transitions or set the radius to 
zero for no curves at the PI.  

 

Define by 
Best Fit  

Constructs an element that best fits a course defined by a selected linear object.  

 

Geometry 
Builder  

Create an alignment in a spreadsheet type dialog.  

 

Geometry 
Connector  

No information is available for this tool.  

 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-0F0FF737-569C-4E24-886C-768F97BC67E8.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-0F0FF737-569C-4E24-886C-768F97BC67E8.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-0C808335-4E89-459A-ACBA-E87095D9FD64.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-0C808335-4E89-459A-ACBA-E87095D9FD64.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-77D70F79-9EAC-4284-983B-B6FA860A33FB.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-77D70F79-9EAC-4284-983B-B6FA860A33FB.html
https://youtu.be/5FROQgVCyg4
https://youtu.be/5FROQgVCyg4
https://communities.bentley.com/products/road___site_design/f/geopak-inroads-mx-openroads-forum/188000/ord-geometry-connector-does-not-work/552772
https://communities.bentley.com/products/road___site_design/f/geopak-inroads-mx-openroads-forum/188000/ord-geometry-connector-does-not-work/552772
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 Complex By Elements - Constructs a complex element of previously placed elements by 
joining them in sequence. 

• Ribbon: Geometry > Horizontal > Complex Geometry split button  

Complex By Elements constructs a complex element of previously placed elements by joining 
them in sequence.  

 

Workflow  

1. Click Complex By Elements. The Complex Element dialog displays.  

There are two methods of operation: Manual and Automatic.  

2. Using the Automatic method, hover over the beginning element until the directional arrow points 
to the desired direction. Left mouse-click to accept the chosen element.  

 

3. At this point, the complex path will be highlighted. Left-click again to accept the complex 
creation or right-click to cancel.  
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4. Alternatively, using the Manual method, select each element individually using the left-click.  

 

Once all items are selected, data point, example, left-click in the drawing area off of the elements 
to accept the complex element creation.  

Manipulators  

 

When the elements are migrated to a complex element, the individual element manipulators 
remain intact.  

Properties  

The rule data is also accessible in the properties of the individual elements making up the 
complex element. Select the individual element to edit the properties. Most data in the property 
pane can be edited to change any of the element's definitions.  
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 Complex By PI - Creates a linear element with curves based on user input of PI (point of 
intersection) locations.  The curves can include transitions or set the transitions to none.  

• Ribbon: Geometry  Horizontal  Complex Geometry split button  

Complex By PI creates a linear element with curves based on user input of PI (point of 
intersection) locations. The curves can include transitions or set the radius to zero for no curves 
at the PI.  

The transitions on the curves can be arc transitions or clothoid spirals using the following 
methods. See Spiral from Element for a description of the various spiral parameters.  

• Spiral - Length  
• Spiral - A-Value  
• Spiral - Deflection  
• Spiral - Delta R  
• Spiral - RL  
• Curve - Length  
• Curve - Deflection  
• Curve - Delta R  
• Curve - Ratio  

Workflow  

1. Click Complex By PI. The Complex Element By PI 
dialog displays.  

2. Data point to set the beginning of the element.  

 

3. Data point to set the second PI.  

 

 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v8/en/GUID-F4BE5F9E-CAB4-4767-AB4B-8A12C60AF016.html
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4. Data point to set the third PI. Radius always applies to the PI prior to the one where the data 
point is currently being set. You can edit the radius by keying in a new value in the prompt. This 
is a triple toggle input. Toggle with left-right arrow keys to set back and ahead transition 
parameters.  

 

5. Continue to data point to add more PI points. Click the Reset button to stop adding PI points.  

Manipulators  

 

Manipulators are available for:  

• Distance and direction on each line segment  
• Radius and transition parameter on each curve  
• Drag handles at PI points  
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2.9.1 Geometry Common Tools 
 

 

 

 

Transform  

This single tool is capable of Translating, Rotating, and Scaling an element. Civil 
elements are not valid for the three above separate power platform tools so this 
tool can do all three modifications on regular or civil elements at once, if desired. 

If civil elements are transformed, they become simplified elements, meaning if the 
element is a target of a rule then that rule is removed. A warning box appears if 
civil elements are about to be transformed. 

 

Simplify 
Geometry  

Simplify Geometry is a tool used for removal of intervals and external referencing 
rules for horizontal and vertical geometries. 

 

Complex by 
PI  

Used to preserve the original Alignment name, allowing all rules built off the 
original geometry to update in line with the new geometry. 

 

Table Editor  

Used to modify geometry in a spreadsheet type dialog where values can be 
locked.  
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2.10 Editing Horizontal Geometry  

Once a Civil Geometry Element is placed, selection of that element will display the appropriate 
manipulators, defining the element.   

Manipulators 
Manipulators are available for: 

• Distance and direction on each line segment 
• Radius and transition parameter on each curve 
• Drag handles at PI points 

 

Normal Line Manipulators 
When the line is placed without any snaps and without 
any Civil AccuDraw constraints, you will see the 
onscreen manipulators as shown right. These 
manipulators can be used to edit the line as follows: 

• The distance and direction text manipulators 
can be clicked to allow editing of the value 

• The arrows parallel to the line can be used to 
extend or trim the line (i.e., change the distance) 

• The end point arrows perpendicular to the line can be used to rotate the line (i.e., hold 
the distance and change the direction) 

• The perpendicular arrow at midpoint can be used to move the line parallel 
• The dot at the end points can be used to move the point without constraining the distance 

or direction 
• The dot at the midpoint can be used to move the line in its entirety 
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Snap Manipulator 

When a line end point has been snapped, the normal 
manipulators are replaced by a snap manipulator. The end on 
the left was snapped by key point, so you see a single dot 
and an icon indicating the snap type.  

You can move the snapped end in space by clicking the dot 
and dragging. This breaks the snap and creates a new 
endpoint location that might be a data point, a different snap 
or a Civil AccuDraw input. 

If you hover over the snapped end point dot, the normal manipulators will appear to allow 
extend/trim or rotate of the line. This also breaks the snap. Similarly, when a line endpoint is 
created by Civil AccuDraw, the normal manipulators are replaced by a single dot and the 
AccuDraw manipulators. The AccuDraw Manipulators are text labels that can be clicked and 
edited. 

Hover over the dot to show the normal manipulators for rotate and trim/extend functions. This 
replaces the AccuDraw input with the new input values. 

2.11 Horizontal Geometry Properties 

The rule data is also accessible in the properties of the line. Select the line and click Properties 
from the heads-up menu. Most data in the property pane can be edited to change the line 
definition.   You can also select the geometry using the Element Selection tool and use the 
Element Information dialog to make changes 

 

Note: When you review geometry the Element Information dialog displays the terrain models 
that the geometry belongs to, if any. 
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2.12 Exercise #1 (Group): Ramp 4 Alignment 

1. Within the Roadway\data-2 folder, open the file: Terrain_J5P3181.dgn 

2. Create a new file named Civil_Geometry_J5P3181.dgn using the following the 2D seed 
file:  

pw:\CADD_Standards\Seed Files\Design - English\MoDOT_Design_Seed_2D.dgn.   

This new file will hold Horizontal and Vertical Alignments for the project. 

3. Open the Coordinate System tool by selecting the OpenRoads Modeling 
Workflow  Utilities Tab  Geographic Section. 

4. Select “From File” icon. 

 

5. Select the Terrain_J5P3181.dgn file in the data-2 folder. 

6. Verify the settings.  

 
 

7. Reference in the following file: 
Terrain_J5P3181.dgn. 
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8. Create the alignment as shown below and per the steps outlined on the following pages. 
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Ramp 4  
Beginning Point: Station 5+60.0000 Connector Road = Station 0+00.00 Ramp 4 
Ending Point:  X = 1,606,618.6409      Y = 866,205.6571 
 

Beginning station of Ramp 4 is 0+00.00 

Curve #1 Information 

Direction Back   = S 45° 37’ 39” E 
Radius     = 900.00’ 
Direction Ahead   = S 63° 56’ 17” E 

Note:  Before you start this exercise understand it is best to use the most accurate 
information you are given.  Information like Coordinates out to 4 decimal places, 
and Line Direction bearings out to the “seconds” place, are all very accurate to use.  
Things to avoid are Coordinates, Stations, and Distances only reported to two 
decimal places. Referred 

9. We first need to import the Connector Road Alignment. 
a. Select the “Import Geometry” tool (by selecting the OpenRoads Modeling 

Workflow, then Geometry  General Tools  Import/Export  Import 
Geometry 

b. Select the Connector Road.xml within your data-2 folder. 
c. Set the following settings in the Import Geometry dialog and then select Import: 
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10. Add the Connector Road Alignment Annotation by selecting the OpenRoads Modeling 
Workflow  Drawing Production Tab  Annotation Section  Annotate Element   

11. Within the Feature Definition Toggle Bar set the active feature to Alignment > MoDOT 
Proposed_Baseline and then Enable the Use Active Feature Definition icon. 

 

 

  

12. Select the Line Between Points tool from the OpenRoads Modeling Workflow  
Geometry Tab  Horizontal Section. 

13. In this step use the “Line Between Points” tool and Civil AccuDraw to place lines that 
represent the two tangent sections of the Ramp 4 alignment.  Make sure these two lines 
are long enough so that they overlap each other.  By overlapping the two tangent lines we 
are locating the PI location of the Curve using the intersection point of the two Civil 
Geometry Lines. 
a. First select the “Line Between Points” tool located in the OpenRoads Modeling 

Workflow  Geometry Tab  Horizontal Section  Lines Tools  Line 
Between Points.   

b. Next, select the Civil AccuDraw tool and its Station Offset mode and key in the 
values STA = 5+60.0000 (Connector Road), Offset = 0.00 

c. Once the start of the alignment has been defined, continue to place the line using 
Civil AccuDraw and its Distance-Direction mode at a bearing of S 45° 37’ 39” E at 
a length that would extend past the PI location of the Curve (a length of at least 200 
feet will work).  When typing in a bearing use a colon “:” in-between the 
Degrees:Minutes and Minutes:Seconds.  For this step you would type S45:37:39E 

 
Note:  If “Angle” is display instead of “Bearing” in the Civil AccuDraw heads-up 

display select the keyboard keys “R” and then “T”.  This is a Civil AccuDraw 
shortcut to Rotate the compass to the Top view. 

d. Select the “Line Between Points” tool, and using Civil AccuDraw and its XY 
function, key in the coordinates X = 1,606,618.6409      Y = 866,205.6571 

e. Once the end of the alignment has been defined, continue to place the line using Civil 
AccuDraw and its Distance-Direction option at a bearing of N 63° 56’ 17” W at a 
length that would extend past the Overall PI location of the Spiral-Curve-Spiral (a 
length of at least 1,000 feet will work).  When typing in a bearing use a colon “:” in-
between the Degrees:Minutes and Minutes:Seconds.  For this step you would type 
N63:56:17W 
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Note:  If “Angle” is display instead of “Bearing” in the Civil AccuDraw heads-up 
display select the keyboard keys “R” and then “T”.  This is a Civil AccuDraw 
shortcut to Rotate the compass to the Top view. 

14. Deactivate Civil AccuDraw. 

15. Next store the Curve by selecting the OpenRoads Modeling Workflow, then Geometry 
Tab  Horizontal Section  Arcs Tools  Arc Between Elements  Simple Arc 
tool, and defining the tool with the following parameters: 

Radius of Curve  = 900’ 
Notes: 

• If you need to switch from Radius to Degree of Curve type in a “d” in the 
Radius field and then the degree of curve value. 
   

• When typing in a Degree of Curve use a colon “:” and place in-between the 
Degrees:Minutes and Minutes:Seconds.  For example, 3° 30’ 00” you would 
type d3:30:00 or d3:30 for short. 
 

• Spirals requirements come from the MoDOT Superelevation Standard Plans 
which is based on AASHTO 2018 Green Book. 

 
Once the tool is defined with the correct parameters select each tangent and place the 
Curve trimming both tangents back. 

16.  Select Create Complex Element and to turn the individual element into one complex 
element.   

a. Name the complex element “Ramp 4”. 
b. Make sure the stationing will be flowing (getting larger) in a southerly 

direction 

17. Add the Ramp 4 Alignment Annotation by selecting the OpenRoads Modeling 
Workflow  Drawing Production Tab  Annotation Section  Annotate Element   

18. Using the “Start Station” tool set the Beginning Station to 0+00.00. 

19. Set the Drawing Scale is set to 1”=50’. 

20. Generate a Horizontal Geometry Report by “left clicking” on the alignment and 
selecting from the heads-up menu the Horizontal Geometry Report Tool. 
a. Using the report verify your alignment matches the Alignment diagram at the 

beginning of this exercise. 

21. Select File > Update Server Copy. 
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2.13 Exercise #2 (Individual): Route 54 Alignment 

1. Create the alignment as shown below and per the steps outlined on the following pages. 
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2. Within the Feature Definition Toggle Bar set the active feature to Alignment > MoDOT 
Proposed_Baseline and then Enable the Use Active Feature Definition icon. 

 

 

  

3. Select the Line Between Points tool from the OpenRoads Modeling Workflow  
Geometry Tab  Horizontal Section. 

4. Activate Civil AccuDraw and then select the XY mode. 

 

5. Using the heads-up display, key in the coordinates of the first PI: 
X = 1,604,892.3100             
Y = 868,014.5720 
 

 

 

 

 
Hint: After locking in each value move the mouse to ensure the value is set. 

6. Data point to accept the placement of the first point.  

7. When prompted to Enter End Point, make the Distance-Direction mode active in Civil 
AccuDraw.  This will change the heads display.  

 

8. Locate the second point with a Distance = 1,600 ft and the Direction = S 34:57:33 E  
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Hint: Directions or angles should be entered in this format DD:MM:SS. S34:57:33E  

If Bearing is the MicroStation Definition, then the Alpha indicators (N, S, E, and W) should 
be entered with no spaces before the DD and after the SS. 

 

9. Data point to accept. 

10. Select the XY favorite from the Civil AccuDraw toolbar. 

.  

11. Place another line with a Start point at X = 1,608,412.4320 and Y = 865,359.6180 
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12. Define the End point as Distance = 3,100 ft and the Direction = N62:57:26W. 

13. Data point to accept. 
14. Deactivate Civil AccuDraw. 
15. Next store the Spiral-Curve-Spiral by selecting the Spiral Arc Spiral tool located the 

OpenRoads Modeling Workflow  Geometry Tab  Horizontal Section  Arc 
Between Elements Tools. 
Define the tool with the following parameters: 

Radius = 2,400 ft 
Spirals = 333 ft 
 

Once the tool is defined with the correct parameters select each tangent and place the 
Spiral Curve-Spiral trimming both tangents back. 
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16. Select Create Complex Element and to turn the individual element into one complex 
element.  Name the complex element “Route 54”.  Start the complex element selecting 
the northern most end of the north line to ensure that stationing will be flowing (getting 
larger) in a southerly direction. 

 

 

17. Add Stationing and Tic marks to the Alignment using the Element Annotation tool 
located under the OpenRoads Modeling Workflow  Drawing Production Tab  
Annotation Section. 

 
a. Select the Alignment 
b. Reset to complete 

18. Using the Start Station tool to apply a beginning Station to our Route 54 alignment of 
602+59.49. 

The Start Station tool located under the OpenRoads Modeling Workflow  
Geometry Tab  Horizontal Section  Modify Tools. 
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19. Next apply a Station Equation at 608+01.01 to even out the stationing going forward in 
this alignment.  Use the Station Equation tool located under the OpenRoads Modeling 
Workflow  Geometry Tab  Horizontal Section  Modify Tools. 

Enter the following parameters: 
Back Station = 608+01.01  
Ahead Station = 608+00 

 

20. Select the Horizontal Reports tool using the heads-up display of the RTE54 alignment. 
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21. Select the XSL report named HorizontalAlignmentReviewReport.XSL and compare 
your results with the one below. 
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2.14 Exercise #3 (Individual): Ramp 2 Alignment 

1. Continue in the Civil_Geometry_J5P3181.dgn 
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Ramp 2 
 
Beginning Point: X = 1,604,948.9130      Y = 867,834.2818 
Ending Point:  X = 1,604,883.5120      Y = 866,871.1847 
 
Beginning station of Ramp 2 is 0+00.00 

Curve #1 Information 

Direction Back   = S 36° 17’ 04” E 
Radius     = 464.00’ 
Direction Ahead   = S 23° 59’ 50” W 

Curve #2 Information 

Direction Back   = S 23° 59’ 50” W 
Degree of Curvature  = 15° 00’ 00”   (Chord) 
Direction Ahead   = S 17° 54’ 20” E 

Note:  Before you start this exercise understand it is best to use the most accurate 
information you are given.  Information like Coordinates out to 4 decimal places, 
and Line Direction bearings out to the “seconds” place, are all very accurate to use.  
Things to avoid are Coordinates, Stations, and Distances only reported to two 
decimal places. 

2. Within the Feature Definition Toggle Bar set the active feature to Alignment > MoDOT 
Proposed_Baseline and then Enable the Use Active Feature Definition icon. 

 

  

3. Store alignment. 

Hint: To switch between Arc and Chord Defined Curves you need to select the 
following: 

File (takes you to the Backstage)  Settings  File  Design File Settings  
Civil Formatting  Radius Settings  Degree of Curve Method 

4. Annotate Alignment (Stationing and Tic Marks) 

5. Generate a Horizontal Geometry Report by “left clicking” on the alignment and 
selecting from the heads-up menu the Horizontal Geometry Report Tool. 

6. Using the report verify your alignment matches the Alignment diagram at the beginning 
of this exercise. 
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7. Select File > Update Server Copy. 
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2.15 Exercise #4 (Individual): Ramp 4 Alignment “Advanced” 

1. Continue in the Civil_Geometry_J5P3181.dgn 
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Ramp 4 (Advanced)  
 
Beginning Point: Station 5+60.0000 Connector Road = Station 0+00.00 Ramp 4 
 
Ending Point:  X = 1,606,830.0199      Y = 866,100.0255 
 
Beginning station of Ramp 4 is 0+00.00 

Curve #1 Information 

Direction Back   = S 45° 37’ 39” E 
Radius     = 900.00’ 
Direction Ahead   = S 63° 56’ 17” E 

Curve #2 Information 

Direction Back   = S 63° 56’ 17” E 
Radius     = 13,800’ 
Direction Ahead   = S 62° 57’ 25” E 

Note:  Before you start this exercise understand it is best to use the most accurate 
information you are given.  Information like Coordinates out to 4 decimal places, 
and Line Direction bearings out to the “seconds” place, are all very accurate to use.  
Things to avoid are Coordinates, Stations, and Distances only reported to two 
decimal places. 

2. Continue in the J5P3181_Civil_Geometry.dgn file and delete the previously stored 
Ramp 4 alignment. 

3. When laying out this alignment do not use the ending alignment Coordinates from the 
Exercise #1 as the coordinates of the PC Location of this example’s second curve. 

4. Within the Feature Definition Toggle Bar set the active feature to Alignment > MoDOT 
Proposed_Baseline and then Enable the Use Active Feature Definition icon. 

 

  

5. Store alignment. 

6. Annotate Alignment (Stationing and Tic Marks) 
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7. Generate a Horizontal Geometry Report by “left clicking” on the alignment and 
selecting from the heads-up menu the Horizontal Geometry Report Tool. 
a. Using the report verify your alignment matches the Alignment diagram at the 

beginning of this exercise. 

8. Select File > Update Server Copy. 
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3.1 Objectives 

• Create and store vertical alignments using Vertical Geometry tools 

• Review the Vertical Geometry Settings 

• View Vertical Geometry Standards and Reports 

• Modifying Vertical Geometry information 

• Using the Table Editor 

3.2 Definitions 

The Vertical Geometry ribbon group in the OpenRoads Modeling workspace > Geometry tab is 

a collection of Open Roads tools that are used to graphically create and modify proposed design 

profiles or modify an existing ground profile.  These operations may be accomplished through a 

dialog box and/or by dynamic manipulation of graphic elements. 

3.3 Vertical Geometry Settings 

Profiles have overall settings that may be modified to display information the user may wish to 

see.  Examples include Elevation and Slope precision, Slope format and ratio settings. 

1. From the drawing click File from the pull-down menu 

2. Click Settings from the side panel options 

3. Click on File under the Settings pane 

4. Click on Design File Settings 

5. Choose Civil Formatting 

6. Make the desired changes and click OK 

 

Note: See next page for Vertical Geometry Settings dialog. 
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3.4 Vertical Geometry Tools 

  Open Profile Model 

Use the Open Profile Model command to generate a profile view for the chosen feature and gain 

access to the Vertical Geometry tools. 

1. Ribbon: Geometry > Vertical > Open Profile Model, click the Open Profile Model icon. 

2. Move the cursor into a view and note the command prompt to Locate Plan Element. 

3. Select the plan element with which you wish to work in profile. 

4. The cursor is now equipped with the prompt Select or Open View. 

a. If another View is already open, data point in it to present the selected element in 

profile. (if the 3D model has been opened using the F6 tool, do not use this view. It is 

set up with different viewing displays and will cause confusion when working with 

the profile) 

b. If another view is not open, select a view from the View Groups toolbar that is not 

being used for other models, then data point in the new View.  

5. Use the Vertical Geometry tools to create or edit your vertical alignment. 

  Set Active Profile 

Use the Set Active Profile command to designate which of profile elements will drive the 3D 

model. The result is the creation of a 3D spline in the 3D model representing the combination of 

the Horizontal alignment plus the Design profile. 

 

3.4.2 Profile Creation Tools 

The Profile Creation drop down in the Vertical Geometry ribbon group in the OpenRoads 

Modeling workspace > Geometry tab is a collection of Open Roads tools that assist in the 

creation of a proposed profile.  Surface profiles can also be utilized to create offsets of existing 

ground or other terrain models accessible to the design file. 
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Profile from Surface 

 Use the Profiles from Surface command to generate a profile whose elevations are determined by 

draping onto a surface. The surface may be a terrain model, a mesh, or mesh solid. 

 

Quick Profile from Surface 

Quick Profile from Surface is a companion command that provides the same result but simplifies 

the input by assuming that the entire element is draped and that the offsets are zero. 

 

Project Profile To Element 

Project Profile To Element is a used to show one element’s profile into the profile view of another 

element. 

 

Project Profile Range To Element 

Project Profile Range To Element performs the same function as the Project Profile tool except a 

station range can be used instead of the entire element. Use the Project Profile Range to Element 

tool to show a portion of one elements profile in the profile space of another element. 

 

Project Extended Profile 

Use the Project Extended Profile tool to show, in an element's profile view, the profiles of 

adjacent elements. For example, the edges of pavement adjacent to an intersection turning radius 

are important in the design of the radius profile. 

 

Place Profile Intersection Point  

Use the Place Profile Intersection Point command to indicate in a Profile View where one 

element crosses another. The point is placed at the station and elevation of the intersected 

element. The intersected element must have a designated active profile. 
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3.4.3 Vertical Geometry - Line tools 

The Line tool drop down in the OpenRoads Modeling workspace > Geometry tab is a collection 

of Open Roads tools that assist in the creation of a proposed profile using single line elements. 

 

 

 

 

 

 

  Profile Line between Points 

Use the Profile Line between Points command to construct a profile line between two designated 

points. 

1. Open the Lines drop down in the Vertical Geometry ribbon group in the OpenRoads 

Modeling workspace > Geometry tab then click the Profile Line Between Points tool. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model 

• The Profile Line Between Points dialog opens. 

 

• Checking the box next to any field locks the associated value. 

2. When you move the cursor into the Profile View, it is equipped with a prompt. Enter the 

Start Point in the View by data pointing (i.e., left-clicking) at the desired location. 
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3. When prompted to Enter End Point, data point the location for the end of the profile line. 

Or you can use one of the following methods to establish the Slope or Length (choose 

between the two by striking the left or aright arrow keys to toggle between them): 

• Move the cursor slightly, key in the value, then data point. 

• As you move the cursor, a value is displayed on the prompt.  Data point.  

 

• Note: If the data entry field is locked on the Place Plan Profile between Points 

dialog, you cannot set a new value.  

 Profile Line to Element 

Use the Profile Line To Element command to construct a profile line, at a delta slope, from a 

designated location to a reference element. 

1. In the Vertical Geometry ribbon group in the OpenRoads Modeling workspace > 

Geometry tab click the Profile Line to Element tool. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

• The Profile Line to Element dialog opens. 

 

• Checking the box next to any field locks the associated value. 

2. When you move the cursor into the Profile View, it is equipped with a prompt. When 

prompted to Locate Reference Profile, move the cursor to the element to which you wish 

to draw a line then data point on the target element. 
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3. Establish the End Point in the View by data pointing (i.e., left-clicking) at the desired 

location.   

 

 

4. Establish the Vertical Offset with one of the following methods: 

• Key in the desired distance and press the Enter key to lock then data point to accept. 

• Move the cursor to a station displayed on the prompt. Data point at the desired 

station. 

 

5. Use one of the following methods to establish the Delta Slope or Length; choose 

between the two by using the left or right arrow keys to toggle between them. 

• Key in the desired distance and strike the Enter key to lock then data point to accept. 

• As you move the cursor, a value is displayed on the prompt.  Data point at the desired 

distance. 

 Profile Line from Element 

Use the Profile Line From Element command to construct a profile line, at a delta slope, from a 

reference element to a designated location. 

1. the Profile Line From Element tool. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

• The Profile Line from Element dialog opens.  
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• Checking the box next to any fields locks the associated value. 

2. When you move the cursor into the Profile View, it is equipped with a command prompt 

requesting that you Locate Reference Profile, so move the cursor to the element from 

which you wish to draw a line then data point (i.e., left-click) on it. 

 

3. Establish the Vertical Offset with one of the following methods: 

• Key in the distance and strike the Enter key to lock then data point to accept. 

• As you move the cursor, a distance is displayed on the prompt. Data point at the 

desired distance. 

 

 

4. Identify the Start Point along the offset line at the location where the profile line should 

cross.  Data point at the location. 

 

5. To establish the Delta Slope or Length, select the left or right arrow keys to toggle 

between them then perform one of the following: 

• Key in the value then data point. 
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• The value is displayed on the prompt and updated as it moves. Data point at the 

value. 

 

6. To trim the element at the intersection with the Profile line or to extend the element to 

intersect with the Profile line, strike the up or down arrow keys to choose a 

Trim/Extend option. 

 

 

Dialog Customization 

Right-click on the Profile Line From Element dialog to customize it for specific tasks or to 

personal preference. 

 

Manipulators 
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Manipulators are available for: 

• Offset from base element (not shown here) 

• Delta Slope 

• Length 

• Drag a grip to dynamically adjust start and end distance 

 

Properties 

To View the new element's properties, equip the Element Selection tool. 

Select the element in the View then let the cursor hover over the selected element. Click the 

Properties icon to access rule data for the chosen element. 

  

Tangent Profile Line from Element - Creates a profile line from another element at zero 

deflection, applicable only when the From element is a profile curve, Offset locked at zero 
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 Profile Complex by VPI 

Use the Profile Line between Elements command to construct a profile line between two 

previously placed profile curves. 
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3.4.4 Curves tools 

The Curve tool drop down in the OpenRoads Modeling workspace > Geometry tab is a 

collection of Open Roads tools that assist in the creation of a proposed profile single element 

curves. The lines and curves created can be combined to form one complete profile. 

 

 Profile Curve Between Points 

Use the Profile Curve between Points tool to construct a vertical curve between designated 

points. 

1. Select the Profile Curve between Points icon. 

• The Place Profile Curve between Points dialog opens. 

 

• Checking the box next to any of the fields locks in the associated value. 
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2. When you move the cursor into the Profile View, it is equipped with a command prompt that 

invites you to choose a Placement Method. Navigate the options by striking the up and down 

arrow keys. 

 

Start\End\VPI 

1. To create a symmetrical, vertical curve defined by a Start Point, an End Point, and the Vertical 

Point of Intersection, choose Start\End\VPI by striking the down arrow key on the Placement 

Method prompt. Strike the Enter key to initiate the Start\End\VPI method. 

2. When prompted to "Enter Start Point", so move the cursor to the point at which you wish the 

curve to originate then data point. 

 

3. When prompted to "Enter End Point"; use one of the following methods to establish the end of 

the curve: 

 

o Move the cursor to the desired location and data point. 

o Strike the left and right arrow keys to choose the Length option on the prompt, key in a value, 

and then strike the Enter key. 

4. Use one of the following methods to set the VPI (navigate the options by striking the left or right 

arrow keys): 

 



Chapter 3 - Vertical Geometry  OpenRoads Designer Road 1  
 

3-14 Missouri Department of Transportation 1/11/23 

o As you move the cursor, a value is displayed on the prompt. Data point at the desired value. 

o Enter a value for Start Grade and strike the Enter key then data point. 

o Enter a value for End Grade and strike the Enter key then data point. 

o Enter a value for Vertical Curve Parameter and strike the Enter key then data point. 

Start\End\Pass-thru 

1. To create a symmetrical, vertical curve defined by a Start Point, an End Point, and a point 

through which the curve must pass, choose Start\End\Pass-thru by striking the down arrow key 

on the Placement Method prompt. Strike the Enter key to initiate the Start\End\Pass-thru method. 

 

2. When prompted to "Enter Start Point", so move the cursor to the point at which you wish the 

curve to originate then data point. 

 

3. When prompted to "Enter End Point"; use one of the following methods to establish the end of 

the curve: 

 

o Move the cursor to the desired location and data point. 

o Strike the left and right arrow keys to choose the Length option on the prompt, key in a value, 

and strike the Enter key then data point. 

4. Use one of the following methods to designate a point through which the curve must pass 

(navigate the options by striking the left or right arrow keys): 
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o As you move the cursor, a value is displayed on the prompt. Data point at the desired value. 

o Enter a value for Start Grade and strike the Enter key then data point. 

o Enter a value for End Grade and strike the Enter key then data point. 

o Enter a value for Vertical Curve Parameter and strike the Enter key then data point. 

High\Low\End 

1. To create a symmetrical, vertical curve defined by a the High or Low Point and an End Point, 

choose igh\Low\End by striking the down arrow key on the Placement Method prompt. Strike 

the Enter key to initiate the High\Low\End method. 

 

2. When prompted to "Enter HighLow Point", so move the cursor to the curve's highest or lowest 

point then data pointX. 

 

3. Use one of the following methods to the set the end of the curve (navigate the options by striking 

the left or right arrow keys): 
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o As you move the cursor, a value is displayed on the prompt. Data point at the desired value. 

o Enter a value for Start Grade and strike the Enter key then data point. 

o Enter a value for End Grade and strike the Enter key then data point. 

o Enter a value for Vertical Curve Parameter and strike the Enter key then data point. 

Vertical Curve Type 

The option for curve type can be changed in the dialog or by pressing Shift key on keyboard. 

Supported curve types are: 

• Parabola Symmetric Parabolic Curve 

• Asymmetric Asymmetric Parabolic Curve 

• Circular A simple curve defined by radius 
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 Profile Curve To Element 

Use the Profile Curve to Element tool to construct a vertical curve from a designated point to an 

element. 

 

 
 

 Profile Curve From Element 

Used to construct a vertical curve between an existing element and a point you will designate. 
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 Profile Curve between Elements 

Use the Profile Curve Between Elements command to constructs a vertical curve between two 

designated elements. 

   

1. In the Vertical Geometry ribbon group in the OpenRoads Modeling workspace > 

Geometry tab click the Profile Curve Between Elements icon. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

• The Profile Curve Between Elements dialog opens. 

 

• The back and ahead elements can be lines or curves and can be attached or not.  If 

attached the elements will be clipped based on the curve parameters selected. 
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• Checking the box next to any of the fields locks-in the associated value. 

2. Once the cursor is in the Profile View, a command prompt requesting Locate First 

Profile Element is presented.  Data point on the element that will come into the curve.   

3. Set the Back Vertical Offset either by keying in a value or locating a distance graphically 

by moving the cursor. 

4. When prompted to Locate Second Profile Element, move the cursor to the element to 

which the curve must extend then data point. 

5. Enter the Ahead Vertical Offset.  

6. Use one of the following methods to designate a point through which the curve must 

pass.  Navigate the options by selecting the left or right arrow keys. 

• As you move the cursor, a value is displayed on the prompt. Data point at the desired 

value. 

• Enter a value for Length and select the Enter key then data point. 

• Enter a value for Vertical Curve Parameter and select the Enter key then data point. 

7. To trim the element at the intersection of the curves or to extend the new curve to 

intersect with the old, your Offset value must be zero. Strike the down arrow key to 

choose the Both option then strike the Enter key. 

 

 

Other tools under Profile Curve Between Elements drop down menu include other types of 

curves.  Typically we only utilize Parabola for MoDOT vertical curves. 

 

 Parabola between Elements - Creates a parabola between two elements, Offsets are 

locked at zero 



Chapter 3 - Vertical Geometry  OpenRoads Designer Road 1  
 

3-20 Missouri Department of Transportation 1/11/23 

 Asymmetric Parabola - Creates an asymmetric parabola between two elements, Offsets 

are locked at zero 

 Circular Curve between Elements - Creates a simple profile radius between two 

elements, Offsets are locked at zero 
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3.4.5 Element Profiles tools 

 Quick Profile Transition 

Use the Quick Profile Transition tool to define the profile of an element by matching the slope 

and elevation of adjoining elements. Depending on the configuration of adjacent elements, either 

a single crest/sag curve is created or a reverse transition.  Perfect for Radius Return Profiles at 

intersections. 

 

Note: The adjoining elements must have a design profile. 

 Profile By Constant Elevation 

Use the Profile By Constant Elevation tool to define a flat profile at a given elevation for the 

entire element. 

 

 Define Profile by Slope from Point 

Use the Define Profile by Slope from Point tool to define a 

profile of an element by computing a slope from a 3D 

point. A 3D Point is created when placing a point with an 

Elevation. 
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  Profile by Slope From Element 

Use the Profile by Slope From Element tool to define an elements profile by projecting a fixed 

slope from another element with a design profile. 

1. Select the Define Profile by Slope from Element icon. 

o The Define Profile by Slope from Element dialog opens. 

 

o Checking the box next to any of the fields locks in the associated value. 

2. When you move the cursor into the View, it is equipped with a command prompt. Select 

the element that you wish to define the profile. 

 

3. When prompted to "Locate Reference Element", move the cursor to the element that will 

serve as a reference for the profile then data point, example, left-click. 
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4. When prompted to provide the desired Slope, enter the value then strike the Enter key. 

 

5. When prompted to choose a Point Selection Adjustment, navigate the options by striking 

the up or down arrow key then strike the Enter key. 

 

6. When prompted to choose a Profile Adjustment, navigate the options by striking the up or 

down arrow key then strike the Enter key. Options are: 

 

o None - no adjustment is performed 
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o Minimum - of the points used in previous step, select the minimum elevation and 

use this value for the entire profile 

o Maximum - of the points used in previous step, select the maximum elevation and 

use this value for the entire profile 

7. The vertical offset is an additional adjustment to the profile after all the above slope 

computations are complete. 

 Profile By Variable Slope From Element 

Use the Profile By Variable Slope From Element tool to define an elements profile by projecting a 

variable slope from another element with a design profile. This tool differs from the Profile by 

Slope tool only in the fact that you have additional options. Specifically, you can define a range 

instead of the entire element, and there are multiple methods of slope rather than fixed slope 

alone. 

Options for slope style are: 

• Constant uses a constant fixed slope 

• Linear slope transitions between a start and end value using a linear method 

• Reverse Biquadratic slope transitions between a start and end value using a reverse 

biqudratic transition method 

• Reverse Cubic slope transitions between a start and end value using a reverse cubic 

transition method 

 Profile By Vertical Offset From Element 

Use the Profile By Vertical Offset From Element tool to define the profile of an element based on 

a vertical offset. The results are similar to Profile by Variable Slope tool, except that, instead of 

transitioning two slopes, two vertical offsets are used. 

 

 Profile By 3D Element 

Use the Profile By 3D Element tool to produce a profile (in profile space) from a 3D element in 

the drawing.  Must have a 3D element referenced in to the 2D Default model. 
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3.4.6 Modify tools 

The Modify drop down in the OpenRoads Modeling workspace > Geometry tab is a collection of 

Open Roads tools to assist in copying, inserting curves or appending elements to a complex 

profile. 

 Copy Vertical 

Copy Vertical tool is used to replicate geometry in the same horizontal element with the same or 

different feature definition. The profiles can also be copied to another piece of horizontal or 

vertical geometry. 

 Profile Insert Curve 

Use the Profile Insert Curve tool to insert a vertical curve into a profile element.  The tool will 

allow the user to insert a defined parabolic curve. 

 

  Append Profile Element 

Use the Append Profile Element tool to append additional elements to a previously established 

complex element. First element must be a complex element, additional elements may be curves, 

lines or complex elements. 
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3.4.7 Complex Geometry tools 

The Complex Geometry drop down in the OpenRoads Modeling workspace > Geometry tab is a 

collection of Open Roads tools that assist in the creation of a proposed profile alignments or 

complex chains.  These tools create or combine elements to create a complex profile with tangents 

and parabolic curves.  

 

  Profile Complex by Elements 

Use the Profile Complex by Elements command to construct a complex profile element from 

previously placed elements. 

1. Open the OpenRoads Modeling workspace > Geometry tab go to the Vertical Geometry 

section then click the Complex Geometry tool and choose the Profile Complex by 

Elements tool. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

• The Complex Elements dialog opens.  

• Checking the box next to any of the fields locks-in the associated value. 
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2. On the Complex Element dialog, expand the Method drop-down and choose the Manual 

Option.   

• Manual allows the identification of the elements to include and the direction of 

the elements. 

• Automatic will select the elements based on juxtaposition. 

3. When you move the cursor into the Profile View, it is equipped with a command prompt 

requesting that you Locate First Element, move the cursor to one of the elements that 

you wish to include in the complex element and click on it. 

 

4. When prompted to Locate Next Element, move the cursor to another element that you 

wish to include in the complex element and data point. 

 

5. When prompted to Locate Next Element, move the cursor to another element that you 

wish to include in the complex element and data point. 
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6. When a line appears to link the elements, data point to create the new complex element. 

 

Note:  The line that appears between the elements vanishes upon confirmation. It is 

simply a visual aid to identify the component elements. 

 

  Profile Complex by PI 

Use the Profile Complex by VPI command to construct a profile complex defined by vertical 

points of intersection (VPI). 

1. In the Vertical Geometry ribbon group in the OpenRoads Modeling workspace > 

Geometry tab click the Profile Complex by VPI tool. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

• The Complex Element by VPI dialog opens.  

• Checking the box next to any of the fields locks-in the associated value. 

2. When the cursor moves into the Profile View, it is equipped with a command prompt 

requesting that you Enter First PI. Place the cursor over the initial point of intersection 

by data pointing at the location. 

 

3. When prompted to Enter Next VPI, use one of the following methods to designate a 

point through which the curve must pass (navigate the options by striking the left or 

right arrow keys on the keyboard): 
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• As the cursor moves, the value is updated in the prompt. Data point at the required 

value. 

• Enter a value for the Curve Length then strike the Enter key to lock in the value.  

Data point to accept. 

• Enter a value for the Vertical Curve Parameter then strike the Enter key to lock in 

the value.  Data point to accept. 

• Enter a value for the Slope then strike the Enter key to lock in the value. The slope 

can always be locked independently of the length or curve parameter.  Data point to 

accept. 

Note:  The VPI can be positioned dynamically or with the aid of Civil AccuDraw. The 

heads up prompt can also be used to lock desired slope value from the previous VPI to 

the current VPI. 

4. On the 3rd and subsequent VPIs, the Length and/or Curve Parameter can be used to 

control the curve placed at the previous VPI. For example, the length entered at the 3rd 

VPI prompt is used to define the curve at VPI 2 and 1. 

Vertical Curve Type 

The option for curve type can be changed in the dialog or by pressing Shift key on keyboard. 

Supported curve types are: 

• Parabola - Symmetric Parabolic Curve 

• Asymmetric - Asymmetric Parabolic Curve 

• Circular - A simple curve defined by radius 

 

  Simple Profile by PI 

Use the Simple Profile by PI command to construct a complex profile element by simply clicking 

locations of VPI’s in a profile view.  User may input a Vertical Curve Parameter only.  
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 Define Profile By Best Fit 

Use the Define Profiles by Best Fit tool to construct a profile complex defined by best fitting 

through a selected profile. For example, pick an existing ground profile and best fit a profile to 

match the ground.  The program will determine the profile based on an upper and lower envelope 

and desired and minimum curve information. 

 

 Profile Reverse Transition 

Profile Reverse Transition constructs reverse curves between previously drawn elements with an 

optional tangent length between the two curves. 

 

 

 Profile Offset Transition 

Profile Offset Transition constructs profile elements at an offset from a base element. The base 

element may be a line, arc, spiral, or complex. 
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3.5 ORD Common Tools - Profiles 

3.5.1 Table Editor 

 Within the Geometry tab of OpenRoads Modeling, locate the Common Tools group. Table 

Editor tool can be used on horizontal or vertical geometry. Table Editor displays K values, back 

slope, back tangent length, and allows either parabolic and/or arc defined geometry for vertical 

geometry.  Edit any of the geometry that is available for edit and select Apply. 

 

 

3.5.2 Transform Tool 

Within the Geometry tab of OpenRoads Modeling, locate the Common Tools group.  

  Transform tool can be used on horizontal or vertical geometry.  Options for this tool 

depend on the active model when the tool is invoked.  With the profile model active, Copy and 

Scale options are available. Options are also available to transform from English to Metric units 

as well. 
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Transforms can be saved for future use. 

Setting Description 

Transform Select a transform. 

Choose Foot to Meter, Foot to 

USFoot, Meter to Foot, Meter 

to USFoot, USFoot to Foot, or 

USFoot to Meter. 

 
Browse Transforms 

 

 
Reset All Transforms 

 

 
Enable to translate elements. 

Choose one or more Enable to 

rotate elements, Enable to 

scale elements, or Apply 

transforms to Z or elevation 

values. 

 
Scale 

Choose Scale or Active Scale. 

 Select 4 points to set 

scale value. 

Translate Select translate option. Choose Cursor Point, Deltas, 

or Points. 

Active if Enable to translate 

elements is enabled. 

Copy Enable to make a copy. 

 
Save Transform 

 

 
Duplicate Transform 

 

 
Delete Transform 

 

 

3.5.3 Simplify Geometry 

Within the Geometry tab of OpenRoads Modeling, locate the Common Tools group. 

 Simplify Geometry The tool reduces the rules to the defining geometry. In other words, it 

removes rules and relationships from other elements, which includes snap rules, offset rules, and 
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intervals from other elements that constructed the geometry. After running the tool, the geometry 

reflects the ruling of geometry that is imported in from ALG, GPK, FIL, and LANDXML. 

 

This tool should be used with caution, since the referencing rules that constructed the geometry 

are removed. This means the original design intent no longer exists and the geometry will no 

longer update since it no longer monitors these elements for changes. 

 

3.6 Profile Rules 

Several tools exist in various locations in the Geometry tab of the OpenRoads Modeling ribbon.  

These tools create rules and remove rules on profile geometry.  The tools shown here can be 

useful when working with the Vertical Geometry line work. 

3.6.1 Create Civil Ruled Feature 

Within the Geometry tab of OpenRoads Modeling, locate the Design Elements drop down and 

select the down arrow.  

 

  Use the Create Civil Rule Feature tool to assign Civil Geometry rules to elements created 

by tools other than civil geometry tools. For example, MicroStation smart lines can become Civil 

Geometry ruled elements complete with manipulators and all the editing capabilities that derive 

therefrom. 

In profiles, base elements with active profiles that are then complexed in horizontal, automatically 

pass the base elements forward (requires active profiles). Where this is true vertical geometry it is 

not editable in the complex profile because it is controlled at the element profile level. A copy can 

be made that is a vertical element snapshot that is editable using the Copy Vertical tool discussed 

earlier. 

Example: Smartline to Civil Profile Element 
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3.6.2 Remove Rules 

 Within the Geometry tab of OpenRoads Modeling, locate the Civil Toggles drop down and 

select the down arrow. Use the Remove Rules command to remove rules on selected elements. 

When rules are removed, the manipulators are unavailable for editing and the elements will not 

update.  This will basically turn the element into a standard MicroStation element with no civil 

rules. 

 

       

3.6.3 Profile Reports 

 Within the Geometry tab of OpenRoads Modeling, locate the General Tools group in the 

ribbon and select Reports down arrow.  Choose Profile Reports.  Left click on a profile 

line, curve or complex element.  Reset to complete.  When finished, the report will generate with 

the default style sheet.  You may click on other vertical reports and using the Tools > Options 

pull down to modify the way the report displays the information. 
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3.7 Exercise 1 (Group): Create Route 54 Profile - Part 1 

1. Within the Roadway/data-3 folder, open the file: Civil_Geometry_J5P3181.dgn 

2. Open the Coordinate System tool by selecting the OpenRoads Modeling 

Workflow ➔ Utilities Tab ➔ Geographic Section. 

3. If not already set, Choose the “From File” icon. 

 

4. Select the Terrain_J5P3181.dgn file in the data-3 folder. 

5.  Verify the settings.  

 

6. If not already set change the Annotation Scale to 1”=50’ 

7. Set J5P3181 as the active Terrain Model. 

8. After Left Clicking on the Route 54 Alignment select Open Profile Model from the 

heads-up display. 

9. When prompted to Select or Open View, select View 8 from View Groups and data 

point in the view. 

10. Use Zoom (the roller button on the mouse) and the Pan (hold the roller button down) to 

navigate around the profile model. 
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11. Use the Profile Complex By VPI tool and create a “rough draft” proposed profile that 

has 3 VPIs.  Adjustments to rough draft profile will be made in next steps. Do not Snap 

or AccuSnap to any location in the profile window. 

The Profile Complex By VPI tool is located under the OpenRoads Modeling Workflow 

➔ Geometry Tab ➔ Vertical Section ➔ Complex Geometry Tools. 

In the dialog set the following items: 

 

Note: AASHTO 2018 page 3-165 states “For simplicity, a Parabolic Curve with an 

equivalent vertical axis centered on the Vertical Point of Intersection (VPI) is usually 

used in roadway profile design.” 

 

12. After the “Rough Draft” profile has been placed use the chart above adjust the VPI’s 

Station values. 

13. Next, using the chart above adjust the Grade Values for profile.   

14. Lastly, using the chart above adjust the Curve Length for the Vertical Curve defined in 

the profile. 

15. Select the new Profile using the Heads Up display and select Set As Active Profile. 

16. Select the new Profile using the Heads Up display and select Profile Report.  Verfify 

your Profile data matches data on the next page. 

17. Select File ➔ Update Server Copy.  
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3.8 Exercise 1 (Group): Create Route 54 Profile - Part 2 

1. Next we are going to create the profile a second way using Civil AccuDraw to place the 

Vertical Curve information.  First we need to delete the previously store profile by 

selecting the Route 54 Propose Profile and using the heads up disply and selecting 

Delete.   

Select the Profile Complex By VPI tool.   

The Profile Complex By VPI tool is located under the OpenRoads Modeling Workflow 

➔ Geometry Tab ➔ Vertical Section ➔ Complex Geometry Tools. 

In the dialog set the following items: 

 

2. Activate the Civil AccuDraw tool.  

3. Snap or AccuSnap to the beginning point of the existing ground. 

4. This time using Civil AccuDraw and its “Z” and “Slope” mode, create the same Route 54 

Proposed profile using the following criteria: 

 

 

5. Select the new Profile using the Heads Up display and select Set As Active Profile. 

6. Select the new Profile using the Heads Up display and select Profile Report.  Verfify 

your Profile data matches data on the previous page. 

7. Select File ➔ Update Server Copy.  
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3.9 Exercise 2 (Individual): Create Ramp 4 Profile 

1. Continue working in the Civil_Geometry_J5P3181.dgn 

2. After Left Clicking on the Ramp 4 Alignment select Open Profile Model from the 

heads-up display. 

3. When prompted to Select or Open View, select View 8 from View Groups and data point 

in the view. 

4. Use Zoom (the roller button on the mouse) and the Pan (hold the roller button down) to 

navigate around the profile model.  

Connector Road crosses over our new Ramp 4.  There is an active profile for the Connector 

Road. Place a point in the profile window at the elevation of the intersection. 

5. In the OpenRoads Modeling workflow, locate the Vertical group in the ribbon. Click the 

arrow by Profile Creation and select Profile Intersection Point. 

a. For the “Locate Element to show Intersection”, 

select the Ramp 4 alignment 

b. For the “Locate Element which Intersects”, select 

Connector Road. 

 

 

 

 

Elevation of Connector Road Profile as it crosses the Ramp 4 alignment 

 

 

 

 

 

 

 

 

 

 

 Note: The User might need to turn the Line Weights on in the Profile View to better see the 

Intersecting Point. 
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6. Turn on Civil Accudraw. Select the Slope mode. 

 

7. Select the   Profile Line Between Points tool and snap to the magenta point that 

represents the Connector Road 

 

 

8. Key in Station 2+50 and hit Enter 

9. Key in Slope of -4.00% and hit Enter 

10. Accept the location with a Left Click 

11. Using Profile Line Between Points tool, snap to the end of the previous line at 2+50 

12. In Civil Accudraw, key in station 9+00 and hit Enter 

13. For slope, key in 5.50% and hit Enter 
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14. Using Profile Line Between Points tool, snap to the end of the previous line at 9+00 

15. Next, snap the end point to the Existing Ground at the end of the Alignment 

 

Next we need to have a curve that goes through the PI points created. 

16. Use the  Profile Curve Between Elements tool to create a curve between the lines that 

have been drawn.  Choose Parabola Between Elements  

 

Note: AASHTO 2018 page 3-165 states “For simplicity, a parabolic curve with an 

equivalent vertical axis centered on the Vertical Point of Intersection (VPI) is usually 

used in roadway profile design.” 

17. Fill in the Length of 340’ 

18. Select the First Element  
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19. Select the Second Element  

 

20. Accept the 340’ Length 

21. Trim Both and Accept 

 

22. Use the  Profile Curve Between Elements tool to create a curve between the next lines 

that have been drawn.  Choose Parabola Between Elements  

23. Fill in the Length of 300’ 

24. Select the first element, choose the tangent line from 9+00. 

25. Select the second element, which is the last tangent line 

26. Accept the 300’ length above the profile 

27. Accept Trim/Extend Both 

 

 

28. Select the Profile Complex by Element tool under the Vertical ribbon Complex 

Geometry 
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Name the Profile Ramp 4 Proposed 

Set Method to Automatic 

Set Feature Definition to Alignment > MoDOT_Baseline_Proposed 

 

 

Highlight the first tangent towards the beginning of that line so that the arrow points right 

 

29. Select the first line and accept the entire element to create one element. 

 

 

30. Select File > Update Server Copy. 

 



Chapter 3 - Vertical Geometry  OpenRoads Designer Road 1  
 

3-44 Missouri Department of Transportation 1/11/23 

31. Create the Profile Report.  Verify your Profile data matches data on the next page. 
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3.10 Exercise 3 (Bonus - Individual): Create Ramp 2 Profile 

1) Continue working in the Civil_Geometry_J5P3181.dgn 

2) Using what you have learned from this chapter, create the following profile for Ramp 2.  

3) Name the profile Ramp 2 Proposed 

 

1. Select the new Profile using the Heads Up display and select Set As Active Profile. 

2. Select the new Profile using the Heads Up display and select Profile Report.  Verfify 

your Profile data matches data on the next page. 

3. Select File ➔ Update Server Copy.  
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4.1 Objectives 

• Learn the MoDOT Template Library 

• Work with Components, End Conditions and Templates 

• Understanding Template Points 

4.2 Definitions 

The Create ribbon group in the OpenRoads Modeling workspace > Corridors is a collection of Open 

Roads tools that are used to create and modify corridors.  One aspect of this group is the Template 

icon.  This icon can be used to open an ITL, which is an OpenRoad Template Library. CADD Support 

has created a default template library.  This library contains most used components and end conditions 

at MoDOT.  A limited number of templates are available through this template library.  The intent is 

for the user to assemble his/her own templates giving the districts more flexibility in their design; 

therefore, the default MoDOT library needs to be copied to the user’s working directory when creating 

new projects. 

4.3 Template Creation Tools 

The first step to creating a 3D model is to create templates for the roadway design. Templates are 

dynamic typical sections used in Corridor Modeling that use transverse geometry to create 3D models.  

Each template contains a series of points and components that represent breaklines, which are used to 

create the roadway surfaces.  All these points, components, and templates are stored in the template 

library (itl). 

 To access the Create Template Dialog, select the icon through the OpenRoads Modeling 

workflow, locate the Corridors Tab in the ribbon. The tool is in the Create group of this ribbon.  
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There are three options under the template drop down 

 

4.3.1 Create Template 

The Create Template tool will open the current ITL.  If this is the first-time opening ORD, it will open 

the Standard MoDOT.itl.  You can save the ITL into your current project. The ITL contains all the 

Templates, components, end conditions, etc. that will make up your typical section. This dialog will be 

discussed further in this chapter. 
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4.3.2 Import Template 

 Import Template allows you to import a template from graphics previously identified in a 

selection set.  MicroStation Elements drawn together can be selected to create a custom template that 

will be placed in the current ITL.  Choose what type of elements you are trying to create, determine the 

vertical exaggeration and chord lengths.  Choose elements from the origin point out. Define the origin 

point and hinge points and a generic template will be created. 

 

 

 

4.3.3 Display Template 

 Display Template is used to draw MicroStation elements into the DGN from the Template 

Library.  This may be modified with MicroStation tools and imported back into the Template Library. 

All MoDOT specific information is lost and may not function as expected if used on a MoDOT 

project. 
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4.4 Create Template Dialog 

The Create Template Dialog is composed of three major areas: Folder Tree Window, Current 

Template Window, and the Template Preview Window, which are shown below. 

  

Folder Tree Window 

This view allows the user to navigate through the template library selected.  The folder tree structure 

begins with the template library.  Underneath, the user will find the following categories: Point Name 

List, Components Folder, End Conditions Folder, CADD Support Templates, and District User 

Templates. This window is completely user definable, and it has all windows capabilities like right 

click functions, copy, paste, drag and drop. 

Point Name List 

This list contains previously created names to be utilized in the creation of new points for creating 

components for templates. Each point on a template must be unique, so no point can have the same 

name.  CADD Support has created a point name list for standardization. 

Components 

A component is a set of points defining an open or closed shape that represent different portions of the 

template.  For example, pavement structure, curbs, gutters, shoulders, medians, retaining walls, etc.  

MoDOT default library has many components from which to choose to create templates.  These 

components are organized in categories according to functionality.  These components do not include 

side slope conditions. 

Folder 

Tree 

Window 

Template 

Preview 

Window 

Edit 

Template 

Window 
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End Conditions 

End conditions are simply side slope condition components that tie to existing ground.  These include 

fill slope, cut slopes, ditches and/or combination thereof. 

CADD support templates 

The MoDOT standard template library will contain a limited number of templates.  Only these 

templates will be housed in this folder.  

District user templates 

The user will save the template library in his/her working directory and 

will be able to modify the library by adding new templates or 

components.  Any templates created by a district user should be stored in 

this folder.   

Preview Template Window  

The template preview window shows the template that is highlighted in the folder tree view.  A Cyan 

color box denotes the placement location for that template.  Usually this is at the origin of the 

template, but the user can click on any point to move the placement point location. The user can drag 

and drop from the preview are to the current template window. 

Current Template Window 

This is the large window on the right hand side of the Create Template Dialog where templates are 

assembled and edited.  The current template window shows the user the name, description and design 

of the template currently being edited, reviewed or assembled.   
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4.4.1.1 DISPLAY OPTIONS 

The two radio buttons allow the user to choose what to display in the center window.  The 

Components option shows the typical section component/template picture.  The Constraints option 

show how each point in the component/template is constrained to each other.  Constraints will be 

covered in another section. 

There are two check boxes the user can select for displaying various portions of the template.  When 

the Display Point Names option is checked on, all the point names in the current template are 

displayed.  Point names are long and when displayed the window can be too cluttered. Sometimes 

templates have hidden components controlled by certain design situations. This concept will be 

discussed in a later chapter. When the Display All Components option is selected, these hidden 

components are displayed.  

Center Window 

The center window is the main graph for creating/modifying templates.  This window has its own 

graphics engine and so it is not a MicroStation window. The scale of the graph is dynamic and changes 

as you zoom in and out. 

The center point of the window is marked by the dynamic origin, which is a magenta-colored box.  

The dynamic origin is used as a reference point and can be moved to any location in the graph. 

View Commands 

 

These commands are similar to the MicroStation view commands.  They allow the user to perform the 

standard zoom in/out, zoom in/out in the X direction, zoom in/out in the Y direction; window in an 

area, and fit the view, undo, redo, and set dynamic settings.  
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Testing End Conditions 

Test – Opens the Test End Conditions dialog box.  This tool allows the user to test the end condition 

solutions. 

 

This tool displays the current template; the non-solved end conditions and their child components are 

displayed in dashed lines.  The normal components and solved end conditions are displayed as solid 

lines. 

The Available Targets area lists all of the targets available whether they are surfaces or specific 

Feature Definitions. The user simply selects the desired target, sets the Surface Slope, and then clicks 

on Draw to test. The Surface Slope is the slope of the surface that is being placed. The Reset button 

clears all the drawn targets. 

Display Rules - list the display rules for the current template. Left-click over a value to toggle 

between True and False.  Press the Reset button to restore the original Display Rules values. 

Failure Report – activates the Results dialog.  When a template fails to get a solution on one or both 

sides, the results show which components failed and which end condition start points were not solved. 

Check Priorities – tests the template for priority conflicts.   Each end conditions starting at the same 

point has a priority assigned, and must be unique.  When a conflict exists, a message is displayed 

indicating there are end conditions starting at the same point having the same priority assigned.  If 

there are no conflicts, a message box indicating no conflicts is displayed. 
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Check Duplicates – checks for duplicate feature and component names for the given solution. If 

duplicate feature or component names are found, the Duplicate Feature Name List dialog is displayed. 

If no duplicates are found, a message to this effect is displayed.  

Close – dismisses the dialog. 

Help – displays the help for this dialog. 

Dynamic Settings 

Similarly to the MicroStation AccuDraw tool, the Dynamic Settings 

are used for precision input of the template components and to 

assign point names and Feature Definitions when creating 

components. 

It also serves as a compass for the cursor location with respect to the 

dynamic origin.  The dynamic origin can be modified by using the 

“Set Dynamic Origin” at the bottom of the dialog box. 

Accessing the Dynamic Settings 

The Dynamic Settings can be accessed by selecting Tools>Dynamic 

Settings or by using the view control icon . The dynamic setting 

Step should be set to x = 0.1, y = 0.1 before creating templates to allow for easy dynamic positioning. 

Precision Key-In Commands 

XY = Key-in absolute coordinates (x, y) 

 

DL = 

 

Key-in delta coordinates from last point placed (defaults to the dynamic origin if it is the 

first point of a component 

 

HS = 

 

Key-in horizontal delta distance and slope from last point placed 

 

VS = 

 

Key-in vertical delta distance and slope from last point placed 

OL = Key-in delta coordinates from dynamic origin 
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Creating Templates from Components 

Templates can be assembled by dragging and dropping components and end conditions into the 

Current Template window one at a time.   

Each point on a component has a unique point name.  These point names are created without being 

specific to “left” or “right” side of the roadway.  The user assigns a prefix or suffix to determine “left” 

or “right” when creating the template via the Dynamic Settings. 

Creating components will be covered in a later chapter. 

Dragging and Dropping Components 

When two points coincide, a heavy white plus sign will appear.  When connecting two components 

together, the existing connection point name will override the dropped point name.  Dynamic Settings 

should be set before starting to drag and drop components to create a template. 

Once a component is created, it can be modified by editing any property, inserting new points, or 

creating display rules. Once two or more components have been combined, they can also be merged. 

To edit components, simply right-click between the components to access the editing commands.  
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Basic Template Creation Workflow 

1. Open Template Library 

2. From the folder tree view, right-click and select Create > New Template 

3. “Drag and drop” template components 

4. Merge Components 

5. Verify Point Names 

6. Save the Template Library 

Pull Down Menus 

File – allows the user to create a new template library, new folder, or new template; open another 

library, save the current library, or import a template from another library. 

Edit – has the common Windows commands undo, redo, cut, copy, paste, clear, delete, and rename. 

Add – has all the options for developing new components. Components are covered in a later chapter. 

The Tools menu offers several tools to manage the template library, but the only two tools pertaining 

to the MoDOT template library are the Dynamic Settings covered in section 2.6 and the Template 

Library Organizer, which allows the user to copy components and templates from one library to 

another. 

Point Constraints 

Templates and components are defined by the points making their shapes. Thus point constraints are 

used to manage the behavior of all template points. The purpose of point constraints is to create 

relationships between the points in a template so that if one point moves, the other points follow in a 

predictable manner. 

Each template point has a maximum of two constraints on it.  A template point with two constraints is 

considered “fully constrained” and is represented graphically by a red plus sign on the template 

display. A template point with only one constraint is considered “partially constrained” and is 

represented graphically by a yellow plus sign. A point with no constraints is considered 

“unconstrained” and is shown as a green plus sign. 

Types of Constraints 

There is a total of 11 different types of constraints:  

Horizontal - Allows the placement of a new point (or child point) a specified horizontal distance from 

a reference point (or parent point). 

Vertical - Allows the placement of a new point (or child point) a specified vertical distance from a 

reference point (or parent point). 
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Slope - Allows the placement of a new point (or child point) using a specified slope from the reference 

point (or parent point).  Slope constraints are absolute.  Slopes going from lower-left to upper right are 

positive regardless of whether the child point is to the left or right of the parent. 

Horizontal Maximum - The child point has two parent points and remains at the specified horizontal 

distance from the parent point that is farthest to the right (has a maximum horizontal or X value).   

Horizontal Minimum - The child point has two parent points and remains at the specified horizontal 

distance from the parent point that is the farthest to the left. 

Vertical Maximum - The child point has two parent points and remains at the specified vertical 

distance from the parent point that is the highest (has a maximum vertical or Y value). 

Vertical Minimum - The child point has two parent points and remains at the specified vertical 

distance from the parent point that is lowest (has the minimum vertical or Y value). 

Vector-Offset - The child point is projected onto the vector defined by two parent points.  If the offset 

is not zero, then the child point will maintain a perpendicular offset from the parent vector at the 

specified offset value.  Negative values indicate an offset to the left of the vector defined by the parent 

points. Positive values indicate an offset to the right. If the offset is zero, the child point is located on 

the parent vector. 

Project to Surface (to Existing Ground) - This constraint must be used in conjunction with one of 

the previously defined constraints. The other constraint will define the projection direction. The child 

point will then be projected to the surface with the specified name.  If the surface does not exist, or no 

solution is found, the point will remain where it is placed in the template. 

Project to Design - This constraint is similar to Project to Surface, except that the point is projected to 

the design surface of the template.  A projection value is given to indicate whether the projection is to 

be to the left or to the right.  Again, the point must also be constrained by one of the previous 

constraints, excluding the Project to Surface constraint, so that a direction for the projection may be 

determined.  If no solution is found, then the point will remain where it is placed in the template. 

Angle distance - This command is used to fully constrain a point in the template.  This constraint 

requires two parent points, a distance, and an angle.  The point is constrained to the location defined by 

the distance from the first parent, and the angle from the first parent relative to the vector defined by 

the two parent points.  This constraint creates a rigid-body rotation.  When selected, no other constraint 

types are available. 

 

 

 

 

Parent-Child Point Relationship 

When a template point is constrained by either one or two other points, it is considered the “child” of 

those reference points.  The reference points are then known as the “parent” point(s). 



OpenRoads Designer Road 1  Chapter 4 - Creating Templates

  
 
 

4-12 Missouri Department of Transportation 3/15/23 

If the parent point moves, the child also moves based on the constraints established. 

 

 

 

 

 

Example: 

Point B is a child of point A.  Point A is unconstrained and shown as a green plus sign on the screen.  

Point B is fully constrained.  Point B has a horizontal and a slope constraint, and is shown as a red plus 

sign.  In addition, the parent point (Point A) has a blue arrow pointing to the child point (Point B). 

 

Visual Indicators for Vertical, Horizontal and Slope Constraints 

 
 

Modifying Constraints 

Once a point has been created with or without constraints in a template, it can still be modified. 

Modifications include: adding or deleting constraints, or changing the type of constrained originally 

set for a point. 

 

 

 

Child is vertically constrained to parent.  When the parent 

point moves, the child point follows at a constant vertical 

distance to that point. 

Child is horizontally constrained to parent. When the parent 

point moves, the child point follows at a constant horizontal 

distance to that point. 

Child is constrained to parent by a slope. When the parent 

point moves, the child point follows a constant slope with 

respect to the parent point. 

Point A 

Point B 
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4.5 Template Components 

Templates are a grouping of several components, and each component is a set of points that defined an 

open or closed shape.  Each component represents a material for the typical section at a particular 

location.  Each component is given a name and assigned a Feature Definition.  A Feature Definition is 

simply the MicroStation symbology used to draw the component both in cross section view as well as 

plan view. 

There are six types of components: Simple, Constrained, Unconstrained, Null Point, Overlay, and End 

Condition. 

Once created, components can be modified as desired. There is no limit to the number of points or 

components in a template. When templates are paired with horizontal and vertical alignments and 

superelevation, they define the surface of a corridor. Templates are flexible design components that 

allow you to model simple highway design items such as ditches and sidewalks to the more complex 

multi-lane highways with superelevated curves and variable side slopes. 

4.5.1 Simple Component 

A simple component is a closed parallelogram (4 constrained points) that is defined by the slope and 

thickness (for example, a pavement layer). In this case, if any point is moved, the entire shape moves 

keeping the same relationships determined by the original slope and thickness, making this a rigid 

shape. 

4.5.2 Constrained 

A constrained component consists of points that are all restricted to the movement of the first point. A 

constrained point is typically used to manage the behavior of other points in the template. When a 

point (parent) is moved, any constrained point (child) also moves. This restriction only affects the 

offset and elevation (x, y) of the restrained point and, the relationship is unidirectional (movement of 

child point does not move the parent point).  

4.5.3 Unconstrained 

An unconstrained component is open or closed-shaped with no movement restrictions. This type of 

component is only used for very specific purposes, such as “tracing” a previously placed component. 

4.5.4 Null Point 

A null point is a template point that is purposely not related to any particular component. It’s most 

often used as a reference for controlling other points.  A null point is considered a “check or test 

point”. For example, a null point is used to check if there is an entrance to the right or left of the 

alignment. 

4.5.5 Overlay 

This is a special type of component that allows the user to add overlay/stripping properties in order to 

calculate milling, and/or leveling (overlay) quantities.  
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4.5.6 End Conditions 

An end condition is a special open-shaped component that targets a surface, a surface Feature 

Definition, an elevation, or an alignment.  In other words, the end condition components are simply the 

fill/cut/ditch slopes or benching which tie back to ground. The integrity of end conditions can now be 

routinely tested while the roadway template is being created. 

4.6 Creating Basic Components 

4.6.1 Point Name List and Feature Definition 

Each point used for creating a component must be given a name and a Feature Definition associated 

with such.  CADD Support has created a point name list from which to select.  Point naming 

convention is extremely important in the creation of templates, so 

especial attention must be paid while creating individual 

components. 

4.6.2 Setting Display Options 

The dynamic settings need to be set prior to creating a 

component, end condition or template.  

Key-In 

Specifies the type of key in to be performed. 

• XY= key in absolute coordinates 

• DL= key in delta coordinates from last point placed (defaults to the dynamic origin if it is the 

first point of a component. 

• HS= key in horizontal delta distance and slope from last point placed. 

• VS= key in vertical delta distance and slope from last point placed. 

• OL= key in delta coordinates from dynamic origin. 

• OS= key in horizontal delta distance and slope from dynamic origin. 
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4.7 The Sign of the Distance and Slope 

 

When defining components with precision input, the sign of the distance is dependent on the parent-

child relationship. The parent is always the first point placed when creating template components. The 

distance is positive if the parent has a lower X or Y value than the child. The distance is negative if the 

parent has a higher X or Y value than the child. The sign of the component slope is based on the 

mathematical slope. 

4.7.1 Adding Components  

Adding components is a simple process guided by dialog boxes, but point name and placement must 

be carefully thought of before starting the process.  The steps are as follow:  

1. Create the component structure in the library folder tree to the left. 

2. Activate and set and activate the setting display options. 

3. Right click on the current template window and select Add New Component. 
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4. Select the type of component desired. 

 

5. Populate the display setting options and current component dialog. 

 

 

6. Data point to the origin to start placing the component or type 0, 0 using the x, y key-in.  

 

7. Add points by using the precession key-in commands in the dynamic settings to finish the 

desired shape. For unconstrained and constrained components, once the shape has been 

drawn, right click and select Finish to complete. 
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Once a component has been created, it can be modified visually by adding, deleting points or taking 

away/adding constraints.   

 

 

Also, the component can be modified through the point properties dialog box.   

Note: In order to modify a component, the user must modify the points making up the component. 
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4.7.2 Point Properties Dialog  

To access the Point Properties dialog box, right click on the point to modify and select Edit Point. 

 

 

4.7.3 Basic Component Creation Workflow 

1. Open a template library 

2. Navigate to folder where component will be placed 

3. Right click on folder, and select Create Template 

4. Select and set dynamic settings 

5. Create components by using the point names in the point list 

6. Edit any points if necessary 

7. Save template library 
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4.8 Creating an Overlay/Stripping Component 

Creating an overlay/stripping component is similar to creating a basic component.  The only difference 

is that overlay/stripping components are a single line “closed” components and they have additional 

attributes to determine overlay/milling quantities.  Detail creation of an overlay/stripping component 

will be covered in the Overlay Tools chapter. 

4.9 Creation of Basic End Conditions 

End conditions are components of the template used to create cut and fill treatments.  These end 

condition components have a specific target such as, terrain models, elevations, horizontal and vertical 

alignments.  

4.9.1 Target Types 

Target types are defined only for end condition components, and are a property of that component.  An 

end condition solution can intercept multiple targets and target types.  For example when designing a 

special ditch, the sideslope condition “targets” the special ditch profile elevation, and then intercepts 

the original ground terrain model to form the ditch bottom and backslope. 

4.9.2 End Condition Settings 

End conditions will draw based 

on the targets and settings set.  

These settings are considered 

specifically end condition 

properties and are 

enabled/disabled through the 

point property dialog box. The 

end condition settings are 

described below. 

Check for Intersection – when 

set, the line segment will search 

for the specified target. If not 

set, the line segment will be 

created at its full width 

regardless of whether it 

intersects the target, provided that one of the segments connected to this segment successfully 

intersects the target. 

Place Point at Interception – when set, a point will be placed at the location of the interception. If not 

set, the line segment will be created at its full width, provided that one of the segments connected to 

this segment successfully intersects the target. 

End Condition is Infinite – when set, the line segment will automatically be extended to intercept the 

target. If not set, the line segment will only extend to its maximum constraint to meet its target. This 

applies only to the last line segment in an end condition. 
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Do Not Construct - If set, the end point of the line segment will be used as a reference point to find a 

subsequent point. The point will be solved like any other end condition point, but that point will be 

skipped when drawing the final component segments. This is normally not set and is used only for 

more complex condition testing. 

4.9.3 Testing End Conditions 

Testing end conditions gives the user the ability to verify the solutions and priorities as well as testing 

multiple targets without using the Create Corridor tool. 

When creating end conditions, the user should test to see if desired results are generated.  This can be 

done before, during or after creation of the end condition.   

4.9.4 Basic End Conditions Creation Workflow 

1. Open a template library 

2. Navigate to the folder where templates will be stored 

3. Select create template 

4. Create a new template 

5. Create end condition components 

6. Test end conditions 

7. Save the template library 
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4.10 Group Exercise 4-1: Creating a Constrained Component - Curb 

1. Within the Roadway/data-4 folder, open the file: Civil_Geometry_J5P3181.dgn 

2. From the OpenRoads Modeling Workflow, open the Corridors Tab, select the Create 

Template icon. 

 

3. Select File > Save As from the Create Template dialog menus.  Save the MoDOT 

Workspace template library as J5P3181.itl in the Roadway\data-4 folder. 

4. Right click on the file path at the top of the dialog and create the following folder structure: 

J5P3181 ➔ Components ➔ Curbs 

 

5. Within the Curbs folder, create a new template named Curb. 

6. If the Dynamic Settings dialog is not displayed, select Tools ➔ Dynamic Settings.  Set the 

step increment to 0.10. 

7. If not set, toggle ON the Display Point Names check box in Create Template dialog. 

8. Right-click on the Current Template window and select Add New Component ➔ 

Constrained. 
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9. Setup the Current Component portion of the Create Template dialog as follows: 

• Component Name: CONCRETE CURB   

• Feature Definition: Mesh\Template Components\Curb Gutter\XS_Curb_Surface 

 

Note: See next page for dialog: 
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10. Setup the Dynamic Settings dialog as follows: 

• Point Name: SHDR (key in) 

• Feature Definition: Linear\Design\Template Point Features\Curb Gutter\XS_Curb_Surface 

• Apply Affixes: Disabled 

• Precision Input: x, y = 0, 0 

• Press the Enter key 

Notes:  

• Do NOT click the Set Dynamic Origin button.  This will change the template origin to the location 

in the dialog box. 

• The default units for precision input are feet. You can enter other units with the proper 

specification, such as 6" instead of 0.5. 

• Watch the prompts in the lower left corner of the Create Template dialog. 

• When creating a component using precision key-in, an ESC allows you to go back. 

11. Setup the Dynamic Settings dialog as follows: 

• Point Name: TOC (key in) 

• Feature Definition: Linear\Design\Template Point Features\Curb Gutter \XS_Curb_Surface 

• Apply Affixes: Disabled 

• Precision Input: xy = 0.07,0.5 (from similar triangles) 

• Press the Enter key 

12. Setup the Dynamic Settings dialog as follows: 

• Point Name: BOC (key in) 

• Feature Definition: Linear\Design\Template Point Features\Curb Gutter \XS_Curb_Surface 

• Apply Affixes: Disabled 

• Precision Input: hs = 5.5",0.0 

• Press the Enter key 

13. Setup the Dynamic Settings dialog as follows: 

• Point Name: BOC_BOT (key in) 

• Feature Definition: Linear\Design\Template Point Features\Curb Gutter \XS_Curb_Surface 

• Apply Affixes: Disabled 

• Precision Input: dl = 0.0,-16" 

• Press the Enter key 

14. Setup the Dynamic Settings dialog as follows: 

• Point Name: TOC_BOT (key in) 

• Feature Definition: Linear\Design\Template Point Features\Curb Gutter \XS_Curb_Surface 

• Apply Affixes: Disabled 

• Precision Input: dl = -7.75",0 

• Press the Enter key 
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15. Right-click on the Current Template window and select Finish. 

16. Enable the Display Point Names option. 
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4.11 Group Exercise 4-2: Creating an End Condition 

Create a Fill and Ditch End Condition in the same End Condition Template  by right-

clicking on the Template Window and select Add New Component > End Condition. 

In this exercise the design criteria calls for a 6:1 Fill and 6:1 Ditch slopes. 

1. From the OpenRoads Modeling workflow, open the Corridors tab, select the Create 

Template icon. 

 

2. Select File > Open from the Create Template dialog menus.  Open template library named 

J5P3181.itl from the J5P3181/Data04 folder. 

3. Navigate to the J5P3181 folder and create a new folder called End Conditions. 
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4. Within the End Conditions folder create a new template called Slopes (6:1). 

. 
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5. To create the new slope component, right-click on the Edit Template Window and select Add 

New Component > End Condition. 

 

6. Setup the Current Component portion of the Create Template dialog as follows: 

Name:    Fill Slope 

Feature Definition:  Mesh\Template Components\Grading\XS_Ground_Proposed

 Target Type:   Terrain Model 

Priority:   1 

Terrain Model:  <Active> 

 

 

 

 

 

 

 



Chapter 4 - Creating Templates   OpenRoads Designer Road 1 
 
 

3/15/23 Missouri Department of Transportation 4-29

  

7. For the first point setup the Dynamic Settings dialog as follows: 

Name: Fill_Slope_T (select from list) 

Feature Definition: Linear\Design\Template Point Features\Grading\XS_Ground_Proposed 

Apply Affixes: Disabled 

Precision Input: xy = 0,0 

 

  

8. With your cursor in the xy=0,0 field, press the Enter key on your keyboard. 

9. For the second point setup the Dynamic Settings dialog as follows: 

 

Check for Interception:        Enable 

Place Point at interception: Enable 

End Condition is Infinite:    Enable 

Do Not Construct:     Disabled 

Point Name:     Fill_Slope_B (pull-down) 

Feature Definition:              XS Ground Proposed  

Apply Affixes:      Disabled 

Precision Input:     hs = 30,-1:6 

 

 

 

 

 

 

 

 

With your cursor in the hs = 30 -1:6 field, press the Enter key on your keyboard. 

 

10. Right-click on the Edit Template window and select Finish. 
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The next few steps describe the steps need to build a Ditch End Condition  

 

 

 

 

 

 

 

 

 

11. Create Ditch End Components by right-clicking in the Current Template window and select 

Add New Component > End Condition. 

12. Setup the Current Component portion of the Create Template dialog as follows: 

Name:    Ditch 

Feature Definition:  XS Ground Proposed 

Target Type:   Terrain Model 

Priority:    1 

Terrain Model:  <Active> 
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13. For the first point setup the Dynamic Settings dialog as follows: 

 

Point Name:  Ditch_Frslp_1_T (select from list) 

Point Feature Definition: XS_Ground_Proposed 

Apply Affixes:  Disabled 

Precision Input:  xy = 0,0 

  

With your cursor in the xy=0,0 field, press the Enter key on your keyboard. 

 

14. To place the Fore-Slope bottom point, set the Dynamic Settings dialog as follows: 

 

Point Name:   Dtch_Frslp_1_B (select from list) 

Check for Interception:   Disabled (this forces this line segment to be placed) 

Place Point at Interception:  Disable 

End Condition is Infinite:   Disabled 

Do Not Construct:   Disabled  

Apply Affixes:    Disabled 

Precision Input:    hs = 24,-1:6 

 

 

 

 

 

 

 

 

 

With your cursor in the hs = 24,-1:6 field, 

 Press the Enter key 
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15. To place the Back of Ditch bottom point, set the Dynamic Settings dialog as follows: 

Point Name:    Dtch_Bkslp_1_B (select from list) 

Check for Interception:   Disabled (This forces this line segment to be placed) 

Place Point at Interception:  Disable 

End Condition is Infinite:   Disabled 

Do Not Construct:   Disabled 

Apply Affixes:    Disabled 

Precision Input:    hs = 4,0 

 

 

 

 

 

 

 

 

 

With your cursor in the hs = 4,0 field, 

 Press the Enter key. 

 

16. To place Slope-Stake point, set up the Dynamic Settings dialog as follows: 

 

Point Name:    Dtch_Bkslp_1_T (select from list) 

Check for Interception:   Enable 

Place Point at Interception:  Enable 

End Condition is Infinite:   Enable 

Do Not Construct:   Disabled 

Apply Affixes:    Disabled 

Precision Input:    hs = 5,25%  

 

 

Toggle on End Condition is Infinite 

 

 

 

 

 

 

With your cursor in the hs = 5,25.0%, 

press the Enter key. 

 

17. Right-click on the Edit Template window and select Finish. 
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18. Test the End Conditions by selecting the Test button located under the Current Template 

window.  A warning will be given about the template having end condition priority conflicts. 

 

19. Select Check Priorities on the right side of the Test End Conditions window. 

 

Notice the Fill_Slope_T point is the point that has the priority conflicts. 
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20. In the End Condition Priorities dialog select Edit. Notice that all the end conditions have the 

same priority number. 

 

Put your cursor in each of the fields and notice the segments highlighting. 

Assume that Ditch is the most desirable condition and change the Priority of the Fill Slope 

priority to “2”. 

 

21. Click OK, and then Close. 

22. Click Draw on the right side of the Test End Conditions window.  Move your cursor over 

the end conditions. 

23. Close the Test End Conditions dialog.    
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4.12 Individual Exercise 4-3: Creating an End Condition 

1. From the OpenRoads Modeling workflow, open the Corridors tab, select the Create Template 

icon. 

 

2. Select File > Open from the Create Template dialog menus.  Open template library named 

J5P3181.itl from the J5P3181/data-4 folder. 

3. Navigate to the J5P3181 folder and End Conditions, create a new template called  

Fill (4:1) Cut (3:1) 
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4. Create a Fill and Ditch End Condition in the same End Condition Template  by right-

clicking on the Template Window and select Add New Component > End Condition. 

In this exercise the design criteria call for a 4:1 Fill and 3:1 Ditch slope. 

Using the previous exercise create the following two end conditions.  Also test end conditions to 

make sure there are no conflicts. 

 

 

Note: In this exercise the User only needs to create the End Conditions shown above.  The User does 

not have to create any of the main components of the Roadbed (shoulder, pavement, etc.).  
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4.13 Bonus Individual Exercise: Creating a Curb and Gutter w/Sidewalk 
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4.14 Group Exercise 4-4: Creating a Template (Pavement w/Curb & Gutter) 

1. From the OpenRoads Modeling workflow, open the Corridors tab, select the Create Template 

icon. 

 

2. Select File > Open from the Create Template dialog menus.  Open template library named 

J5P3181.itl from the J5P3181/data-4 folder. 

3. Navigate to the J5P3181 folder and create a new folder named Ramp 4.  

4. Within the Ramp 4 folder, create a new template called Ramp 4 Pavement with Curb and 

Gutter by right clicking on the Ramp 4 folder and selecting New > Template. 
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5. Set the following Dynamic Settings: 

  

6. In Create Template go to Tools > Options and confirm the following Affixes are set: 
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7. Use the following Components and End Conditions to create the Ramp 4 Pavement with 

Curb and Gutter template: 

Setup Requirements: 
 

a) Make the concrete thickness 9-3/4” (-0.8125’) before adding Curb and Gutter Type B w/ 

Agg Base.  If you already place the Curb and Gutter, select “Undo”. 

b) Modify pavement width to 18 feet 

c) Have the pavement slope downward to the right at 2% 

d) After adding each Curb and Gutter move the CL Merge Point to opposite edge of pavement 

and merge points.  When asked which point to delete select CL Merge Point 

e) When bringing in the Cut Wall, merge the LT_Ret_Wall_Lower_Ground_Tie point to the 

LT_Curb_Surf_Back point.  Utilize the preview window to do this. 

f) Remove the LT_RetainingWallUpperGround End Condition from the Cut Wall. 

g) Place the Type A Gutter 6 inches down from the outside of the Cut Wall. 

h) Adjust the Sidewalk Outer Buffer to slope down away from Sidewalk at a -2% slope. 

i) At this time, do not worry about the unconstrained point within Cut Wall. 

j) Save Template Library 

 

Components: 
 

Left Side      Right Side 

 

Concrete Pavement w/ Agg Base    

Curb and Gutter Type B w/ Agg Base  Curb and Gutter Type B w/ Agg Base 

Cut Wall Case 5- use existing ground no profiles exist Sidewalk w/ Outer Buffer   

Gutter Type A  

 

End Conditions: 

 

Left Side      Right Side 

 

Ditch Back Slope 1 (4:1)    Ditch  

Fill Slope 1 (4:1)     

 

Concrete Pavement w/ Agg Base is in the following location:   

Components ➔ Pavement New ➔ Pavement Only ➔ Concrete 

Curb and Gutter Type B w/ Agg Base is in the following location:   

Components ➔ Curb and/or Gutter 

Cut Wall Case 5 - use existing ground no profiles exist is in the following location: 

Components ➔ Retaining Wall ➔ Cut Wall 

Sidewalk w/ Outer Buffer is in the following location:  

Components ➔ Sidewalk 

Gutter Type A is in the following location:   

Components ➔ Curb and/or Gutter 
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8. In Create Template select the Test button to check the End Condition Priorities. 
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4.15 Individual Exercise 5-5: Creating a Template (Pavement w/Shoulder) 

1. From the OpenRoads Modeling workflow, open the Corridors tab, select the Create Template 

icon. 

 

2. Select File > Open from the Create Template dialog menus.  Open template library named 

J5P3181.itl from the J5P3181/data-4 folder. 

3. Navigate to the J5P3181 folder.  

4. Within the Ramp 4 folder, create a new template called Ramp 4 Pavement with Shoulders by 

right clicking on the Ramp 4 folder and selecting New > Template. 
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5. Verify the following Dynamic Settings: 

  

6. In Create Template go to Tools > Options and confirm the following Affixes are set: 
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7. Use the following components to create the Ramp 4 Pavement with Shoulders template: 

Setup Requirements: 
 

a) Modify pavement width to 18 feet. 

b) Verify Pavement is sloping downward to the right at 2% 

c) Have the Left and Right Shoulder Slopes follow the pavement slope using a Vector Offset 

constraint. 

d) When bringing in the Cut Wall, select the LT_Ret_Wall_Lower_Ground_Tie point in the 

preview window and place it on top of the LT_Conc_T_O_EOS shoulder point. 

e) Remove the LT_RetainingWallUpperGround End Condition from the Cut Wall. 

f) Place the Type A Gutter 6 inches down from the outside of the Cut Wall. 

g) Adjust the all surface slopes of the Sidewalk w/ Inner and Outer Buffer to be -2% sloping 

downward to the  right 

h) At this time, do not worry about the unconstrained point within Cut Wall.  

i) Save Template Library. 

 

Components: 
 

Left Side      Right Side 

 

Concrete Pavement w/ Agg Base   A2 Shoulder Concrete Option 1 w/ Agg Base 
A2 Shoulder Concrete Option 1 w/ Agg Base Sidewalk w/ Inner and Outer Buffer 

Cut Wall Case 5- use existing ground no profiles exist    

Gutter Type A  

 

End Conditions: 

 

Left Side      Right Side 

 

Ditch Back Slope 1 (4:1)    Ditch  

Fill Slope 1 (4:1)    

    

Concrete Pavement w/ Agg Base is in the following location:   

Components ➔ Pavement New ➔ Pavement Only ➔ Concrete 

A2 Shoulder Concrete Option 1 w/ Agg Base is in the following location:   

Components ➔ Shoulders ➔ Concrete w/o Curb 

Cut Wall Case 5 - use existing ground no profiles exist is in the following location: 

Components ➔ Retaining Wall ➔ Cut Wall 

Sidewalk w/ Inner and Outer Buffer is in the following location:  

Components ➔ Sidewalk 

Gutter Type A is in the following location:   

Components ➔ Curb and/or Gutter 
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8. In Create Template select the Test button to check the End Condition Priorities. 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Close the Template Library and select “Save” to save the Template Library. 



 

3/15/23 Missouri Department of Transportation  

Chapter 5 

Corridor Modeling  
5.1 Objectives .............................................................................................................................. 5-1 
5.2 Corridor Modeling Overview ................................................................................................ 5-1 

5.3 Prerequisites ........................................................................................................................... 5-2 
5.4 Corridor Modeling Tools ....................................................................................................... 5-2 

5.4.1 Corridor Creation Tools ............................................................................................. 5-2 

5.4.2 Corridor Edit Tools ..................................................................................................... 5-6 
5.4.3 Superelevation Tools ................................................................................................ 5-11 
5.4.4 Corridor Miscellaneous Tools .................................................................................. 5-13 

5.5 Group Exercise: Creating a Corridor – Ramp 4 ................................................................... 5-26 
5.6 Individual Exercise: Creating a Corridor for Route 54 ........................................................ 5-36 
5.7 Group Exercise: Horizontal Feature Control ....................................................................... 5-40 

5.8 Group Exercise: Adding Right of Way to Route 54 ............................................................ 5-44 





OpenRoads Designer Road 1 Chapter 5 – Corridor Modeling Overview  
 

5-1 

 

5.1 Objectives 

• Create Corridor 

• Assign Multiple templates to one corridor 

• Create new templates from  existing templates  

5.2 Corridor Modeling Overview 

The Corridor Modeling toolset is a group of highly interactive commands to create new design 

surfaces that represent a new roadway or other type of surface. Tools for creation, modification, 

management, and report functions are supported. 

 

Corridor Modeling tools aggregates a variety of civil data. The geometry is created with the 

Horizontal and Vertical Geometry tools, while the existing ground is defined by a MicroStation 

mesh or Civil Terrain Model. Plan view elements, such as edges of pavement, shoulders, curbs, 

etc. can be 2D or 3D. Superelevation information is defined within a design file using standards or 

imported data. Templates are utilized from one or more template libraries. 

 

Reference files can be used extensively with Corridor Modeling. On a simple project, the data 

may be all in one file; larger projects may have geometry in one file, plan view graphics in a 

second, terrain in another, superelevation in a fourth and the actual model in a fifth. All files can 

reference the others, to present a complete picture of the project. 

 

When working with Corridor Modeling, you can draw in 2D or 3D. When using 2D (such as for 

plan-view graphics), a 3D view is automatically created and maintained. For example, when a 

vertical geometry element is initially defined for a horizontal geometry element, the Default-3D 

model is created, if there isn't one already. The 3D baseline (combination of horizontal and 

vertical element) is drawn into the 3D model. As template drops are added, and progressed, they 

are added to the 3D model automatically. 

 

When starting to create a corridor, basic information can be used. A single template can be used, 

along with preliminary geometry and a high level terrain model. As the design progresses, more 

detail can be added. Instead of a single template drop, perhaps more templates better define the 

roadway. Transitions can be added to smoothly move from one template to another. There may be 

multiple roadways all interconnected using the target aliasing tools. All the while, as changes are 

made, the corridor model is updating, so you see up-to-the minute results. Simple projects may 

not require all the tools, and a basic corridor model may be sufficient. But all the tools are 

available to handle basic to complex, small-scale to large-scale projects.  
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5.3 Prerequisites 

The following are minimum requirements to use Corridor Modeling. 

• One Civil horizontal element and one Civil vertical element, generally the centerline and 

profile of the design roadway 

• One template stored in a template library 

A terrain model is not required for corridor modeling. If the template includes end conditions 

and no terrain model is defined, the software generates as much of the model as possible, but 

will not complete the end condition that ties to ground and no error message is given. 

5.4 Corridor Modeling Tools 

 

5.4.1 Corridor Creation Tools 

The first toolbox is used when beginning design on a corridor and includes tools for creating 

corridors, template drops, and transitions; along with various tools for working with the 

template library. 

 

 

New Corridor - The New Corridor tool is the initial step in corridor design; names the corridor 

and identifies the geometry.  No processing of templates is done within this tool; rather it’s a set-

up step prior to template work. 
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After the corridor is created/drawn, the software automatically advances to the Create Template 

Drop tool. 

 

Create Template Drop - defines what the cross sections of the roadway look like for that portion 

of the road based on user-defined station range. A project may comprise of a single template drop 

or multiple template drops. Often, transitions are used between two template drops, rather than an 

abrupt change from one template to another. 

Careful consideration should be given for the Drop Interval used for a corridor, although it can be 

changed at any time. It specifies the distance between each processing of the template (in master 

units). Generally, this value is equal to or less than (but still a multiple) of the desired interval for 

the final cross sections, since cross section stations should be coincident with processing stations. 

It is not necessary to set the interval so small that it encompasses all desired cross section stations, 

as stations with particular project interest can be added to the model with the use of the Key 

Station tool. If the model is to be used in construction, the smaller the interval, the more detailed 

the model, but will require more processing time. 

Note Drop Intervals are impacted by the Design Stages. 

• Minimum Transition Before Drop and Minimum Transition After Drop are inputs in the 

Create Template Drop tool. If they are non-zero, then a transition drop is created at the 

beginning/end of the template drop with a length greater than or equal to the value 

entered. The actual length is determined by how far it is between the new drop and the 

drop before/after the new drop. If there isn’t enough space to meet the minimum, then the 

previous/next drop is shortened to accommodate the transition. If there is no 

previous/next drop, then no transition drop is created. 
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After completing the prompts, the corridor is automatically processed and can be viewed in both 

2D and 3D views. The corridor can be rendered, if desired. 

 

The symbology is based on the feature definitions within the template. The Project Explorer is 

also updated with the corridor information, including template drops, components and features. 

Create Template Drop Workflow 

Select the Create Template Drop tool. This tool is automatically invoked at the end of the Create 

Corridor tool, but you can use it independently of the Create Corridor tool. 

Select the Corridor wherein the template drop will be added. 

1. Select Template - Select the template from the pull-down list of recently used templates, 

or select <Alt> <Down> on the keyboard to open the active template library and select 

the template. Data point to accept the template and move to the next prompt. 

2. Start Station - Graphically define the start station or enter the value in the edit field.  

Data point to accept and move to the next prompt. The Start station can be locked by 

<Enter> after keying in the station or selecting <Alt>.  Selecting <Alt> again unlocks 

the field. 

3. End Station - Graphically define the end station or enter the value in the edit field. Data 

point to accept and move to the next prompt. The End station can be locked by <Enter> 

after keying in the station or selecting <Alt>. The template is copied to the new station 

range. Selecting <Alt> again unlocks the field.  

4. Drop Interval - specifies the distance between each processing of the template (in master 

units). Generally, this value is equal to or less than (but still a multiple) of the desired 
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interval for the final cross sections, since cross section stations should be coincident with 

processing stations. Note that this is impacted by the Design Stages. 

 Copy Template Drop - As an alternate to creating and modifying a template drop, this tool 

copies an existing template drop to a newly defined station range along the same baseline 

reference. 

The Copy Template Drop tool can be used as an alternate to creating and modifying a template 

drop, as the tool copies an existing template drop to a newly defined station range along the same 

baseline reference within the same corridor. 

 

Copy Template Workflow 

1. Select the Copy Template Drop tool. 

2. Locate Template Drop - Select the previously created template that you want to copy to 

a different location. 

3. Start Station - Graphically define the start station or enter the value in the edit field. 

Data point to accept and move to the next prompt. The Start station can be locked by 

<Enter> after keying in the station or selecting <Alt>. Selecting <Alt> again unlocks the 

field. 

4. End Station - Graphically define the end station or enter the value in the edit field. Data 

point to accept and move to the next prompt. The End station can be locked by <Enter> 

after keying in the station or selecting <Alt>. The template is copied to the new station 

range. Selecting <Alt> again unlocks the field. 

 

Create Template - Opens the current template library to add a new template, delete or modify an 

existing template.   
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5.4.2  Corridor Edit Tools 

This ribbon contains tools for editing of a previously created corridor and associated template 

drops. These tools enable you to refine the model by adding more detailed information to respond 

to project-specific requirements and constraints. 

 

 

Edit Template Drop - Opens the current template library and displays the template with the 

selected template drop.  While the dialog is the template library interface, keep in mind that the 

editing is only being done to the template within the template drop, not the actual template library. 

Therefore, if any changes are made, the template associated with the template drop is no longer in 

sync with the template library. For project specific circumstances, this may be required. The tools 

and options within the edit template drop function identically to those in the template library, 

except the File tools are not available. 

If the changes are needed in the template library, use the Create Template tool. 

To update the template associated with the template drop to match the template in the template 

library, use the Synchronize with Library tool. When this tool is used, the template from the 

template library overwrites the template associated with the template drop, so all changes are lost 

with no warning given. 

Edit Template Drop Workflow 

1. Select the Edit Template Drop tool. 

2. Locate the Template Drop. Select the template drop whose template needs editing. The 

Editing Roadway Design Template Drop dialog (whose interface is identical to the 

Template Library dialog) opens with the current template. 

3. Edit as needed. Click OK to close the dialog. You do not have to File > Save to save your 

edits (most File functions are ghosted out). 
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Create Point Control These are used to override the normal locations of one or more points and 

or components in a cross section.  Examples of this include lane widening, staying within the 

right-of-way, maintaining a particular slope for a ditch, and superelevation. 

An example would be a ramp is merging into the main road. The ramps left edge is vertically 

controlled by the main road right edge of pavement. The ramps left edge is horizontally controlled 

by the main road right edge from 0+00 to 1+00, and then it is controlled by a horizontal alignment 

named rampLeft. 

Station Limits (Start/Stop) - specifies the start and stop stations for the control. 

Control Description - allows you to enter a description of the control. 

Point - allows you to select the point to be controlled. Select from the list or identify the point 

in the cross-section using the locate button. The selected point is highlighted in plan/cross 

section and profile or superelevation views as applicable. 

Mode - allows you to select the control mode: Horizontal, Vertical, or Both. 

Control Type - specifies the type of control. 

If the Mode is Horizontal or Both, valid control types are Linear Geometry, Feature 

Definition, or Corridor Feature. 

If the Mode is Vertical, valid control types are Linear Geometry, Feature Definition, 

Corridor Feature, Superelevation, Elevation Difference, Elevation and Grade. 

The selection combo boxes and/or field displayed depends on the selected Mode and 

Control Type. 

Type - Linear Geometry If the type is Linear Geometry, a Horizontal Offsets combo box 

is displayed. If the mode is Both, a Vertical Offsets combo box is also displayed. 

Type - Feature Definition If the type is Feature Definition, a Feature Definition and 

Range text field is displayed. 
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Type - Corridor Point For all modes, Corridor and Reference Feature combo boxes are 

displayed. These options allow you to set up the control of one corridor’s points(s) from 

another corridor’s point(s). 

Targeting another corridor's point cannot be done simultaneously with Target Aliasing of 

that same corridor. If Target Aliasing has been defined, the Corridor Point is not available 

for selection within the Point Control dialog. This produces a recursive situation, making 

the corridor point control unavailable for selection until that Target Aliasing is removed. 

Type – Superelevation This option displays a Superelevation control line combo box, and 

a Reference Point combo box. Superelevation control lines are stored in the roadway 

design, not on the alignment. The reference point is the pivot point (feature) about which 

the point will rotate. 

Type - Elevation Difference This option displays Horizontal and Vertical alignment 

combo boxes. The vertical alignment represents a vertical difference value to be applied to 

the points’ current elevation. 

Type - Elevation and Grade This option displays an Elevation field, and a Grade field. 

The control sets elevation of the point at the start station to the elevation specified. The 

slope of the point’s line is then at the grade specified until the end station is reached. 

Priority - determines the order of controls on a point. This value applies only when there are 

conflicting controls on a point. Where there is a conflict, the control with the lower priority is 

applied (that is, lower numbers are applied first). 

Use as Secondary Alignment - specifies that horizontal point controls are also used as 

secondary alignments. This option is available only when working with a 2D entity. If you are 

using a 3D object, the software skips the secondary alignment option. 

Horizontal Offsets (Start/Stop) - specifies the start and stop horizontal offset controls for the 

corridor. If the values are different, then the value applied at a given station is calculated using 

a linear algorithm. 

Vertical Offsets (Start/Stop) - specifies the start and stop vertical offset controls for the 

corridor. 
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Create Key Station - The Create Key Station tool is useful to add stations that are not coincident 

with the template interval, when a special circumstance of the project occurs and it’s desirable to 

include the station in processing. 

Create Key Station Workflow 

1. Select the Create Key Station tool. 

2. Locate Corridor - Select the corridor for station addition. A display line dynamically 

running perpendicular to the baseline reference is visible. 

3. Station - Define the key station by dynamically moving the display to the desired 

location (and data point) or by keying in the station, <Enter> and data point to accept. 

The key station is added to the Key Station list, and the corridor is automatically 

reprocessed to include the new station. 

  

Create Secondary Alignment - Sets parameters for secondary alignments, which are used to 

modify the direction of cross section processing. Requirements include corridor selection, 

secondary alignment definition, beginning and ending station (in cases where only part of the 

alignment element is to be used) and beginning and ending offsets. 
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Create Parametric Constraints - Sets up constraint value overrides for specified station ranges. 

  

Create Curve Widening - Applies horizontal controls to points to move them farther from the 

centerline at each curve of the controlling alignment. 

  

Create End Condition Exception - Defines end condition exceptions, which are used to modify 

the behavior of an end condition solution without requiring the use of additional template drops. 
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Corridor Objects - One-stop viewing of data relating to corridor objects. Excellent for managing 

your corridor data, as it encompasses template drops, key stations, parametric constraints, point 

controls, various references and end condition exceptions all within one dialog. 

  

Process Corridor - Processes the corridor to ensure that it is up to date. 

5.4.3 Superelevation Tools 

This toolbox contains tools for creating, calculating, and editing superelevation lanes. Tools are 

also supported for importing excel (CSV) data and reporting. 

 

  

Create Superelevation Sections - Adds a superelevation sections (generally one per curve set) 

for the specified station range on the baseline reference. 
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Create Superelevation Lanes - Creates color-filled lanes based on width and offsets from the 

baseline reference, as a precursor to superelevation calculations. 

  

Calculate Superelevation - Calculates station and superelevation transitions rates based on a 

preferences or rules file (*.sep,*.srl).  The values are augmented to the superelevation lanes, edit 

manipulators are created, and the color fill is recolored based on the cross slopes. 

  

Import Superelevation - Optionally, imports data from a CSV file. 

  

Assign Superelevation to Corridor - Associates superelevation with a corridor, so the pavement 

reflects the superelevation stations / cross slopes, rather than the pavement cross slope defaults in 

the template. 
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Superelevation Editor - Opens the superelevation editor allowing the user to edit the calculated 

superelevation in a tabular format. 

  

Superelevation Report - Creates a superelevation XML report and opens the Bentley Civil 

Report Browser. 

 

5.4.4 Corridor Miscellaneous Tools 

 

  

Define Target Aliasing - Aliasing allows you to target other corridor surfaces or features or to set 

up a prioritized target list for end condition solutions on surfaces, features and alignments. This 

means that on a large job where the existing surface may have been broken up into more than one 

surface, you don’t need to be concerned about where those breaks occur, and you don’t need to 

create a different template for each existing surface. Use target aliasing to find the proper solution. 

In any situation where the active surface is the target, the software looks for the mainline corridor 

surface and uses whichever is closer because you have turned on that option. If the Use Closest 

option is not set, then it would search for the surfaces in the order they are displayed, and it would 

stop as soon as a solution was found. 

Target Aliasing cannot be defined with a corridor that targets that particular corridor with a 

Corridor Point Control. This produces a recursive situation, making the corridor unavailable for 

Target Aliasing until that corridor point control is removed. 
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Target lists end-condition targets for the current corridor. 

does not list feature definition targets. 

Surface or Corridor lists all the available aliases for the current target. If the target is a 

surface, it displays a list of alternate surfaces and corridors. If the 

target is a feature, then the list displays available surface features and 

corridor points. If the target is an alignment, it displays a list of 

available alignments. 

Aliases lists the aliases for the current target. The order of the list indicates 

the priority of the target aliases. 

Add, Remove, Move 

Up, Move Down 

activates as items are selected. The left and right buttons allow you to 

move items between lists. More than one item can be selected and 

moved. The up and down buttons allow you to change the priority of 

a single item in the alias list by moving up or down in the list. 

Use Closest Ignores the order of the aliases, when checked on. The solution seeks 

the closest alias that satisfies the solution (end condition). 

Define Target Aliasing Target Workflow 

1. Select the Define Target Aliasing tool. 

2. Select the corridor. This opens the Target Aliasing dialog. 

3. Use the Add, Remove, Move Up, Move Down, and Use Closest to set the Target 

Aliasing. 

Synchronize Template - Updates a template within a template drop with the template of the 

same name from the current template library. Any changes previously made to the template in the 

template drop are overwritten with no warning. 

 

  

Add Corridor Reference - The Add Corridor Reference tool adds graphical elements to the 

corridor processing. This must be done even if the feature is targeted in the template, otherwise 

the elements will not process. It enables only those elements associated with a particular corridor 

to be processed, rather than all elements of a particular feature definition. This speeds up 

processing, and eliminates processing of unwanted elements of the same feature definition. The 

elements can be selected within the tool, or a selection set can be created prior to commencing the 

tool. 
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Remove Corridor Reference - The Remove Corridor Reference tool removes graphical elements 

from the corridor processing, but does not delete the element. The elements can be selected within 

the tool, or a selection set can be created prior to commencing the tool. 

  

 

Add Clipping Reference - allows you to remove areas of overlap when working with multiple 

corridors in a single surface. For example, in a corridor intersected by a crossing roadway, 

clipping would be used to remove all overlapped features within the intersection. 

 

Add Clipping Reference Workflow 

1. Select the Add Clipping Reference tool. 

2. Select the corridor to be clipped. 

3. Locate Clipping Reference - select elements until all are defined, then reset to complete. 

The corridor is processed and the clipping reference is added. 

Remove Clipping Reference - Removes the clipping reference, reprocesses the corridor, 

restoring the clipping area to its previous state prior to clipping. 

Remove Clipping Reference Workflow 

1. Select the Add Clipping Reference tool. 

2. Select the Corridor where the clipping is to be removed. 

3. Locate Clipping Reference - select elements until all are defined, then reset to complete. 

The corridor is processed and the clipping reference is removed. 

 

Managing Corridor Data 
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Several tools can be used to help manage the corridor model data. Depending on the tool 

selected, the data may be read-only or may be manipulated. These include: 

• Properties 

• Corridor Objects - view and manage all the input objects in the corridor in one location 

• Project Explorer - see all corridor information in one place 

Properties 

Clicking on the corridor border opens the Element Information with most of the same 

information found in the Project Explorer Corridor. It includes the corridor tree, symbology, 

Corridor Info (Name, Alignment Name, Profile Name, and Design Stage). 

 

The dialog changes as the tree is navigated, based on the current highlighted item in the tree. 

Much of the information can be edited, which is automatically reflected in the corridor model. 

 

 

 

 

If a Template Drop is selected, the Element Information dialog reflects the template drop 

information, which can be edited. 
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Corridor Objects - Allows you to view and manage all the input objects in the corridor in 

one location. 

Explorer 

The Explorer is located in OpenRoads Modeling workflow > Corridors ribbon > Primary tool 

set.  the design progresses, the information is continually created / updated automatically.  

 

 

Each corridor (and associated data) is listed separately. As the tree is navigated, additional data is 

exposed. In addition, right-click context sensitive menus are available for common tasks and 

information. 
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Template Management 

SS4 Design Stage has been replaced with Feature Definiton. You can access the Design Features 

within the Properties from the headsup display tools. 

The Template Drop Interval Multiplier is used in conjunction with the Interval Drop specified 

when the template drop was created. Its purpose is to enable designers to use larger intervals for 

preliminary work and easily shorten the interval as the design is refined. To determine the 

interval used for processing, the Interval Drop is multiplied by the Template Drop Interval 

Multiplier and the result is used.  

MoDOT uses the following Design Stages: 

Stage Multiplier  Description 

Preliminary x 10 10  Used for general design work, until high level of accuracy 

is required towards the end of the project. Faster 

processing time on larger Corridors. 

Final x 1 1  Used for cross section sheets with 25, 50 or100 feet 

between sections. Best and more accurate Design stage for 

final cross sections 

Final x 1 w/Meshes 1  Used for creating Mesh surface 

Final x 1 Top Mesh 1  Used for creating Top Mesh surface 

Final x 1 Bottom Mesh 1  Used for creating Bottom Mesh surface 

Final x 1 Linear Features 1  Used for creating surfaces 

Final x 1 Components Only 1   
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Processing & Critical Sections 

This information is also located in the Properties tool when the Corridor Design Stage is selected 

from the OpenRoads Standards of Explorer. 
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Option Description 

Template Drop Interval Multiplier The Interval multiplier times the template drop interval 
is the distance between template drops depending on the 
chosen stage. 

Horizontal Cardinal Points When set to True, the location of cardinal points of the 
active horizontal alignment (PC, PT, CS, etc.) are used 
to compute a point or template drop interval location. 

Vertical Cardinal Points When set to True, the location of cardinal points 
of the active vertical alignment (VPC, VPT, VPI, etc.) 
are used to compute a point or template drop interval 
location. 

External Control Points When set to True, the location of horizontal and/or 
vertical point controls are used compute a point or 

template drop interval location. 

Densify Horizontal Curves When set to true, the processing along horizontal curves 
is at a closer interval. This option utilizes the 
CIVIL_DEFAULT_CURVE_STROKING configuration 
variable value, with extra points being computed based 

on the chord offset from the horizontal curve. The value 
defines the chord height used to calculate the extra 
points. If configuration variable is not set or Densify 
Horizontal Curves is set to False, the value defaults to 
0.01. 
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Display Settings 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

Option Description 

Corridor - Element Template Element template utilized to draw the corridor 
boundary in the Create Corridor tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 
on as needed. 

Corridor Handle Length Factor 

Template Drop Handle Length 

Factor Single Station Handle 

Length Factor 

Transition Handle Length Factor 

The Length Factors are a ratio of the handle length to 
the width of the corridor.  So 1.0 would make the 
handle as long as the width of the corridor at that point. 

Corridor Handle Spacing The handle spacing either is set to a physical distance as 

shown or set to zero. If you set to zero you will get 11 
handles per corridor regardless of its length.  Any non-
zero value is used as a distance between handles 
measured in master units along the horizontal 

alignment. 

Template Drop Element Template Element template utilized to draw the template drop 

boundary in the Create Template Drop tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 
on as needed. 

Transition Element Template Element template utilized to draw the transition 

boundary in the Create Transition tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 
on as needed. 
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Output Settings 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

For all options, when set to False, no elements, features, or meshes are drawn. 

Option Description 

Create Top Mesh 

Top Mesh Feature Definition 

When set to True, a mesh is created for each component in the 
corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled OFF.  The mesh is drawn using the specified 
Feature Definition. 

 

 

If Create Top Mesh is set to False, no Top Mesh Feature Definition 
can be selected. 

Create Bottom Mesh 

Bottom Mesh Feature Definition 

When set to True, a mesh is created for each component in the 
corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled OFF.  The mesh is drawn using the specified 

Feature Definition.  If Create Bottom Mesh is set to False, no Bottom 
Mesh Feature Definition can be selected. 
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Create Linear Features 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When set to True, 3D linear features are drawn based on Feature 
Definitions.  First, review the Point Properties within the template: 

 

 

Then review the corresponding Feature Definition. 

 

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 

 

 
 

 

 

Then review the corresponding Feature Definition. 

 

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 
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Create Linear Features Continued  

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 

 

 

Create Component Meshes When set to True, a mesh is created for each component in the 

corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled On.  The mesh is drawn using the specified 
Feature Definition in the Component Properties. 

 

 

Include Null Point Linear Features When set to True, linear features for null points are drawn, basis on the 
same criteria as Create Linear Features. 
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5.5 Group Exercise: Creating a Corridor – Ramp 4 

1. Within the J5P3181\data-5 folder, open the file: Civil_Geometry_J5P3181.dgn 

2. Create a new file named Corridors_Ramp-4_J5P3181.dgn using the  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

This new file will hold the proposed corridor for Ramp 4 

3. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow ➔ 

Utilities Tab ➔ Geographic Section. 

4. Select “From File” icon. 

 

5. Select the Terrain_J5P3181.dgn file in the data-5 folder. 

6. Verify the settings.  

 

 

7. Reference in the following files: 

Terrain_J5P3181.dgn 

Civil_Geometry_J5P3181.dgn. 

 

8. Set the Annotation Scale to 1”=50’ 
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9. Select the Terrain Model and select the Set As Active Terrain Model icon form the pop 

up menu. 

 

Setting Project Template Active  

From Corridors tab of the OpenRoads Modeling Workflow, select Create Template.   

   

 

10. To set the J5P3181.itl as the Active Template Library select File > Open from the 

Create Template dialog menu.   

Roadway ➔ data-5 ➔ J5P3181.itl 

11. Close the J5P3181.itl Template Library. 

 

Setting up the Corridor 

12. From Corridors tab of the OpenRoads Modeling Workflow, select New Corridor.  

 

Create Corridor command is also available from the context sensitive pop-up menu 

presented when hovering over a selected horizontal civil geometry element.  
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13. When prompted to Locate Corridor Baseline, data point on Ramp 4. 

a. Right-click to reset to select the active profile. 

b. Name the Corridor Ramp 4. 

c. Data point to accept. 

d. Select <Alt> + Down to pick a template or use the Create Template Drop dialog 

box. 

e. Expand the project folder J5P3181 and Ramp 4 folders.  Select the Ramp 4 

Pavement with Curb and Gutter template.  Click OK to dismiss the dialog and 

data point in the view to accept the choice of template. 

f. When prompted to enter the Start Station, select the <Alt> key to lock the Start 

Station to the start and data point in the view to accept it. 

g. When prompted to enter the End Station, key in 2+50 and Enter to lock the value. 

Data point in the view to accept the end station. 

h. When prompted for the Interval, key in 5 and Enter to lock the value and data point 

to accept the value. 

14. Select <Alt> + Down to pick another template or use the Create Template Drop dialog 

box. 

a. Expand the folder J5P3181 and the Ramp 4 folder and select Ramp 4 Pavement 

with Shoulders template. Click OK to dismiss the dialog and data point in the view 

to accept the choice of template. 

b. When prompted to enter the Start Station, key in 2+50 and Enter to lock the value.  

Data point in the view to accept the start station. 

c. When prompted to enter the End Station, key in 5+00 and Enter to lock the End 

Station and data point to accept it. 

d. When prompted for the Interval, key in 5 and Enter to lock the value and data point 

to accept the value. 

15. Select <F4> to close the Create Template Drop tool down. 

16. Press <F6> key to setup the 3D view.  

Note: If you don’t see end conditions then the original ground terrain model was not 

active. 

17. The Cut Wall Ditch Backslope is set to 4:1.  For this project we want the Ditch End 

Slopes to be 1:1 (100%) so edit the two template drops (Ramp 4 Pavement with 

Shoulders and Ramp 4 Pavement with Curb and Gutter) in the Template Library to 

adjust the Left Cut Wall Ditch Slopes. 
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18. To edit the template drop, open the template library by selecting the OpenRoads 

Modeling Workflow ➔ Corridors Tab ➔ Create Section➔Create Template 

Verify the Roadway/Data-5/J5P3181.itl is the active template library. 
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19. Double click on the LT_Ditch_Bkslp_1_T point. 
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20. After changes have been made syncronized the Template Library with the two Ramp 4 

Templates in the Corridors_J5P3181.dgn file.  To do this select the heads up 

promps/tools by selecting both Template Drops grips and then Syncronize with 

Library. 

 

Review the Model and the effect of adjusting the Corridor Feature Definition 

21. Select the corridor by picking one of the handles. 

22. Select the Corridor Component Quantities option from the Corridor Reports pop-up. 

 

23. Key in some unit cost values. 

24. Select Report. 

25. Review the reports available.  Close the Report Browser. 

26. Display the pop-up menu again and select Properties. 

 

27. Select and explore the options for Feature definition. 
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28. In View 2, the Default-3D window use the View Rotation tool to rotate the view to see 

3D effects on the Ramp 4 corridor. 

  

Note: Left click and drag the cross hair to a snap location on the surface to gain a rotation point 

about. Then left click and hold in the window while moving the mouse to rotate effectively. 
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Open Cross Section Model 

29. From Corridor ribbon, select pull down Dynamic Sections, Select Open Cross Section 

View.  

 

 

 

 

 

 

Open Cross Section View command is also available from the context sensitive pop-up 

menu presented when hovering over a corridor handle.  

 

30. When prompted to Locate Corridor or Alignment, identify the corridor by selecting a 

grab handle on the corridor. 

31. When prompted to Select or open View, open window 8 and data point in the view.  

This will present the first Cross Section of the corridor.  To Navigate up and down the 

corridor use the arrow indicators at the top of the view.  To navigate within in the view, 

use the mouse wheel; rolling the wheel forward zooms in, rolling back zooms out.  

Depressing the wheel and moving the mouse pans the view. 

 

NOTE: Since superelevation will be changing the slopes, having feedback to the slope at each 

station is useful, the next steps describe how to place a dimension line from the edge of pavement 

to the center line on each side of the road. 
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Place Temporary Dimensions 

32. Right click and hold for 1 second in the Cross Section Model. This will bring up a menu 

with Temporary Dimension options. 

 

33. Select Place Horizontal Temporary Dimension.   

34. At the Start Point prompt, identify the center of the roadway, data point to accept. 

35. At the End Point prompt, identify the right EOP point, data point to accept. 
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36. Place the dimension height above or below the component in a location that will be easy 

to read, data point to accept the location.  

 

 

 

 

 

 

 

 

 

 

 

 

Note:  This places the same dimension on all cross sections. 

Note:  The blue line on the alignment represents the location of the cross-section. 

 

 

 

 

 

 

 

 

 

 

37. Save Settings on the design file.  The corridor is stored as MicroStation data; no .ird file 

is created. 

38. Select File > Update Server Copy.  
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5.6 Individual Exercise: Creating a Corridor for Route 54 

1. Create a new file named Corridors_ Route-54_J5P3181.dgn using the  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

This new file will hold the proposed corridor for Route 54. 

2. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow ➔ 

Utilities Tab ➔ Geographic Section. 

3. Select “From File” icon. 

 

4. Select the Terrain_J5P3181.dgn file in the data-5 folder. 

5. Verify the settings.  

 

6. Reference in the following files: 

Terrain_J5P3181.dgn 

Civil_Geometry_J5P3181.dgn. 

Corridors_Ramp-4_J5P3181.dgn. 

7. Set the Annotation Scale to 1”=50’ 

 

 

8. Select the Terrain Model and select the Set As Active Terrain Model icon form the pop 

up menu. 
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9. From Corridors tab of the OpenRoads Modeling Workflow, select Create Template.   

10. Select file open and navigate to the the project diretory and open the project template 

library: J5P3181.itl. 

11. In Create Template dialog right-click on the J5P3181, select New > Folder and create a 

folder called Route 54. 

 

12. Select the Templates ➔ Concrete Pavement w/ Shoulders ➔ A2 Shoulders Agg Base 

folder. 

13. Right click on the Concrete Pavement 4 Lane Divided w/ Agg Base Option 3 template 

and select Copy. 

 

14. Right click on the Route 54 folder and select Paste. 
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15. Rename the template adding Route 54 to the beginning of the name. 

 

16. Test the template by clicking Test. 

17. Save your changes to the J5P3181.itl and then close the Create Template dialog. 

18. From Corridors tab of the OpenRoads Modeling Workflow, select New Corridor.  

19. When prompted to Locate Corridor Baseline, data point on Route 54. 

20. Right-click to reset to select the Active Profile. 

21. Name the corridor Route 54. 

 

22. Data point to accept. 

23. Select <Alt> + Down to pick a template or use the Create Template Drop dialog box. 

24. Expand the folder J5P3181 and the Route 54 folder. 

25. Select the Route 54 Concrete Pavement 4 Lane w/ Agg Base Option 3 template.  Click 

OK to dismiss the dialog   

26. Data point in the view to accept the choice of template 

27. When prompted to enter the Start Station, select the Alt key to lock to the beginning 

station, and Data point in the view to accept. 

28. When prompted to enter the End Station, select the <Alt> key to lock the End Station to 

the end and data point in the view to accept it. 

29. When prompted for the Interval, key in 25 and Tab to lock the value. 
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30. Left Click to Accept the placement of the Template Drop. 

31. Select <F4> to close the Create Template Drop tool. 

32. Select the Corridor and from the Properties pop-up menu, select and explore different 

design stages. 

33. If the 3D View is not open select <F6> key to open a 3D view of the corridors. 

34. In the View 2, Default-3D window use the View Rotation tool to rotate the view to see 

3D effects on the Route 54 corridor. 

Set up Dynamic Cross sections 

35. From context sensitive pop-up menu presented when hovering over a corridor handle, 

select the pull-down next to the Dynamic Sections icon, then select Open Cross Section 

View.  

a. When prompted to Locate Corridor or Alignment, identify the Route 54 corridor by 

selecting a grab handle on the corridor. 

b. When prompted to Select or Open View, select a view not in use, (View 8) and data 

point in the view.  This will present the first Cross Section of the corridor.  To 

navigate up and down the corridor, use the arrow indicators at the top of the view.   

Since superelevation will be changing the slopes, having feedback to the slope at each station is 

useful, the next steps describe how to place a dimension line from the edge of pavement to the 

center line on each side of the road. 

36. Right click and hold for 1 second in the Cross Section Model. This will bring up a 

menu with Temporary Dimension options. 

37. Select the Cross Section view. 

38. Select Place Horizontal Temporary Dimension.   

39. At the Start Point prompt, identify the center of the roadway, data point to accept. 

40. At the End Point prompt, identify the right EOP point, data point to accept. 

41. Place the dimension height above or below the component in a location that will be easy 

to read, data point to accept the location.   

42. Do this for both the North bound and the South bound lanes of Route 54. 

43. Close View 8. 

44. Select File > Update Server Copy.  
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5.7 Group Exercise: Horizontal Feature Control 

In this Exercise we are going to add a plan graphic and have the corridor draw to that 

graphic.  This process is called adding a Horizontal Feature Constraint. 

 

1. Create a new file named Plan_J5P3181.dgn using the . 

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

2. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow ➔ 

Utilities Tab ➔ Geographic Section. 

3. Select “From File” icon. 

 

4. Select the Terrain_J5P3181.dgn file in the data-5 folder. 
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5. Verify the settings.  

 

6. Reference in the following files: 

Civil_Geometry_J5P3181.dgn 

Terrain_J5P3181.dgn 

 

7. Set the Annotation Scale to 1”=50’ 

 

 

8. Using the Feature Definition Toggle Bar set the Feature Definition to EOP_New (Edge 

of Pavement New).  Also toggle on Use Active Feature Definition. 

 

 
 

EOP_New is located following place: Linear ➔ Design ➔ Roadway 

9. Open the Single Offset Partial tool by selecting the OpenRoads Modeling Workflow 

➔ Geometry Tab ➔ Horizontal Section. 
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10. Within the Single Offset Partial tool use the following parameters: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Open the file: Corridors_ Route-54_J5P3181.dgn 

 

12. Reference in the Plan_J5P3181.dgn into the default 2D view. 

 

13. Sometimes it is helpful to turn off the 3D Corridor View to make the 2D Corridor View 

less cluttered.  Within the active 2D View open the Reference Dialog and turn off the 

Display of the 3D Corridors_ Route-54_J5P3181.dgn file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Locate Element: Route 54 Alignment 

Offset:   66.00 ft 

Start:   Start of Route 54 Alignment 

Stop:   Beginning of Ramp 2 Alignment 
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14. Edit the Route 54 Template Drop and open the Point Properties Dialog for the 

RT_Conc_T_EOP1 point.  Set the Horizontal Feature Constraint to seek the 

following Feature Definition: 

Linear/Design/Roadway/EOP_New 

 

 
 

15. Add the newly place EOP_New line as a Corridor Reference to the Route 54 Corridor 
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5.8 Group Exercise: Adding Right of Way to Route 54  

Create a New Land Boundary Design File: 

1. Within the Roadway\data-5 folder, open the file: Corridors_Route-54_J5P3181.dgn 

2. Create a new file named Land_Boundary_J5P3181.dgn using the  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

3. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow ➔ 

Utilities Tab ➔ Geographic Section. 

4. Select “From File” icon. 

 

5. Select the Terrain_J5P3181.dgn file in the data-5 folder. 

6. Verify the settings.  

 

7. Reference in the following file: 

a. Civil_Geometry_J5P3181.dgn  

b. Terrain_J5P3181.dgn 

8. Change the Annotation Scale to 1”=50’ 

9. Activate the Terrain Model J5P3181. 
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Creating the 3 individual Right of Way Lines as Complex Elements: 

 

Use Civil AccuDraw with a zero Curve Radius and zero Spiral Transition Length along with 

the Route 54 alignment to place line accurately along the Route 54 Alignment using the 

Station-Offset mode 

 

10. In the Feature Definition Toggle Bar set the Feature Definition to 

RW_Controlled_Access_Proposed.  Also toggle on Use Active Feature Definition. 

11. Using the OpenRoads Modeling Workflow select the Geometry tab 

12. Open the Complex By PI tool from the pull down 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. Open the Civil AccuDraw tool and set the mode to Station/Offset 
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14. Use the Horizontal Geometry Tool Complex By PI to place a line with a Feature 

Definition of Linear ➔Design➔ Right of Way ➔ RW_Controlled_Access_Proposed 

at the following locations: 

 
 

Left Side 

 

 

 

 

 

 

 

 

Right Side 

 

 

 

 

 

 

 

Station  

(2 entries) Right Offset 

602+60 R1 305 

607+00 R1 305 

Station  

(6 entries) Left Offset 

602+60 R1 -300 

613+44 R2 -374 

614+78 R2 -604 

620+13 R2 -574 

622+18 R2 -200 

635+00 R2 -200 

Station  

(8 entries) Right Offset 

609+24 R2 175 

615+00 R2 175 

616+31 R2 315 

618+20 R2 328 

623+49 R2 198 

627+00 R2 260 

630+00 R2 200 

635+00 R2 200 
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15. If not already done, select the Terrain Model J5P3181 and set it Active. 

16. Open the Profile View of each just placed RW_Controlled_Access_Proposed element. 

17. Set the existing ground as the Active Profile. 

 

Note: by setting active the Right of Way line profile, future cross section will now show a 

label of the locations of said Right of Way line in the Dynamic Cross-Section window 

and Named Boundary created cross section sheets and models. 

 

18. Select File > Update Server Copy. 

 

Updating the Corridors file: 

19. Within the Roadway\data-5 folder, open the file: Corridors_Route-54_J5P3181.dgn 

20. Reference in the newly created Land_Boundary_J5P3181.dgn into the 2d View 

21. Verify the dynamic cross-section view shows the R/W lines 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

End of Exercise 
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6.1 Objectives 

• Create a superelevation section and lane 

• Calculate superelevation using an XML file, or import data from CSV file 

• Review / edit the data utilizing the table editor and SE Model 

• Assign the superelevation information to a corridor 

6.2 Overview 

Superelevation tools calculate how much banking to apply to curves and spirals in the 

horizontal alignment to help offset centrifugal force. These commands also compute how 

the road will make the transition from normal crown to a fully banked curve and back again. 

Superelevation can be calculated in two ways: 

Rules-based – using a set of preferences (XML file) the station and associated cross slopes 

of the transitions are based on design speed, curvature, and other design parameters. As the 

design progresses and parameters change (i.e., design speed exceptions) superelevation can 

be reprocessed to the revised parameter(s). 

Import – using a comma separate values (CSV) file to import the station and associated 

cross slope of each transition. In this option, the rules are not utilized; the data is simply 

applied to the superelevation lanes. 

The result of superelevation is a DGN file of graphic superelevation lanes with cross slope 

attributes. This file can be referenced to a corridor model and associated, so the 

superelevation transitions are incorporated into the corridor model. The superelevation data 

can be in its own DGN file, or can be drawn into any of the other project DGN files with 

geometry, corridor, etc. 

6.3 Prerequisites 

In order to create superelevation, the following are minimum requirements: 

• One Civil horizontal geometry element 

• Superelevation preferences (an XML file)  

In order to add the superelevation data to a corridor, you will need: 

• Superelevation lanes 

• Corridor whose template has superelevation flags for 

control points (for association step) 

Superelevation data is drawn using a Feature Definition for 

Superelevation. Therefore, turning off the levels with 

superelevation data removes it from the active view. 
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6.4 Settings 

The following two sets of settings are utilized within the superelevation tools. It is prudent to 

set them prior to drawing lanes. There are no required values; these are user preference. 

• fill settings for superelevation lanes 

• decimal place settings for element handlers 

6.5 Fill Settings 

Located under File> Settings> User from the main Backstage menu, the View Options - 

Civil listing provides options for the superelevation fill. 
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Option  Description 

  Color Shaded 

Fill 
Color Shaded Fill Color fills superelevation lanes AFTER calculations are 

complete. The coloring is hard-coded based on the cross slope: 

 

slope < -10% =blue 

 

-10% <= slope <= -0.5% = Calculated color between green and blue 

 

-0.5% < slope < 0.5% = white 

 

0.5% <= slope <= 10% = Calculated color between red and yellow slope > 10% 

= dark red 

Based on the side of road, the colors flip. In addition to setting this option, the 

View Attribute for Fill must also be toggled on. Boundaries 

Only 

In this option, only the outside boundary of each lane is displayed and can be 

selected. 

None No superelevation lanes / edit handlers are displayed; however, they are still in 

the file. To display them, set to one of the other two options. 
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6.6 Stationing and Decimal Place Settings 

Located under File> Settings> File> Design File Settings from the main Backstage menu, 

the Civil Formatting category listing has options for controlling display of element handlers. 

These settings are not unique to superelevation; the same settings are used throughout the 

Civil products. 

 

Option Description 

Station 

Settings: 

Used for section and lane edit handlers. 

Format Controls the number of places after the delimiter. 

Format 

Delimiter 

Controls the delimiter, generally the plus (+) sign. 

Precision Defines the number of decimal places for stationing. 

Profile 

Settings: 

Used for lane edit handlers. 

Slope Format Used for cross slope edit handlers. Generally, set to percentage for 

superelevation. Slope Precision Defines number of decimal places in cross slope edit handlers. 

Superelevation General Workflow 

The general workflow for superelevation is described in the following steps. Steps 4-6 

can be done in a different order and not all steps are required. 

1. Create the super section(s). 

2. Define the lanes with Create Superelevation Lanes (by Road Template or 

manual). 

3. Calculate superelevation transitions and cross slopes. 

4. Review and edit as needed. 

5. Add auxiliary lanes. 

6. Associate to a corridor. 

6.7  Create the Super Section(s) 

In this first step, the Civil horizontal geometry element is identified, and station limits of the 

superelevation are defined. Station limits are useful if the horizontal geometry element is 

substantially longer than the project limits. 

In a basic project where the through lane pavement configuration is consistent (i.e., all 2 lane 

rural with a few turn lanes), a single section may be used. However, if there are significant 

changes to the road, i.e., changing from 2 lane rural to 4 lane divided, separate sections 

should be created. 

The general rule is to create a new section if you are using rule-based calculations and the 

through lane configuration or pivot method changes. The changes should be based on the 

through lanes, as auxiliary lanes such as turn lanes, ramp entrances and exits and truck 

climbing lanes are handled independently. If you are importing superelevation, one section 

can be used for an entire alignment. 

  



OpenRoads Designer Road 1 Chapter 6 – Superelevation  
 

4/18/23 Missouri Department of Transportation 6-5 

6.7.1 Create Superelevation Lanes 

Once the section is defined, define the lanes. Focus on the through lanes, as the turn lanes and 

intermittent lanes can be added at any time. Lanes are defined by selection of the horizontal 

geometry and offsets. Default cross slope, used for subsequent calculations, is also defined. 

The result of this step is that graphic lanes (filled with green and yellow, no choice of colors) 

are drawn. 

6.7.2 Create Superelevation Lanes by Road Template 

OpenRoads Designer allows for the ability to select the template that has been used on your 

project to define the superelevation lanes.  Users would want to make sure their templates 

used in the DGN match the current ITL template.  The program will utilize the points with 

the superelevation flag option and determine lane widths automatically.  

 

6.7.3 Calculate Superelevation Transitions and Cross Slopes 

In this step, there are two options: rule-based and imported data. Generally, one method 

would be selected, however, you can use rule-based for part of the project and import other 

parts (although this would be confusing). 

The rules-based tool uses a preferences file (XML file) to compute the station and cross 

slopes of transitions, while the import superelevation method uses a comma separate values 

(CSV) file containing the station and cross slopes, which were calculated by an exterior 

program (or manually). The inputs vary depending on the method used and the preferences 

within the XML file. 

The result of this step is the augmentation of station/cross slopes of transitions to the lanes 

created in the previous step. It is easy to see the results if the fill is toggled on as the lanes 

change from solid yellow and green to a gradient coloring, based on cross slopes. 

6.7.4 Review and Edit as Needed 

There are several ways to review the superelevation data and edit if desired. Highlighting a 

section displays station and cross slope values for review and editing. Stationing can be 

changed dynamically by selecting the gray wedge and dragging to the desired station. Each 

lane can be manipulated independently of the adjacent lanes. The station can all be keyed 

into the edit field. Slopes can be changed by keying the slope into the edit field. 

The superelevation editor is another way to edit the data, in a tabular format. Any changes 

made in the editor are automatically synced with the graphic lanes and vice versa. The fields 

in the editor can be customized so unused or unwanted fields can be hidden. Any data in gray 

cannot be edited, due to constraints used during calculations with the XML method. 
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OpenRoads Designer also has the option to edit the Superelevation graphics through a 

Model.  

The Open Superelevation View  will take the graphics displayed in the Edit Table 

dialog and open it up in a MicroStation Model for editing. 

6.7.5 Add Auxiliary Lanes 

At any time during the process, additional lanes can be added in any section. Primary lanes 

(those lanes that are rule based) or auxiliary lanes (those with user-specified cross slopes) 

can be added. The result of this step is graphic superelevated primary or auxiliary lanes. 

6.7.6 Associate to a Corridor 

At any time during the process, the superelevated lanes can be associated with a corridor. If 

the superelevated lanes are in a different file than the corridor, you must be in the corridor 

file with the super lanes attached as a reference. They can both be in the same file. 

The result of this step is the superelevated pavement is reflected in the corridor model. 
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6.8 Accessing Superelevation Tools 

 Create Superelevation Sections  

 

In this tool the Civil horizontal geometry element is identified and station limits of the 

superelevation are defined. Station limits are useful if the horizontal geometry element is 

substantially longer than the project limits. 

Determination of Sections 

If you are importing superelevation, one section can be used for an entire alignment. The 

advantage of curve sets for each curve versus one large section is the ability to reprocess 

rules for a single curve set or two. Since rules are not used in an imported project, separate 

curve sets serve no useful purpose aside from shorter, piecemeal reports and more 

granularities in the editor. 

In a basic rules-based project where the through lane pavement configuration is consistent 

(i.e., all 2 lane rural with a few turn lanes), a single section may be used. However, if 

there are significant changes to the road, i.e., changing from 2 lane rural to 4 lane divided, 

separate sections should be created. 

The general rule is to create a new section if you are using rule-based calculations and the 

through lane configuration or pivot/rotation method changes. The changes should be 

based on the through lanes, as auxiliary lanes such as turn lanes, ramp entrances and exits 

and truck climbing lanes are handled independently. However, the auxiliary lanes must be 

drawn within a single section. 

Workflow 

1. Select Create Superelevation Section. 

2. Set the Feature Definition to Superelevation 

3. Follow the heads-up prompts. 

Prompt User Action 

Name Name each section, suggestions include alignment name which can be appended -1, 2, etc. for projects 

with multiple sections. 

Locate Reference 

Element 

Select the Civil horizontal element to be used as a basis for superelevation lanes and calculations. 

 

Start Station Graphically define (based on the dashed line perpendicular to the reference element) the beginning of 

the section. The station can also be keyed in and locked  
End Station Graphically define (based on the dashed line perpendicular to the reference element) the ending of the 

section. The station can also be keyed in and locked  
Minimum 

Tangent 

Length 

Enter a value (in master units). If the tangent distance between two adjacent curves is less the specified 

value, the two curves and adjacent tangent are drawn into one curve set. If the tangent distance between 

two adjacent curves is greater the specified value, each curve and half of the adjacent tangent are 

drawn into each curve set. At the completion of this prompt, the sections are drawn and the software 

automatically advances to the Create Superelevation Lanes tool  
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Minimum Tangent Length 

This variable defines the minimum tangent between curves and is the determining factor 

on how curve sets are defined. When using rule-based calculations, there are times when 

you need to reprocess part of the superelevation calculations, perhaps due to a horizontal 

geometry change or design speed revision. If your project is one big section, then 

reprocessing is performed on the entire section, and overwrites any manual editing. For 

flexibility, curve sets enable the processing of one curve or multiple curves, while leaving 

manually manipulated sets intact. In the following example, the distance between curves is 

234.57 master units. 

 

 

The following results illustrate the impact of the Minimum Tangent Length. 

 

 

This line separates the 
two superelevation 
sections. 
Example: first section 
may have a speed 
limit of 30 mph and 
the second section 
may have a speed 
limit of 25 mph. Using 
the Minimum Tangent 
Length will allow for 
separate 
superelevation 
sections to 
accomplish the task. 
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Create Superelevation Lanes  

 

At any time during the process, additional lanes can be added in any section. Primary lanes (those 

lanes that are rule based) or auxiliary lanes (those with user-specified cross slopes) can be added. 

The result of this step is graphic superelevated primary or auxiliary lanes. 

 

Workflow for Through Lanes 

1. Select the Create Superelevation Lanes tool. 

2. Follow the heads-up prompts. 

 
Prompt User Action 

Locate First Superelevation 

Section 

Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines 
a square wherein the entire section must be encompassed in order to be 
included. 

Locate Next Superelevation 
Section or Reset to 
Complete 

Continue selecting sections until all are highlighted, then reset to move to 
the next prompt. 

Enter Lane Name Name each lane, suggestions include RT or LT which can be appended -

1, 2, etc. for projects with multiple lanes. 

Select Side of Centerline Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines 
a square wherein the entire section must be encompassed in order to be 
included. 

Inside Edge Offset Enter the offset (in master units) from the baseline reference. If the lane 
edge is the baseline reference, enter 0. 

Width Enter the width of the lane (in master units). 

Normal Cross Slope Enter the default cross slope to be used for calculations (in percent format). It 

not necessary to add the percent sign. 

Name The prompts are looping again, so you can define multiple lines with a single 

selection of the tool. You may need to move the cursor slightly for the 

prompt to appear. When you have no additional lanes to define, reset to exit 

the tool. 
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Create Superelevation Lanes by Road Template    
 

In lieu of manual entry of primary lane widths, a template representing the roadway may be 

selected. This is an alternate way to create superelevation lanes by using the widths and cross 

slopes of a specified template along with parameters specified in the Superelevation Rules File. 

Instead of having to enter the lane widths and slopes, they can be garnered from a road template 

if that template has superelevation points flagged.  The resulting superelevation lanes are drawn 

as graphics in a DGN file.  

 

Adding Lanes 

At any time during the process, additional lanes can be added in any section. Primary lanes 

(those lanes that are rule based) or auxiliary lanes (those with user-specified cross slopes) can 

be added using the Create Superelevation tool, but within a single section. When a single 

section is selected, the prompts change to reflect adding an individual lane. The result of this 

step is graphic superelevated primary or auxiliary lane. The lane needs to be associated to the 

corridor, similar to the through lanes. 

Workflow for Individual Lane 

1. Select the Create Superelevation Lanes tool. 

2. Follow the heads-up prompts: 

 

 

 

Prompt User Action 

Locate First Superelevation 

Section 

Select the first section. 

Locate Next Superelevation 

Section or Reset to Complete 

Reset to move to the next prompt. 

Type Options include: Primary (calculations based on rules) 

or Auxiliary (based on user- defined). After the 

selection, the dialog/heads-up prompts change to reflect 

the selection. 

Application Type (Aux. lane 

only) 

How to define cross-slope: 

None - no cross slopes are assigned. 

Constant - Fixed slope of specified value. If lane is 

transition, use this option, and then modify one end in 

the editor or graphically after creation. 

Follow Adjacent - Projects cross slopes from adjacent 

lane to this lane. 

Select Side of Centerline Right or left 

Inside Edge Offset Enter the offset (in master units) from the baseline 

reference. If the lane edge is the baseline reference, 

enter 0. 
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Width Enter the width of the lane (in master units). If the lane 

is of varying widths, you can use the widest width, or 

narrower than the width. In both cases, the template can 

control the width by parametric constraints or graphical 

features. 

Start Station Graphically define (based on the dashed line 

perpendicular to the reference element) the beginning 

of the lane. Station can be keyed in and locked. 

End Station Graphically define (based on the dashed line 

perpendicular to the reference element) the end of the 

lane. Station can be keyed in and locked. 

Normal Cross Slope Enter the default cross slope to be used for calculations 

(in percent format). It is not necessary to add the 

percent sign. 



Chapter 6 – Superelevation    OpenRoads Designer Road 1  
 

6-12 Missouri Department of Transportation 4/18/23 

Calculate Superelevation   

 

The rules-based tool uses a preferences file (XML) to compute the station and cross slopes of 

transitions. 

Workflow 

1. Select Calculate Superelevation. 

2. Follow the heads-up prompts for XML file. 

Prompt User Action 
Locate First Superelevation 

Section 
Select the first section. In lieu of selecting each section individually, drag 

your cursor diagonally across all desired sections. Your diagonal defines a 

square wherein the entire section must be encompassed in order to be 

included. 

Locate Next Superelevation 

Section; or Reset to 

Complete 

Continue selecting sections until all are highlighted, then reset to move to 

the next prompt. 

Standards File Name Select the XML containing the superelevation standards/parameters. Use 

<ALT> <DOWN> to open the File Manager to select directory/file. Data 

prompt to accept and move to the next prompt. 

Note: The prompts below and their options may vary based on the options within the XML file. 

e Selection 

L Selection 
The available e and length Selection fields are filled in according to the 

XML file.  

Those combo boxes determine which table within the .XML file will be 

used for computation. 

Design Speed Design Speed is to be used either in the tables or equations for e and length 

computations. 

Pivot Method Valid values here are: Crown, Inside Edge, Outside Edge, Left Edge, 

Right Edge, Divided Inside, and Centerline. If Divided Inside is used on 

an undivided roadway, if will be the same as using Crown. If an invalid 

value is entered, Crown will be the default. Centerline always uses the 

base alignment radius to calculate eRate. All other methods use the radius 

+/- the offset of the pivot to calculate eRate. 

Open Editor When calculations are complete and lanes updated, the superelevation 

editor is opened and populated with the new calculated lanes. 
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Edit Superelevation Rule File  
 

The superelevation calculator uses an XML-formatted rules file to calculate various aspects of 

superelevation. This file is used to calculate Max E rate for each curve of an alignment and the 

transition lengths needed to rotate the road bed from normal crown cross slopes to full 

superelevation cross slope (Max E). 

 

MoDOT will not typically edit the XML file for calculating superelevation. 

 

 

Import Superelevation 

In lieu of using rule-based superelevation transitions, the data may be imported from a CSV file, 

where calculations are done outside of the Civil products and just the results are imported. In this 

case, rules do not apply, so no XML is needed or specified. 

Entire projects can be imported, in which case, only one superelevation section is needed. 

However, you can also import just a turn lane or two, or part of your project. Keep in mind the 

superelevation section and lanes must be created prior to importing, and lane names associated 

with the graphics must match the names in the import file. 

The Windows delimiter value is used, which is generally set to comma; however, if you are 

experiencing difficulties, you may want to verify this on your workstation or laptop. 

If a file is imported twice, duplicate lanes are not created; rather the values of the import file 

overwrite any values (including manual edits) of lanes. 

The file format of the comma separated values file is: 

Data Description 

Superelevation 

Lane 

Links the data to an existing superelevation lane. 

Station Units should match design file. 

Station equations supported based on the sections reference 

alignment. 

Cross Slope Formatted as a double value : ±0.0 (i.e. -2% == -0.02) 

Pivot About Enumerated list: {LS,RS} LS = left side 

RS = right side 
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The following details the optional information: 

  

Data Description 

Point Type Enumerated list: 

{NC,NCIN,NCOUT,LC,LCIN,LCOUT,RC,RCIN,RCOUT,FS,FSIN,FSO

UT,U} 

 

NC = Normal Crown, LC = Level Crown, RC = Reverse Crown, FS = Full 

Super, U = Undefined 

Transition 

Type 

Enumerated list : {L,PC,PRC,BRC,CRC,SRC} 

 

L = Linear, PC = Parabolic Curve, PRC = Parabolic Reverse Curve, BRC = 

Biquadratic Reverse Curve, CRC = Cubic Reverse Curve, SRC = 

Symmetrical Reverse Curve 

Non-Linear 

Curve 

Length 

Default Value = 0.0 

 

Only pertinent for transition type: parabolic curve or symmetrical reverse 

curve. 
 

 

Workflow 

1. Create the CSV file, based on file format. 

2. Create superelevation section and lanes, ensuring the lane names match those used 

in the CSV file. 

3. Select the Import Superelevation tool. 

4. Follow the heads-up prompts: 
 

Prompt User Action 

Locate First 

Superelevation Section 

Select the first section. In lieu of selecting each section 

individually, drag your cursor diagonally across all desired 

sections. Your diagonal defines a square wherein the entire 

section must be encompassed in order to be included. 

Locate Next 

Superelevation Section 

or Reset to Complete 

Continue selecting sections until all are highlighted, then reset 

to move to the next prompt. 

  

Import File Name Use <ALT> <DOWN> to open the File Manager to select 

directory / CSV file. 

 

The results look identical to those of the calculated superelevation lanes. All functionality (i.e., 

editor, graphic manipulation, etc.) supported for calculation lanes is also supported for imported 

lanes, aside from reprocessing. 
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Assign Superelevation to Corridor 

 

At any time during the process, the superelevated lanes can be associated with a corridor. If the 

superelevated lanes are in a different file than the corridor, you must be in the corridor file with 

the super lanes attached as a reference. They can both be in the same file. 

The result of this step is the superelevated pavement is reflected in the corridor model. 

Workflow 

1. Verify that the template has the Superelevation Flag set for all pavement points 

used as candidate superelevation points. This flag is used for automatically setting 

the point controls.  To discover if the Flag has been applied to the template, Open 

the Edit Template Drop and select the Template Drop handle. Once inside the 

Editor, double click on the EOP point. 

 

2. From within the DGN containing the corridor model, select the Assign 

Superelevation to Corridor tool. 

3. Follow the heads-up prompts. 
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Select the first section. In lieu of selecting each section individually, drag your cursor diagonally 

across all desired sections. Your diagonal defines a square wherein the entire section must be 

encompassed in order to be included. 

 

Prompt User Action 

Locate First 

Superelevation 

Section 

Select the first section. In lieu of selecting each section individually, 

drag your cursor diagonally across all desired sections. Your diagonal 

defines a square wherein the entire section must be encompassed in 

order to be included. 

 

Locate Next 

Superelevation 

Section or Reset 

to Complete 

Continue selecting sections until all are highlighted, then reset to move 

to the next prompt. 

 

Locate Corridor Select the corridor wherein the superelevation transitions are to be 

applied. 

 

The Associate Superelevation dialog is displayed. 

 

 

 

1. If the information is correct, click OK. If not, click Cancel and review the 

template. Superelevation has been incorporated into the corridor model. 

2. Generate a dynamic cross section view to see the superelevation. 
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Insert Station Cross Slope 

 

There may be times when an additional station and cross slope transition need to be added to an 

existing superelevation lane. Rather than deleting the lane and recreating it, the Insert 

Superelevation Station/Cross-slope tool can be used. 

 

 

Workflow 

1. Select Superelevation Station/Cross-slope. 

2. Follow the heads-up prompts. 

 

Prompt User Action 

Locate 

Superelevation 

Select a previously created superelevation lane that has superelevation 

calculations already assigned. 

Distance Constraint 

Type 

None = 

Distance Offset = 

Vector Slope = 

Slope Constraint 

Type 

None = 

Cross Slope = 

Mirror Cross Slope = 

Match Cross Slope = 

Vector Slope = 

Pivot About Identifies which edge to pivot about. 
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Transition Type Optional - Type of superelevation transition at this station and cross slope. 

Possible values include: 

L = Linear 

PC = Parabolic Curve 

PRC = Parabolic Reverse Curve 

BRC = Biquadratic Reverse Curve 

CRC = Cubic Reverse Curve 

SRC = Symmetrical Reverse Curve 

Station Required - Station where cross slope is defined. 

Station equations supported based on the section's reference alignment 

and the Design File Settings > Civil Formatting > Station Settings > 

Equation setting. 

Cross Slope Required – Cross slope at the specified station formatted as a double 

value (-2% = -0.02). 

Point Type Optional – Type of superelevation point at this station and cross slope. 

Possible values include: 

NC = Normal Crown 

NCIN = Normal Crown Inside 

NCOUT = Normal Crown Outside 

LC = Level Crown 

LCIN = Level Crown Inside 

LCOUT = Level Crown Outside 

RC = Reverse Crown 

RCIN = Reverse Crown Inside 

RCOUT = Reverse Crown Outside 

FS = Full Super 

FSIN = Full Super Inside 

FSOUT = Full Super Outside 

U = Undefined 

Locate Reference 

Element 

Select the Civil horizontal element to be used as a basis for superelevation 

lanes and calculations. 

Start Station Graphically define (based on the dashed line perpendicular to the 

reference element) the beginning of the section. The station can be keyed 

in and locked. 
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Superelevation Editor   

 

The superelevation editor is another way to edit the data, in a tabular format. Any changes made 

in the editor are automatically synced with the graphic lanes and vice versa. Any data in gray 

cannot be edited, due to constraints used during calculations with the XML method. 
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The editor is opened by selecting the tool, then selecting the superelevation section(s). The curve 

sets are listed along the left side. Highlighting any curve set populates the table. Colored points 

indicate: 

• Red - fully constrained 

• Yellow - partially constrained 

• Green - not constrained 

 

 

Between the diagram and the table are numerous short-cut icons to the superelevation tools. The 

superelevation diagram at the top is display only. Right click on the superelevation diagram to 

display the Superelevation Display List dialog. 

The fields in the editor can be customized so unused or unwanted fields can be hidden. This is 

accomplished by right-clicking on any Header in the tabular data area to open the pop-up menu. 

 

 

 

 

 

 

 

 

 

 



OpenRoads Designer Road 1 Chapter 6 – Superelevation  
 

4/18/23 Missouri Department of Transportation 6-21 

Open Superelevation View   

 

Opens the editable superelevation diagram directly in a MicroStation view or Model.  

Certain points in the view may be edited directly in this Superelevation Model. 
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Superelevation Report   

 

Superelevation reports can be generated for a single or multiple sections. Reports are displayed in 

the Civil Report browser. 

Workflow 

1. Select Superelevation Report. 

2. Follow the heads-up prompts. 
 

Prompt User Action 

Name Name each section, suggestions include alignment name which 

can be appended -1, 2, etc. for projects with multiple sections. 

Locate Reference 

Element 
Select the Civil horizontal element to be used as a basis for 

superelevation lanes and calculations. 

Start Station Graphically define (based on the dashed line perpendicular to the 

reference element) the beginning of the section. The Station can 

also be keyed in and locked. 
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Superelevation by Corridor   

In OpenRoads Designer, the ability to choose the corridor instead of an alignment.  This will use 

the template(s) used in the corridor to create sections, create lanes, calculate superelevation and 

assign those calculations to the corridor.  This is by far the easiest way to create supereleveation. 

The steps require the superelevation be placed in the same DGN file as the corridor. 

2. Under Corridors > Superelevation > Create choose Create Superelevation 

Sections 

a) Name the Superelevation 

b) Locate the Corridor – select the corridor 

3. Choose the Rules File (XML) MoDOT_Superelevation_Rules_File.xml 

4. Key-in the Minimum Tangent Length 

a. For MoDOT projects this is typically a a large value so that only on Section is 

created for the entire alignment. 

b. When you have only one section, the User will apply a Design Speed for the 

entire alignment/section. 

c. If the User needs to have different Design Speeds throughout an alignment, 

the User will need to create a sperate Superelevation Section for each area 

with a different Design Speed. 

5. Left-click to allow the tool to run.  This will create and apply superelevation to 

the corridor 
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Editing Lanes 

There are several ways to review the superelevation data and edit if desired. Highlighting a 

section displays station and cross slope values for review and editing. Stationing can be 

changed dynamically by selecting the gray wedge and dragging to the desired station. Each 

lane can be manipulated independently of the adjacent lanes. The station can all be keyed into 

the edit field. Slopes can be changed by keying the slope into the edit field. 
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6.9 Group Exercise – Ramp 4 Superelevation 

1. Within the Roadway\data-6 folder, open the file: Corridors_Ramp-

4_J5P3181.dgn 

2. Create a new file named Superelevation_J5P3181.dgn using the  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

This new file will hold all of the Superelevation sections. 

3. Open the Coordinate System tool by selecting the OpenRoads Modeling 

Workflow ➔ Utilities Tab ➔ Geographic Section. 

4. Select “From File” icon. 

 

5. Select the Terrain_J5P3181.dgn file in the data-6 folder. 

6. Verify the settings.  

 

 

7. Reference in the following file: 

Civil_Geometry_J5P3181.dgn. 

8. Change the Annotation Scale to 1”=50’ 
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Create Superelevation Sections   
 

9. To Start creating the Superelevation for Ramp 4 select the following: 

 

Open Roads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Section ➔ 

Create Tools ➔ Create Superelevation Sections 

 

a. Set the Feature Definition to Superelevation 

 

b. When prompted for the Name key in Ramp 4 and data point or tab to 

accept. 

 

c. When prompted to Locate Reference Element data point on the Ramp 4 

horizontal geometry. 

 

d. When prompted to enter the Start Station either select the beginning of Road 

or press the Alt key to lock to the beginning station.  Data point to accept. 

 

e. When prompted to enter the End Station either select the end of Road or 

press Alt to lock to the ending station.  Data point to accept. 

  

f. There are two horizontal curves in the Ramp 4 alignment.  Since MoDOT uses 

the same Design Speed for the entire alignment, the User will enter a value 

longer than the distance between the two curves for the Minimum Tangent 

Length (for example: 10000 ft) so that the tool just creates a single 

superelevation section.  Data point to accept. 

 

Note:  If the geometry had multiple curves with different design speeds, then the User 

would use a smaller Transition Length to create multiple Superelevation Sections. 
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Notes: 

Create Superelevation Lane(s)   

 

10. After creating the Superelevation Section, the Superelevation tool will now 

prompt you to create the Superelevation Lane(s)   

a. Enter the Lane name: 0 to 6FT 

b. Enter Lane Type: Primary 

c. Side of Centerline: Left 

d. Inside Edge Offset: 0’  

e. Width: 6’  (The template width of Ramp 4 is 18ft, 18ft - 12ft = 6ft ) 

f. Normal Cross Slope: 2%  (sloping UP from the baseline) 

g. Enter the Lane name: 6 to 18FT 

h. Enter Lane Type: Primary 

i. Side of Centerline: Left 

j. Inside Edge Offset: 6’  

k. Width: 12’  (typically AASHTO defines the width of one lane of pavement as 

12’)  

l. Normal Cross Slope: 2%  (sloping UP from the baseline) 

m. Right Click to exit from the Lane Creation. 

 

• There is a Superelevation concept called “Number of Lanes Rotated”, which will adjust 

the Runoff distance UP if the Number of Lanes Rotated is greater than one.  See 

AASHTO 2018 Table 3-16a. 

• AASHTO typically consider a “Full-Lane” being 12ft wide. 

o MoDOT uses a hard coded Nominal Lane Width = 12 ft in its Superelevation 

Rules File.  If MoDOT did not hard code the Nominal Lane Width, OpenRoads 

Designer would use the width of the outermost lane as the lane width in its 

Superelevation calculations.  

o Lane widths greater than 0ft and up to 6ft, will be considered a “Half-Lane”, as 

defined in the MoDOT’s Superelevation Rules File. 

o Lane widths is greater than 6ft, will be considered a “Full-Lane”, as defined in 

the MoDOT’s Superelevation Rules File.    

• The program looks at the lanes to determine the number of lanes rotated.  The lanes also 

assist the “Assign to Corridor” to match the super control lines with the points in the 

template that they should control.  

• There are two types of superelevation lanes.  Primary lanes extend the entire length of a 

section. They begin and end stations are defined by the section. Primary lanes are 

generally the through lanes that extend throughout the project.  Auxiliary lanes are lanes 

that are added and dropped along the alignment such as turn lanes. 
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Calculate Superelevation  

 

11. After Right Clicking the Superelevation tool will now prompt the User for the 

settings to calculate the Superelevation for this alignment. 

a. Select Rules File: MoDOT_Superelevation_Rules_File.xml 

b. e Selection: 8%  (since this is a rural project MoDOT uses 8% for and e Max) 

c. L Selection: MoDOT - AASHTO 2018 Eq. 3-23 and Table 3-16 

d. Design Speed: 50mph 

e. Pivot: Right Edge   The Superelevation tool will utilize the lane width and the 

pivot method to determine the adjusted radius distance to calculate the Runoff 

distance.  

f. Open Editor: Yes 
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12. Below is what the User will get when the Editor option is selected: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

  

 

a. The User might notice that the two superelevation lanes have the same values.  

There are two lines in the diagram representing each lane, but since they have 

the same values they are directly on top of each other. 
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13. To demonstrate that the Superelevation “Profile” can be modified using the 

Superelevation Editor adjust following two items of only the 0 to 6ft 

Superelevation “Profile” Line.  

a. Delete the entire row with the Station 11+17.90 in the lane 0 to 6 ft 

b. Adjust Station 13+54.21 to have a positive 2.00% slope  

 

 

b. Close the Superelevation Editor. 
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Open Superelevation View    

 

14. Open the superelevation view for Ramp 4 by select the following: 

 

Open Roads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Tools ➔ 

Open Superelevation View 

 

a. After enabling the Open Superelevation View tool and choosing the Ramp 4 

Superelevation Section, select View 8 to display the Superelevation “Profile”. 

b. Select the F8 key to change your background from black to white. 

 

 

15. To demonstrate that the Superelevation “Profile” can be modified within the 

Superelevation View, delete the 0 to 6 ft Superelevation “Profile” Line by left 

clicking and using the heads-up tools select Delete. 

Close the Superelevation View. 
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16. Select the F8 key to change your background from White to Black. 

17. Next, in the 6 to 18FT Lane adjust the Inside Edge Offset from 6 ft to 0 ft 

(Zero), then adjust the Lane Width to 18 ft.  To do this left click on the Lane 

Shape itself and bring up the heads-up values (see below). 
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18. The User should note that the Superelevation Shape in the dgn has adjusted to 

every change made in the last few steps.  All the changes could have been made 

by clicking on the Superelevation Section and modifying the heads-up 

Superelevation Shape settings.  

   The station value of the slope can be adjusted by selecting these values. 

    Slope values can be adjusted selecting these values. 

    Lanes width can be adjusted by selecting these values. 

    These arrows indicate the direction of superelevation slope. 

    These values show the inside edge offsets to the lanes. 

    By left clicking on the shape you can bring the heads-up tools 
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19. Select the Superelevation Shape and using the heads-up tools adjust the Shapes 

Name to “0to 18ft”.  

 

 

20. To match the slope of the Route 54 pavement at the end of the Ramp 4, select the 

Superelevation Shape and verify the slopes of the shape at the following two 

stations. 

Station  Slope 

11+17.90 2.00% (Sloping toward the Ramp4 baseline) 

13+54.21 2.00% (Sloping toward the Ramp4 baseline) 
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 Assign Superelevation to Corridor    

 

21. Next, we need to apply the Superelevation to the Ramp 4 Corridor.  Open the 

Corridors_Ramp-4_J5P3181.dgn file.  Check in the 

Superelevation_J5P3181.dgn file when prompted. 

22. Reference in the Superelevation_J5P3181.dgn file. 

23. To apply the Superelevation, select the following: 

 

Open Roads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Tools ➔ 

Calculate Tools ➔ Assign to Corridor  

 

24. When prompted to Locate First Superelevation Section left click on the Ramp 

4 Superelevation Section. 

 

a. Since there is only one section for Ramp 4, when prompted, Reset to 

Complete. 

 

25. When prompted to Locate Corridor, identify one of the Ramp 4 corridor 

handles.  These extend from the outside edge of the corridor. 

 

26. A dialog with a list of the Superelevation objects will display.  Review to verify.  

If changes to Stations, priorities, or points are required, they can be made here.  If 

correct click OK. 

 

 

a. Select “F4” to exit the tool. 

27. Next in the Reference Dialog turn off the display of the 

Superelevation_J5P3181.dgn for View 1. 
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Open Cross Section View    

 

28. Open the dynamic Cross Section Dynamic View for Ramp 4 by select the 

following: 

 

Open Roads Modeling Workflow ➔ Corridors ➔ Review Tab ➔ Dynamic Sections 

➔ Open Cross Section View 

 

(a) After enabling the Open Cross Section View tool and choosing the Ramp 4 

corridor, select View 8 to display the Dynamic Cross Sections. 

(b) While navigating from section to section  

(c) Right-Click and hold in a blank area to bring up the heads-up tools. 

1. Place a Horizontal Temporary Dimension Line 

2. Place a Vertical Temporary Dimension Line. 

(d) Use the Locate Station Via Datapoint 

(e) Remove All Temporary Dimension Lines 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

29. Close View 8 

30. Select File > Update Server Copy 



OpenRoads Designer Road 1 Chapter 6 – Superelevation  
 

4/18/23 Missouri Department of Transportation 6-37 

6.10 Individual Exercise – Route 54 Superelevation 

1. Within the Roadway\data-6 folder, open the file: Superelevation_J5P3181.dgn  

Verify that the active template library is the project’s J5p3181.itl  If needed use the 

Create Template tool to activate template library. 

 

Create Superelevation Sections   
 

2. To Start creating the Superelevation for Route 54 select the following: 

 

OpenRoads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Section ➔ 

Create Tools ➔ Create Superelevation Sections 

 

a. Set the Feature Definition to Superelevation 

b. When prompted for the Name key in Route 54 and data point or tab to accept. 

c. When prompted to Locate Reference Element data point on the Route 54 

horizontal geometry. 

d. When prompted to enter the Start Station either select the beginning of Road or 

press the Alt key to lock to the beginning station.  Data point to accept. 

e. When prompted to enter the End Station either select the end of Road or press 

Alt to lock to the ending station.  Data point to accept. 

f. When prompted to enter the Transition Length enter 1000 ft 

g. When prompted to enter the Lane Creation Method enter Template 

 

Since Route 54 only has one curve in the alignment, no matter what you type in 

for a transition length only one Superelevation section will be created. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

3. Select “F4” or right click to get  

out of the tool. 

 

 

 

Note:   
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Create Superelevation Lane(s) by Road Template   

 

 
4. Create the Superelevation lanes for Route 54 using the following tool: 

 

Open Roads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Tools ➔ Create 

Tools ➔ Create Superelevation Lanes by Road Template 

 

5. After activating the tool do the following:  

a. Select the Route 54 Superelevation Section, this is the only section for the 

alignment. 

b. Select the following template:   

Route 54\Route 54 Concrete Pavement 4 Lane Divided w/ Agg Base Option 3 

 

Calculate Superelevation  

 
6. Calculate the Route 54  superelevation using the following tool: 

 

Open Roads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Tools ➔ 

Calculate Tools ➔ Calculate Superelevation 

 

7. After activating the tool select the following:  

a. Select Rules File: MoDOT_Superelevation_Rules_File.xml 

b. e Selection: 8%  (since this is a rural project MoDOT uses 8% for and e Max) 

c. L Selection: MoDOT - AASHTO 2018 Eq. 3-23 and Table 3-16 

d. Design Speed: 70mph (to get 70mph to show up in the pull-down list you might 

have to switch the e Selection from 8% to 4% and then back to 8%). 

e. Pivot: Divided Inside - The Superelevation tool will utilize the lane width and the 

pivot method to determine the adjusted radius distance to calculate the Runoff 

Lengths.  

f. Open Editor: Yes 
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• There is a Superelevation concept called “Number of Lanes Rotated”, which will 

adjust the Runoff distance UP if the Number of Lanes Rotated is greater than one.  

See AASHTO 2018 Table 3-16a. 

• AASHTO typically consider a “Full-Lane” being 12ft wide. 

o MoDOT uses a hard coded Nominal Lane Width = 12 ft in its Superelevation 

Rules File.  If MoDOT did not hard code the Nominal Lane Width, OpenRoads 

Designer would use the width of the outermost lane as the lane width in its 

Superelevation calculations.  

o Lane widths greater than 0ft and up to 6ft, will be considered a “Half-Lane”, as 

defined in the MoDOT’s Superelevation Rules File. 

o Lane width is greater than 6ft, and up to 12ft will be considered a “Full-Lane”, 

as defined in the MoDOT’s Superelevation Rules File.    

• The program looks at the lanes to determine the number of lanes rotated.  The lanes 

also assist the “Assign to Corridor” to match the super control lines with the points in 

the template that they should control.  

• There are two types of superelevation lanes.  Primary lanes extend the entire length 

of a section. They begin and end stations are defined by the section. Primary lanes are 

generally the through lanes that extend throughout the project.  Auxiliary lanes are 

lanes that are added and dropped along the alignment such as turn lanes. 

• The User needs to understand that certain constraints of points in the template will be 

overridden with a Point Control when Superelevation is applied to the template.  The 

reason points are available to be overridden is because within their Template Point 

Properties the Superelevation Flag option is enabled.  Please review the template 

points below that are available to the Superelevation tool:  
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8. Below is what the User will get when the Editor option is selected: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

a. Close the Superelevation Editor. 
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Open Superelevation View    

 

9. Open the superelevation view for Route 54 by select the following: 

 

Open Roads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Section ➔ 

Open Superelevation View 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. Review the Superelevation View, then close view. 
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10. The User should note that changes to the Superelevation can be made by clicking on 

the Superelevation Section and modifying the heads-up Superelevation Shape 

settings.  

   The station value of the slope can be adjusted by selecting these values. 

    Slope values can be adjusted selecting these values. 

    Lane width can be adjusted by selecting these values. 

    These arrows indicate the direction of superelevation slope. 

    These values show the inside edge offsets to the lanes. 

    By left clicking on the shape you can bring the heads-up tools 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Select the Superelevation Section and verify the slopes at the following locations. 

  Alignment Location   Station___           Slope_Section______            

Tangent to Spiral (TS) 611+21 R2 B-B Section (Level Crown) 

Spiral to Curve (SC)  614+54 R2 D-D Section (Full Super) 

Curve to Spiral (CS)  622+93 R2 D-D Section (Full Super) 

Spiral to Tangent (ST) 626+26 R2 B-B Section (Level Crown) 
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Assign Superelevation to Corridor    

 

12. Next, we need to apply the Superelevation to the Route 54 Corridor.  Open the 

Corridors_Route-54_J5P3181.dgn file.  Check in the 

Superelevation_J5P3181.dgn file when prompted. 

13. Reference in the Superelevation_J5P3181.dgn file into the 2-D View. 

14. To apply the Superelevation, select the following: 

 

Open Roads Modeling Workflow ➔ Corridors Tab ➔ Superelevation Section ➔ 

Calculate Tools ➔ Assign to Corridor  

 

15. When prompted to Locate First Superelevation Section left click on the Route 54 

Superelevation Section.  The Section Line is hidden under the Superelevation 

shape.  The easiest place to select this section line is at the beginning or ending of the 

alignment. 

 

a. Since there is only one section for Route 54, when prompted, Reset to Complete. 

 

16. When prompted to Locate Corridor, identify one of the Route 54 corridor handles.  

These extend from the outside edge of the corridor. 

 

17. A dialog with a list of the Superelevation objects will display.  Review to verify.  If 

changes to Stations, priorities, or points are required, they can be made here.  If 

correct click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

18. Next in the Reference Dialog turn off the display of the 

Superelevation_J5P3181.dgn for View 1. 
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Open Cross Section View    

 

19. Open the dynamic Cross Section Dynamic View for Route 54 by select the 

following: 

 

Open Roads Modeling Workflow ➔ Corridors ➔ Review Tab ➔ Dynamic Sections 

➔ Open Cross Section View 

 

a. After enabling the Open Cross Section View tool and choosing the Route 54 

corridor, select View 8 to display the Dynamic Cross Sections. 

b. While navigating from section to section  

c. Right-Click and hold in a blank area to bring up the heads-up tools. 

1. Place a Horizontal Temporary Dimension Line 

2. Place a Vertical Temporary Dimension Line. 

d. Use the Locate Station Via Datapoint 

e. Remove All Temporary Dimension Lines 

 

 

 

 

 

 

 

 

 

 

 

 

 

20. Close View 8 

21. Select File ➔ Update Server Copy 
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7.1 Objectives 

The purpose of this chapter is to show the user how to use the multiple tools available in 
Corridor Modeling task group to achieve desired results for the design of the corridor.  

• Template Drop Editing 

• Point Controls 

• Parametric Constraints 

• Corridor References (Feature Constraints) 

• Transitioning (components and end conditions) 

• Target Aliasing 

• Corridor Clipping 
Learn about the Hierarchy of control for points in templates 

7.2 Template Point – Hierarchy of Control 
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7.3 Template Drop Editing 

Create Template Drop 
 
 
Using the Create Template Drop tool  defines what the cross sections of the roadway look like 
for that portion of the road based on user-defined station range. A project may comprise a single 
template drop, or multiple template drops.  
 
The tool can be used for either adding on more template drops or completely replacing a station 
range with a different template. 
 

 
 
Template Editor 
 
In order to use tools such as Parametric Constraints, Corridor References, or having end 
conditions seek something other than the active surface, certain requirements need to be met in 
the template.  
Points in a template need to meet certain requirements for Parametric Constraints and Corridor 
References 

7.4 Template Point Controls 

Point controls are used to override the established horizontal and vertical locations of points from 
the original point location on the template.  Point controls are the equivalent of the criteria adhocs 
placed on plan graphics with D&C Manager to control widths, ditch slopes, etc.  Point controls 
then are used to control horizontal and vertical locations for EOP, EOS, sidewalks, retaining 
walls, barriers, special ditch profiles and ditch widths, etc. 

The Create Point Control icon  can be accessed thru the Corridor Modeling tasks group. 

Point Controls are used to override the normal locations of one or more points and or 
components in a cross section. Examples of this include lane widening, staying within the right-
of-way, maintaining a particular slope for a ditch, and superelevation. 

An example would be a ramp is merging into the main road. The ramps left edge is vertically 
controlled by the main road right edge of pavement. The ramps left edge is horizontally controlled 
by the main road right edge from 0+00 to 1+00, and then it can be controlled by a horizontal 
alignment, for example of a name to use would be “Ramp Left EOP”. 
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The following are the prompts for the Create Point Control command: 

Locate Corridor Selects the corridor where the point controls are applied. 

Station Limits (Start/Stop) Specifies the start and stop stations for the control. 

Control Description Allows you to enter a description of the control. 

Point Allows you to select the point to be controlled.  Select from the list or identify the point 
in the cross-section using the locate button. The selected point is highlighted in plan/cross 
section and profile or superelevation views as applicable. 

Mode Allows you to select the control mode: Horizontal, Vertical, or Both. 

Control Type Specifies the type of control. 

If the mode is Horizontal or Both, valid control types are Linear Geometry, Feature 
Definition, or Corridor Feature. 

If the mode is Vertical, valid control types are Linear Geometry, Feature Definition, 
Corridor Feature, Superelevation, Elevation Difference, Elevation and Grade. 

The selection combo boxes and/or field displayed depends on the selected Mode and 
Control Type. 

Type - Linear Geometry If the type is Linear Geometry, a Horizontal Offsets combo box 
is displayed. If the mode is Both, a Vertical Offsets combo box is also displayed. 

Type - Feature Definition If the type is Feature Definition, a Feature Definition and 
Range text field is displayed. 

Type - Corridor Point For all modes, Corridor and Reference Feature combo boxes are 
displayed. These options allow you to set up the control of one corridor’s points(s) from 
another corridor’s point(s). 

Targeting another corridor's point cannot be done simultaneously with Target Aliasing of 
that same corridor. If Target Aliasing has been defined, the Corridor Point is not available 
for selection within the Point Control dialog. This produces a recursive situation, making 
the corridor point control unavailable for selection until that Target Aliasing is removed. 

Type – Superelevation This option displays a Superelevation control line combo box, and 
a Reference Point combo box. Superelevation control lines are stored in the roadway 
design, not on the alignment. The reference point is the pivot point (feature) about which 
the point will rotate. 

Type - Elevation Difference This option displays Horizontal and Vertical alignment 
combo boxes. The vertical alignment represents a vertical difference value to be applied to 
the points’ current elevation. 

Type - Elevation and Grade This option displays an Elevation field, and a Grade field. 
The control sets elevation of the point at the start station to the elevation specified. The 
slope of the point’s line is then at the grade specified until the end station is reached. 
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Priority Determines the order of controls on a point. This value applies only when there are 
conflicting controls on a point. Where there is a conflict, the control with the lower priority is 
applied (that is, lower numbers are applied first). 

Use as Secondary Alignment Specifies that horizontal point controls are also used as 
secondary alignments. This option is available only when working with a 2D entity. If you are 
using a 3D object, the software skips the secondary alignment option. 

Horizontal Offsets (Start/Stop) Specifies the start and stop horizontal offset controls for the 
corridor. If the values are different, then the value applied at a given station is calculated using 
a linear algorithm. 

Vertical Offsets (Start/Stop) Specifies the start and stop vertical offset controls for the 
corridor. 

7.5 Parametric Constraints 

Parametric constraints are used to override the original constraint values established in the 
template from the library being used.  The Create Parametric Constraint icon  can be accessed 
from the Corridor Modeling tasks group. 

The parametric constraints are the equivalent of a re-definable variable.  So, the names of the 
parametric constraints established in MoDOT Template Library mirrors the criteria names as 
much as possible. 

Parametric Constraints are setup in the template and applied to the corridor using the Create 
Parametric Constraint command. 

The prompts for the Create Parametric Constraint command are as follows: 

Locate Corridor – select the corridor where you want the Parametric Constraints applied. 

Start/End Station - Specify the start/end station for the override. 

Constraint Label - Lists all labeled constraints in the design. The selected label receives the 
override. 

Start/Stop Value - Specifies the constraint value and can be transitioning from the first 
parametric value at the start and stop values. 

7.6 Corridor References 

The Add Corridor Reference tool  adds graphical elements to the corridor processing. This must 
be done even if the feature is targeted in the template, otherwise the elements will not process. It 
enables only those elements associated with a particular corridor to be processed, rather than all 
elements of a particular feature definition. This speeds up processing, and eliminates processing 
of unwanted elements of the same feature definition. The elements can be selected within the 
tool, or a selection set can be created prior to commencing the tool. 

Workflow 
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1. Select the Add Corridor Reference tool. 
2. Select the Corridor. 
3. Select the First Reference Element - select the graphical element to be added as a reference. 
4. Continue selecting until all elements are referenced, then reset to exit tool. 

The Remove Corridor References tool  removes graphical elements from the corridor processing, 
but does not delete the element. The elements can be selected within the tool, or a selection set 
can be created prior to commencing the tool. 

Workflow 

1. Select the Remove Corridor Reference tool. 
2. Select the Corridor. 
3. Select the First Reference Element - select the graphical element to be removed as a reference. 
4. Continue selecting until all elements are referenced, then reset to exit tool. 

7.7 End Condition Exceptions 

 Used to modify the behavior of an end condition solution without requiring the use of additional 
template drops. 
 
You can access this tool from the following: 
 

 
 
 
 
 
 
 
 
 

 

Open Roads Modeling  Corridors  Edit  Edits  End Condition Exception 

In many cases, it is desirable to keep the backbone of the road the same but change what is 
happening where the new design is intersecting the surface. One way to do this is to create a new 
template with the same backbone components and new or different end condition components; 
then, drop this new template at the appropriate station. The problem with this approach is that 1) it 
creates template transitions that must be resolved, 2) the conditions on the left and right sides of 
the design are likely to change at different locations, possibly requiring extensive collection of 
slightly varying templates to meet all the possible combinations (also numerous template drops). 
The solution to this situation is End Condition Exceptions. End Condition Exceptions are used to 
modify the behavior of an end condition solution without requiring the use of additional template 
drops. When an end condition exception is added, it must be edited to change its behavior. End 
condition exceptions come in two classes: 
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• Overrides 

• Transitions 

Overrides 

Overrides allow you to replace or override the template drop end conditions on the left or right of 
the backbone. When you choose this option, you must edit the override to set up the new end 
condition. When the override exception is edited, the Create Template dialog is displayed 
allowing you to edit the end-condition. You may also drag and drop a standard end condition 
from the library and make edits. 

 

Transitions 

End condition transitions are used where the end condition may change suddenly due to changes 
in the existing surface or other reason, and you want the transition to be smooth over a specified 
station range rather than a sudden change over a short length. One common instance of this is 
where the end condition criteria may cause a slope to be changed from 1:6 to 1:2 over a 5 foot 
processing length. In this case, a smooth transition from 1:6 to 1:2 over 100 feet would be ideal. A 
transition could be created that starts 100 feet back from the 2:1 slope station and ended at the 2:1 
slope station. Another instance would be going from an end condition with no shoulder to one 
with a shoulder. Here, you could model the shoulder as gradually appearing rather than going 
from no shoulder to full shoulder in a 5 foot interval. 

As with the override exception, the transition exception needs to be edited after placement. The 
following graphic is an example of editing a transition from no shoulder to having a shoulder. 
Notice that the shoulder point was selected first so that the transition line uses that feature style. 
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Backbone Only 

Backbone Only (Left) - indicates that no end condition will be applied over the station range on 
the left side. 

Backbone Only (Right) - indicates that no end condition will be applied over the station range on 
the right side. 

 

7.8 Corridor Clipping 

Adding a Clipping Reference 
 
The "clipping" feature allows you to remove areas of overlap when working with MicroStation 
elements or multiple corridors. In the following illustration, the rectangle (MicroStation element) 
is defined as the clipping reference for the corridor. Therefore, all elements of the corridor within 
the rectangle are "clipped" or deleted, leaving only the horizontal geometry element. When 
working with multiple corridors where a corridor intersects a crossing roadway (defined by a 
second corridor), clipping would be used to remove all overlapped features within the 
intersection. 
You can access this tool from the following: 
 

 
 

Open Roads Modeling  Corridors  Miscellaneous  Corridor Clipping  Add Corridor Reference 
 
The "clipping" feature allows you to remove areas of overlap when working with multiple 
corridors in a single surface. For example, in a corridor intersected by a crossing roadway, 
clipping would be used to remove all overlapped features within the intersection. 
 
Workflow: 
 
5. Select the Add Clipping Reference tool. 
6. Select the corridor to be clipped. 
7. Locate Clipping Reference - select elements until all are defined, then reset to complete. The 

corridor is processed, and the clipping reference is added. 
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Removing a Clipping Reference  
 
Removing a Clipping Reference  removes a clipping reference and reprocesses the corridor 
model without the reference. It does not delete the actual clipping reference element. However, 
you will want to always remove a clipping reference in a corridor before deleting the element 
being used as the clipping reference. 
 
You can access this tool from the following: 
 
Open Roads Modeling  Corridors  Miscellaneous  Corridor Clipping  Remove Clipping Reference 

 
The Remove Clipping Reference tool removes the clipping reference, reprocesses the corridor, 
restoring the clipping area to its previous state prior to clipping. 
 
Workflow: 
 
1. Select the Add Clipping Reference tool. Select the Corridor where the clipping is to be 

removed. Locate Clipping Reference - select elements until all are defined, then reset to 
complete. The corridor is processed and the clipping reference is removed. 

7.9 Target Aliasing 

Target aliasing allows you to target other corridor surfaces or features or to set up a prioritized 
target list for end condition solutions on surfaces, features and alignments. This means that on a 
large job where the existing surface may have been broken up into more than one surface, you 
don’t need to be concerned about where those breaks occur, and you don’t need to create a 
different template for each existing surface. Use target aliasing to find the proper solution. 
 
In any situation where the active surface is the target, the software looks for the mainline 
corridor surface and uses whichever is closer because you have turned on that option. If the Use 
Closest option is not set, then it would search for the surfaces in the order they are displayed, and 
it would stop as soon as a solution was found. 
 
Target Aliasing cannot be defined with a corridor that targets that corridor with a Corridor Point 
Control. This produces a recursive situation, making the corridor unavailable for Target Aliasing 
until that corridor point control is removed. 
 
You can access this tool from the following: 
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7.10  Design Changes 

The lifecycle of a roadway project is long, and complex.  Changes must be done to accommodate 
for unforeseen situations or to stay within budget.  The Corridor Modeling tools offers the 
flexibility to allow these design changes. 

7.10.1 Geometry Changes 
Once the horizontal and vertical geometry are created and used by a corridor, the user can go back 
and change the geometry.  Any changes will be reflected in the corridor design. 

7.10.2 Template Library Synchronization 
Changes to the template can be made either in the Corridor or in the Template Library.  Where a 
user makes the changes for his/her template depends on the circumstances and needs to be 
reviewed on a case by case basis. 

Any changes made in the template library can be obtained by synchronizing the template drops 
with the library.  This is accomplished by selecting the template drop on the corridor in the plan 
view and selecting Synchronize with Library icon from the heads-up menus.  

 

Changes can be made to a template used in a corridor by using the Edit Template command.  
The Edit Template command can either be accessed by selecting the template drop on the 
corridor in the plan view and selecting Edit Template icon from the heads-up menus or from the 
Corridor Modeling tasks group. 
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7.11 Basic Design Workflow with Corridor Modeling Tools 

5. Set up a corridor 
6. Insert template drops as needed 
7. Create any template point controls 
8. Design superelevation 
9. Set parametric constraints as needed 
10. Review design 
11. Make revisions as needed and re-review 
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7.12 Group Exercise: Corridor Modifications - Ramp 4 

1. Within the Roadway\data-7 folder, open the file: Corridors_Ramp-4_J5P3181.dgn 
2. When superelevation was applied to the Route 54 Corridor in the last chapter, the end 

slopes of Route 54 now overlap the Ramp 4 Corridor (See Below).  To help visualize the 
Ramp-4 Corridor turn off the Reference Display of the Route 54 Corridor in both the 2D 
and 3D View. 

 
3. Set the active Template Library to the following: 

Roadway/data-7/J5P3181.itl 
4. Due to the Superelevation being applied the Retaining Wall footing is now hitting the Curb 

and Gutter and Shoulder.   
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5. In both Ramp 4 template drops adjust the LT_Ret_Wall_Footing_Profile  point so that it 
has the following constraints: 
Template Drop #1  Parent 1:  Conc_T_CL 

Constraint 1 Horizontal   Value: -23.5000 
Constraint 2  Vertical  Value: -3 

 
Template Drop #2  Parent 1:  Conc_T_CL 

Constraint 1 Horizontal   Value: -24.5000 
Constraint 2  Vertical  Value: -3 

 
Also add in a Parametric Label for the Horizontal Constraint called Retaining Wall 
Offset.  
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6. Place a 2% grass slope from the Retaining Wall to the back of Curb and Gutter and Shoulder 
(sloping downward toward the right).  In both Ramp 4 template drops  adjust the 
LT_Ret_Wall_Cut_Depth point so that it has the following constraints. 
 
Template Drop #1 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Template Drop #2 
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In the next few steps, we are going to try and transition the Ramp 4 Curb and Gutter Template 
to a Shoulder template. 
 

7. In this step we are going to setup a Parametric Label to help transition the Curb Width 
out (over a distance) to match the Shoulder Width. 

 

In the first Ramp 4 template drop adjust the LT_Curb_Surf_Flowline point so that it 
has the following Parametric Label. 

 

8. Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 

In the Parametric Constraint dialog, define the values as listed below, once the values 
are defined accept values by left clicking to create the Parametric Constraint. 

   
 
 
 
 
 
 
 

Start:   2+40 
Stop:   2+50 
Constraint Label: LT Gutter Width 
Start Value:  -2.5000 
Stop Value:  -4.0000 
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9. In the next few steps, we are going to adjust the first template drop so the Ground Line 
between the Retaining Wall and the Back of Curb will transition down to the elevation at 
the Edge of Shoulder. 

 

Right Click on the LT_RetainingWallLowerGround Component and Insert a Point on 
top of the LT_Curb_Surf_Back point 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Double click on newly place point and open the Point Properties dialog.  Rename the 
point to LT_Ret_Wall_Cut_Depth_Inner 

LT_RetainingWallLowerGround Component 
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11. In the next step we are going to delete a point, but in reality, we are only removing the 
LT_Curb_Surface_Back point from the LT_RetainingWallLower Gound component.   

Right click on newly place point and select Delete Point.  Delete the 
LT_Curb_Surface_Back point: 

  

12. Delete the LT_RetainingWallLowerGround (Component) from the Point. 
 

  
 

Before deleting Point    After deleting Point  
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13. Right click on the point LT_Ret_Wall_Cut_Depth_Inner and add the following 
Constraints. 

Also add in a Parametric Label called   

 
Note: After applying the Vector-Offset, you might notice the grass line is not exactly at the 

top of the Curb.  Vector-Offset are applied/evaluated at the Point Constraint level, 
before any Parametric Constraints, Horizontal Feature Constraints, or Point 
Controls are applied. 

14. Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 

15. In the Parametric Constraint dialog, define the values as listed below once the values 
are defined accept values by left clicking to create the Parametric Constraint. 

   
 
 
 
 
 
 
 
 
 
 
 

Start:   2+40 
Stop:   2+50 
Constraint Label: LT Ground Height 
Start Value:  -0.6566 
Stop Value:   -0.0461 
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16. In this step we are going to modify the Parent Point of the LT_Ret_Wall_Cut_Depth  
point.  It is currently pointing to the LT_Curb_Surface_Back point, which is causing 
our Ground Slope not to draw at a 2.00% Slope. 

   

 

 

 

 

 

 

 

 

Adjust the Parent Point of the Slope Constraints to point to the 
LT_Ret_Wall_Cut_Depth_Inner point: 

   

Optional Step)  If the Ground Line behind the Curb did not match up with the Ground line 
behind the Shoulder, use the Corridor Creation Tools  Corridor Objects 
Bucket  Parametric Constraints to modify the Parametric Value so that 
the ground line matches up more closely. 

 

 

 

 

 



ORD Road 1           Chapter 7 – Advanced Corridor Modeling  
 

7/3/23 Missouri Department of Transportation 7-19 

17. In this step we are going to transition the Retaining Wall over to match the offset off the 
shoulder.   

 

In the first Ramp 4 template drop adjust the LT_Ret_Wall_Footing_Profile point so 
that it has the following Parametric Label. 

 

Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 

In the Parametric Constraint dialog, define the values as listed below, once the values 
are defined accept values by left clicking to create the Parametric Constraint. 

   
 
 
 
 
 
 
 
 
 

Start:   2+40.00 
Stop:   2+50.00 
Constraint Label: Retaining Wall Offset 
Start Value:  -23.5000 
Stop Value:  -24.5000 
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7.13 Individual Exercise: Corridor Modifications - Ramp 4 

1. If not already open, do the following: 
a. Open the Roadway/data-7/Corridors_Ramp-4_J5P3181.dgn. 
b. Set the active Template Library to the Roadway/data-7/J5P3181.itl 

 
In the next few steps, we are going to transition the Ramp 4 Curb and Gutter Template to a 
Template with a Shoulder, Grass Buffer and Sidewalk. 
 
2. In this step we are going to setup a Parametric Label to transition the Curb Width out (over 

a distance) to match the Shoulder Width. 

 

In the first Ramp 4 template drop adjust the RT_Curb_Surf_Flowline point so that it 
has the following Parametric Label. 

   

4. Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 
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5. In the Parametric Constraint dialog, define the values as listed below, once the values 
are defined accept values by left clicking to create the Parametric Constraint. 

   
 
 
 
 
 
 
 
 
 

 

6. In this step we are going to transition the Sidewalk Offset in to match the Sidewalk 
behind the Curb and Gutter.  

 

Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 

 

 

Start:   2+40 
Stop:   2+50 
Constraint Label: RT Gutter Width 
Start Value:  2.5000 
Stop Value:  4.0000 
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In the Parametric Constraint dialog, define the values as listed below, once the values 
are defined accept values by left clicking to create the Parametric Constraint. 

    

7. In this step we are going to transition the Curb and Gutter Sidewalk down to match the 
Sidewalk behind the Shoulder and Grass Buffer.  

 

 

 

 

 

 

 

Start:   2+50.00 
Stop:   2+60.00  
Constraint Label: Swlk_Inner_Buffer_Width 
Start Value:  0.5000  
Stop Value:  2.0000 
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In the first Ramp 4 template drop, right click on the top of the  RT_Sidewalk Surface 
Component and Insert a Point on top of the RT_Curb_Surf_Back point. 

 

 

 

 

 

 

 

 

 

 

 

 

8. Double click on newly place point and open the Point Properties dialog.  Rename the 
point to RT_Swlk_T_In. 

9. In the next step we are going to delete a point, but in reality, we are only removing the 
RT_Curb_Surface_Back point from the RT_Sidwalk Surface component.   

Right click on newly place point and select Delete Point.  Delete the 
RT_Curb_Surface_Back point: 
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10. Delete the RT_Sidwalk Surface (Component) from the Point. 
 

  
 

Note:  The RT_Curb_Surface_Back point was included in both the Sidewalk and Curb 
components before the deletion. 

11. Right click on the point RT_Swlk_T_In and add the following Horizontal and Vertical 
Constraints. 

  

Also add in a Parametric Label called Sidewalk Vertical Offset to the Vector Offset 
Constraint. 
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12. Modify the Parent Point of the RT_Swlk_T_Out point.  It is currently pointing to the 
RT_Curb_Surface_Back point, which would cause our Sidewalk Slope not to draw at a 
1.00% Slope. 

Adjust the Parent Point of the Slope and Horizontal Constraints as follows: 

 

13. Modify the Parent Point of the RT_Swlk_B_In point.  It is currently pointing to the 
RT_Curb_Surface_Back point, which is causing our Sidewalk not to draw correctly. 

Adjust the Parent Point of the Slope and Horizontal Constraints as follows: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14. When done making the changes to the Points close the Editing Roadway Designer 
Template Drop dialog to Save changes. 
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Note: After applying the template changes, you might notice the top of sidewalk is not 
exactly at the top of the Curb.  Remember that Vector-Offsets are applied/evaluated at 
the Point Constraint level, before Parametric Constraints, Horizontal Feature 
Constraints, or Point Controls are applied. 

15. Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 

In the Parametric Constraint dialog, define the values as listed below, once the values are 
defined accept values by left clicking to create the Parametric Constraint. 

     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start:   2+10  
Stop:   2+50 
Constraint Label: Sidewalk Vertical Offset 
Start Value:  -0.5599 
Stop Value:   0.0490  
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16. In this step we are going to transition down the Sidewalk Slope behind the Curb and 
Gutter to match the Sidewalk Slope next to the Shoulder.  

 

Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 

In the Parametric Constraint dialog, define the values as listed below once the values are 
defined accept values by left clicking to create the Parametric Constraint. 

    

 

 

 

 

 

Start:   2+40.00 
Stop:   2+50.00  
Constraint Label: Swlk_Surf_Slope 
Start Value:  1.00% 
Stop Value:  -2.00% 
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7.14 Group Exercise: Corridor Modifications - Ramp 4 & Route 54 

1. If not already open, do the following: 
a. Open the Roadway/data-7/Corridors_Ramp-4_J5P3181.dgn. 
b. Set the active Template Library to the Roadway/data-7/J5P3181.itl 

 
2. To help with the steep slope between the Ramp 4 and Route 54 corridors, we are going to 

raise the retaining wall height. 
 

 

3. Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Create Point Control tool. 

In the Point Control dialog, define the values as listed below, once the values are 
defined accept values by left clicking to create the Point Control. 

  

   
 
 
  
 
 
 
 
 
 
 
 

Start:   Lock to Start 
Stop:   Lock to End 
Control Description: Raise Wall 
Point:   LT_Ret_Wall_Top_Profile 
Mode:   Vertical 
Control Type:  Elevation and Grade 
Elevation:  779.00 
Grade:   4.50% 
Priority:  1 
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4. Within the Roadway\data-7 folder, open the file: Corridors_Route-54_J5P3181.dgn 
 
In the next few steps, we are going to modify the Right Route 54 Fill Slope in the area of the 
Ramp 4 corridor using an End Condition “Override” Exception.  
 

 
 

5. Select the Route 54 Corridor Grips and bring up the heads-up tools.  In those tools select the 
Corridor Creation Tools and then select the Create End Condition Exception tool. 

In the Create End Condition Exception tool, first define the Name and then the Type of 
Exception. 

 

 

 

 

 

 

 

 

 

 

End Condition Name:     Override at Ramp 4 
Apply to End Condition Exception To (ECE): Right Override  
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6. Next define the Start and Stop Station values. 

 

 

 

 

 

 

 
7.  Do not AccuSnap or Snap to any location on Route 54 corridor, User will typically get a 

message saying “Circular Dependency Detected - Reference Entity Depending on 
Corridor Result” 

 
8. Next, we need to first delete the current End Condition that is in the model. 

 

End Condition Name: Override at Ramp 4 
Apply ECE To (Type): Right Override 
Start Station:   617+26.84 R2 
End Station   621+96.13 R2  
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9. In the Template Library select Tools  Options and define the Apply AffixesPrefixes 
and Step Options as follows: 

 

10. Add the Fill Slope (6:1) End Condition to the template to define the Slope on the Right 
side.  
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11. Select the RT_Fill_Slope_B point and modify the follows settings: 

 

When done making the changes to the Point select Apply  Close  and OK 

12.  In your 2D Corridor View you should now have End Condition Exception “Shape”.  
If you single left click on the Shape you will get the Station Values, Properties, Edit, and 
Delete options for the Exception. 
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13. Next, we are going to Clip-Out the Ramp-4 Corridor so that there is no overlap 
between the two Corridors. 

Select the Route 54 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Reference   Add Clipping Reference. 

Next select the Ramp-4 Corridor and Left-Click to accept. 

14. You will notice an area at the end of our Ramp 4 Corridor that is still protruding out 
from the Route 54 Corridor. 

 

Adjust the end station of the End Condition Exception in your 2D Corridor View to 
minimize this issue.  Use a Station Value of 621+48 R2.  You will still have a little piece 
of the Route 54 Corridor hanging out in mid-air (See Below). 
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15. Within the Roadway\data-7 folder, open the file: Corridors_Ramp-4_J5P3181.dgn 

16. In the Reference Dialog turn on the Display of the Route 54 Corridor in both the 2D 
and 3D views. 

 

17. From the Ramp 4 Corridor we are going to adjust what our End Conditions are 
targeting.  Currently the End Condition are targeting the Active Surface which is the 
Existing Ground surface/terrain. 

Using the Target Aliasing tool, we are going to instruct our End Conditions to target 
the Route 54 corridor first, and if the End Condition does not see the Route 54 corridor, 
then target the Active Surface (Existing Ground Terrain). 
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18. Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools   Define Target Aliasing. 

 

Add the Route 54 corridor first and then the Terrain Model – J5P3181. 

Note: Order does matter in this dialog, item at the top will be targeted first. 

19. Select the Ramp 4 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Views   Open Cross Section Model. 

You will notice an overhang in the Route-54 model.  You will need to open the 
Corridors_Route-54_J5P3181.dgn file and let the corridor process the changes to the 
Ramp 4 Corridor.  Remember the Route 54 Corridor was Clipping out the Ramp 4 
Corridor. 
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20. Within the Roadway\data-7 folder, open the file: Corridors_Route-54_J5P3181.dgn 

21. If needed, select the Route 54 Corridor Grips and bring up the heads-up tools.  In those 
tools select the Process Corridor to update the corridor. 
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7.15 Group Exercise: Adjusting the Feature Definition (Corridor 
Design Stage) 

In the next chapter we are going to create Cross Sections, before doing so the User will 
switch and adjust the Feature Definition (Corridor Design Stage) to 1-Final x 1. 
 
Within the Roadway\data-7 folder, open both Corridor Files and adjust the Feature 
Definition (Corridor Design Stage) to 1-Final x 1 

Select the Corridor Grips and bring up the heads-up tools.  In those tools select the 
Properties icon. 

 
1. Set the Feature Definition (Corridor Design Stage) to 1-Final x 1 

 

 
 

2. When the Corridor Feature Definition (Corridor Design Stage) is set to to 1-Final x 1, the 
change causes the following two things to happen to the model. 
 
• Red Arrow  The Route 54 side slope becomes more pronounced at the end of Ramp 4. 
• Yellow Arrow  A ditch is draw at the end of the Ramp 4 
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3. To remove those two effects first open the file: Corridors_Ramp-4_J5P3181.dgn, within 
the Roadway\data-7 folder. 

Within Ramp 4’s second template drop, remove/delete the Ditch End Condition. 

 

4. Open the file: Corridors_Route_54_J5P3181.dgn, within the Roadway\data-7 folder. 

5. To help remove some of the long Fill Slopes coming off Route 54, select the End 
Condition Override shape, modify by extending the End Station to 621+75.00 R2 

 

 

 

 

 

 

 

 

 

 

 

 

 



ORD Road 1           Chapter 7 – Advanced Corridor Modeling  
 

7/3/23 Missouri Department of Transportation 7-39 

6. To help further remove the remaining long Fill Slopes coming off Route 54, use the 
following Parametric Constraint instructions:  

Within the End condition Override identify the Parametric Label for the Horizontal 
Constraint RT_Fill_Slope_B. 

 

Select the Route 54 Corridor Grips and bring up the heads-up tools.  In those tools select 
the Corridor Creation Tools and then select the Parametric Constraint tool. 

In the Parametric Constraint dialog, define the values as listed below, once the values are 
defined accept values by left clicking to create the Parametric Constraint. 

    
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Start:   621+40.00 R2 
Stop:   621+75.00 R2  
Constraint Label: Fill_Slope_X_Width 
Start Value:  5.0000 
Stop Value:  0.0000  
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7. Lastly let us extend the Fill Slope downward so that they look similar to the Fill Slopes 
within the Ramp 4 Corridor. 

 

8. Open the file: Corridors_Ramp_4_J5P3181.dgn, within the Roadway\data-7 folder. 
The reason the Fill slopes are so long mostly throughout the Ramp 4 Corridor is 
because the ground line goes through the RT_Sidewalk_Outter_Buffer, which is not 
part of the End Condition.  The Fill Slope eventually does find its target, but it must go a 
long way reach the Existing Ground Surface. 
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The reason the Fill slopes are so short at the End of the Ramp 4 Corridor is because the 
ground line goes through the Fill Slope, which is part of the End Condition, and thus hits its 
target. 
 
  
 
 
 
 
 
 
 

9. To make the Right End Slopes at the end of the alignment look like the rest of the 
corridor we are going to adjust the End Condition in the Template.  To do this we will 
adjust the Template Drop within the Corridor/dgn file. 

Select the Second Ramp 4 Template Drop and bring up the heads-up tools.  In those 
tools select the Edit Template Drop  tool. 

 

Within the template Drop, first Select the Right Fill Slope and then select Insert Point.  
Place the point somewhere between the two existing points. 
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10. Double-Click on new “Inserted” point and define the point as follows: 
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11. Double-Click on the last point of the Fill Slope (RT_Fill_Slope_1_B) and redefine the 
Parent points to RT_Fill_Slope_1_Mid: 

 
 

12. You will notice that the Model did change slightly because End Condition is still hitting 
its target (Existing Ground Surface) at the first Solution.  If the User moves the 
RT_Fill_Slope_1_Mid point out further the End Condition will not solve until it hits the 
Existing Ground Surface further out, the second solution (see image below). 
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In the cross-sections at the end of Ramp 4 the End Condition has two solutions 

  

13. Double-Click on new “Inserted” point named RT_Fill_Slope_1_Mid and adjust the 
Horizontal Constraint to 10.000 Feet: 
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14. After Selecting “Apply”, and “Save” to the template changes, the model should update 
and look like the following: 
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Explorer Dialog Sheet Index Tab 
A sheet index is an organized and named collection of sheet models from one or more design 
files. You may link any sheet model from any design file into a sheet index. You can then 
manage the properties of all the sheet models within the sheet index collectively. Sheet indexes 
may also be added to print organizer print sets for printing. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting Description 

Refresh 
 

Refreshes the content of the sheet index. Though the sheet index 
automatically refreshes when you make any changes, in some cases, you may 
need to refresh it manually by clicking this icon. 

Open Sheet 
Index for Edit  

Allows you to make changes to the sheet index. When you click this icon, other 
users cannot make changes to the sheet index. 

Make Sheet 
Index Read 
Only 

 

Turns off editing options on the sheet index. When you click this icon, the 
changes made to the sheet index are saved and other users can make 
changes to the sheet index. 
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Setting Description 

Manage Sheet 
Index  

Opens the Manage Sheet Index dialog in which you can manage the sheet 
index and its properties. 

Create Folder 
 

Creates a new folder in the sheet index. 

Add Sheet 
 

Opens the Add Sheet dialog from where you can select the file from which 
you want to add sheet links. 

Delete 
 

Deletes the selected folder or sheet link from the sheet index. If the folder 
contains links or other folders, they are deleted as well. 

Place as Table 
 

Starts the Place Table tool to place the index sheet. An index sheet contains 
properties of all the sheets in the sheet index that is placed as a table. Once 
placed, a report definition of the index sheet is also created in the Reports 
dialog. 

Open Print 
Organizer  

Opens the Select Print Style dialog. Selecting the desired print style in the 
Select Print Style dialog and clicking OK opens the Print Organizer. The Sheet 
Index displays in the Print Organizer. You can compose a new print set file 
using the sheet index. 

 
 
 
 
 

https://docs.bentley.com/LiveContent/web/MicroStation%20Help-v19/en/ManageSheetIndex.html
https://docs.bentley.com/LiveContent/web/MicroStation%20Help-v19/en/GUID-861BD288-67BF-44A5-B344-F35CAE6E7D46.html
https://docs.bentley.com/LiveContent/web/MicroStation%20Help-v19/en/PlaceTable.html
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8.1 Group Exercise: Creating a Sheet Index  

1. Within the Roadway\data-8 folder, open the file: Corridors_Route-54_J5P3181.dgn  

2. Open the Explorer tool by selecting the OpenRoads Modeling Workflow  Home Tab  

Primary Section. 

 
3. Navigate to the Sheet Index section. 
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4. Select the Open Sheet Index for Edit tool. 

 

5. Select the Manage Sheet Index tool. 
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6. Edit the Index properties and then select “OK” 

 

7. Select the Create Folder tool. 
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8. Create a folder named Cross Sections and then another folder named Plan Sheets. 
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8.2 Group Exercise: Creating Route 54 Cross Sections  

Create a New Cross-Section Design File: 
1. If not open already, within the Roadway\data-8 folder, open the file: Corridors_Route-

54_J5P3181.dgn  

2. Create a new file named Named_Boundary_Route-54_XS_J5P3181.dgn  using the  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

3. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow  
Utilities Tab  Geographic Section. 

4. Select “From File” icon. 

 

 

 

 

 

5. Select the Terrain_J5P3181.dgn file in the data-8 folder. 

6. Verify the settings.  

 

 

 

 

 

7. Reference in the following file: 
a. Civil_Geometry_J5P3181.dgn 
b. Corridors_ Route-54_J5P3181.dgn 
c. Land_Boundary_J5P3181.dgn 
d. Terrain_J5P3181.dgn 

 

8. Change the Annotation Scale to 1”=50’ 

9. MicroStation Fit View to the project location. 

10. Activate the Terrain 
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11. Zoom in to the Route 54 Corridor.  

 
Creating the Named Boundary 

12. IMPORTANT: Enable both the 2D and a 3D view by selecting the F6 key (or the tool 
will create the Named Boundaries and NOT the sheet and drawing models. The sheets 
may be created at a different time using the Named Boundaries Manager) 

13. In this next step we are going to be placing Named Boundarys to indicate where we want 
to cut cross sections.  We are going to show you two ways to open the Named Boundary 
Tool. 

The first way to open the Named Boundary tool is to Right-Click in a blank area in the 
Default 2D window (typically View #1) 
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The benefit of using the right click option is that ORD will automatically set up the 
Attributes for the Named Boundary. 

Before 

 

After 

 

 

The second way to access the Named Boundary tool is to select the OpenRoads 
Modeling Workflow  Drawing Production tab  Named Boundary tool.  

 

 

 

 

 

This methoed unfortunate does not set up the Named Boundary Attributes. 

14. After the Place Named Boundary dialog opens, select the Civil Cross Section icon 
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15. Choose the Drawing Seed from the drop-down menu  

XS Sheet – 10 Scale option 

 

NOTE: Once the Drawing Seed is selected the default preference (the offsets, interval 
and the clearances) will be added to the dialog box.  

16. In the Lower Left Corner OpenRoads should be prompting you to Identify Path 
Element. 

 

 

 

17. Data Point on the centerline of Route 54.  

Note: The tool will progress to picking a Start Station dynamically or by key-in. You can 
move your cursor beyond the start of the alignment and data point in a blank area 
which will apply the first station as the start station. To manually key-in a station it 
must be done in the Place Named Boundary Civil Cross Section dialog after the start 
station has been accepted by a data point in a blank area of the screen. 

18. For this exercise we will use 610+00 R2 as the start station for this exercise.  

Note: The “R” represents that the alignment has a station equation applied to it and the 
following number represents the region  

Accept the 610+00 R2 start station by data point in a blank area. 

19. The stop station will be 630+00 R2. Input the data in the dialog and accept. 
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20. The Left Offset = -110 and the Right Offset = 170 for this exercise  

NOTE: Viewing the 2D model makes it clear that there is more room needed on the right 
side of the alignment for the slope limits of construction. 

21. The Interval = 100 for this exercise. 

 

22. Include Control Points - Adds cross sections at horizontal control points such as PC and 
PT (Optional) 

Backward Facing – Will create boundaries with a backward facing view  

Create Drawing - When enabled, the process to create the cross-section sheets is 
automatically started after the named boundaries are created. When disabled, the named 
boundaries are created but the sheets are not created. 

Show Dialog – when enabled, a dialog with additional parameters set by the Drawing 
Seed is shown 
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23. Review Place Named Boundary Civil Cross Section Dialog: 

 

24. Once the dialog has been filled out then Accept/Reject to either place the named 
boundary or end the tool. 

 

25. When you Accept the dialog input with the Show Dialog checked on there will be 
another dialog that opens (see next page). 
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26. Change the Annotation Group to the XS Annotation with Grid option.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

27. Check On the Add To Sheet Index option 
a. Select the pathing folder icon to the right of the Add To Sheet Index 
b. Open the Roadway folder and select the Cross Section folder. This will add all the 

Sheet Models created to the Sheet Index tool 

28. Verify the check is on for the Open Model option then select OK to process. 
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29. Check in dgws. 

 

30. The Open Model option from the previous dialog when checked on will open a Cross-
Section drawing or sheet model after the processing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: In this example the tool opened the sheet model for the last cross-section.   
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31. When the Multi Model View is opened after processing the cross-section models there 
will be elements in the 2D view and shapes in the 3D view that represent the drawing and 
sheet model locations of the cross-sections.  

 

 

 

 

 

 

 

 

 

 

 

NOTE: If the shapes do not show up, 
verify that the View Attribute > 

Constructions is turned on for each 
model view of the 2D and 3D models. 
Also, if the transparency to the shapes 

do not show, verify that the option 
View Attribute > Transparency 
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Viewing the Cross Section Drawing Models and the Sheet Models 

Cross-Sections are now created in individual MicroStation and sheet models. There are various 
ways to view and open these models but, in this exercise, we will use the Active View Groups 
tool that is located at the bottom left of the default MoDOT interface.   

32. Select the Set the Active View Group pull-down and navigate to 614+00 R2 (Sheet View). 

 

33. Open the Sheet Index and verify that the Cross Section Models were added. 

 

End of Exercise 
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8.3 Adding and Removing Annotation of the XS Route 54 

Annotation of Cross-Sections are automatic when first processing but if changes happen 
to the Corridor or Profile the annotation does not update.  The following steps will 
demonstrate how to remove and apply annotation if changes occur to the corridor or 
profile after cross-sections have been created. 

In this example there is an area where the ditch backslope exceeds the right of way. We 
will use a parametric constraint to bring the slope back within the right of way limits. 

Adding Parametric Constraints: 
1. Open the Roadway\data-8\Corridors_Route-54_J5P3181.dgn file.  

2. Open the template drop for Route 54 using the heads-up display tool. 

 

3. In the RT_Ditch Component, open the Point Properties of the RT_Dtch_Bkslp_1_T 

4. Edit the (Parametric) Label to add the prefix RT_ to the Dtch_Bkslp_1_Slope label. 
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5. Add 3 parametric constraints to the Route 54 corridor as shown below to adjust the 
backslopes: 
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Parametric Constraint Settings for the RT_Ditch_Bkslp_1_Slope 

  

    

 

 

 

 

 

Start:   615+26.00 R2 
Stop:   616+00.00 R2 
Constraint Label: RT_Ditch_Bkslp_1_Slope 
Start Value:  25.00% 
Stop Value:  16.67% 

Start:   612+50.00 R2 
Stop:   612+80.00 R2 
Constraint Label: RT_Ditch_Bkslp_1_Slope 
Start Value:  16.67% 
Stop Value:  25.00% 

Start:   612+80.00 R2 
Stop:   615+26.00 R2 
Constraint Label: RT_Ditch_Bkslp_1_Slope 
Start Value:  25.00% 
Stop Value:  25.00% 
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NOTE: 2D and 3D views after the parametric constraints have been applied you will see 
the limits of construction are now within the right of way limits: 

 

 

 

 

 

 

 

 

 

 

 

Modifying the Annotation 

 

6. Open Named_Boundary_Route-54_J5P3181.dgn checking in the corridors file saving 
the changes 

7. Navigate to the 615+00 R2 Drawing Model 

Notice that the slopes have changed according to the parametric constraint that was 
added but the annotation has not updated. The annotation wasn’t showing before since 
the point on the slope wasn’t within the view but now the slope is solving in the view, but 
the annotation is missing and did not update automatically. 

8. Select the Remove Drawing Model Annotations option from the Model Annotation pull 
down. 

 
Note: You have to be in one of the Drawing Models to remove or add annotation. 
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9. The heads-up tool will show an option to either effect All Drawing Models by choosing 
Yes or No.  We will select Yes and Accept in a blank area of the screen. 

 

The annotation along with all grid lines will be removed from all the Drawing/Sheet 
Models. 

10. Select the Annotate Drawing Model option from the Drawing Model Annotation pull 
down. 

 

 

 

 

 

11. The heads-up tool will show an option to either effect All Drawing Models by choosing 
Yes or No.  We will select Yes and Accept in a blank area of the screen. 

 

 

 

 

12. This will open a heads-up display where selecting the 
<Alt>Down will allow browsing for an annotation group 
which will give a couple options for annotations. 
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13. The default will be the XS Annotation with Grid and should be accepted in a blank area 
to annotate all the models. 

 

Note: Pictured below is the re-applied annotations with the slope changes annotated.

 

End of Exercise 
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8.4 Individual Exercise: Creating Ramp 4 Cross Sections  

Create a New Cross-Section Design File: 
1. Within the Roadway\data-8 folder, create a new file named Named_Boundary_Ramp-

4_XS_J5P3181.dgn  using the following seed file:  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

2. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow  
Utilities Tab  Geographic Section. 

3. Select “From File” icon. 

 

 

 

 

 

4. Select the Terrain_J5P3181.dgn file in the data-8 folder. 

5. Verify the settings.  

 

 

 

 

 

6. Reference in the following file: 
a. Civil_Geometry_J5P3181.dgn 
b. Corridors_ Ramp-4_J5P3181.dgn 
c. Land_Boundary_J5P3181.dgn 
d. Terrain_J5P3181.dgn 

7. Change the Annotation Scale to 1”=50’ 

8. MicroStation Fit View to the project location. 

9. Activate the Terrain 

10. Zoom in to the Ramp-4 Corridor.  
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Creating the Named Boundary: 
11. Enable both the 2D and a 3D view by the F6 key 

12. Open  the Named Boundary tool by Right-Clicking and holding in a blank area of the 
Default 2D window (typically View #1) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. Select the Place Named Boundary Civil Cross Section icon 
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14. Choose the Drawing Seed from the drop-down menu  

XS Sheet – 5 Scale option 

 

15. When prompted to Identify Path Element, data point on the centerline of Ramp 4.  

16. For this exercise we will use 0+00 as the start station for this exercise.  

17. We will use 5+00 as the stop station.  

18. The Left Offset = -40 and the Right Offset = 100 for this exercise  

NOTE: Viewing the 2D model makes it clear that there is less room needed with the 
retaining wall and more room needed on the right side of the alignment for the slope. 

19. We will use an Interval of 50 for this exercise 

20. Create Drawing: When enabled, the process to create the cross-section sheets is 
automatically started after the named boundaries are created. When disabled, the named 
boundaries are created but the sheets are not created. 

Optional: Show Dialog – when enabled, a dialog with additional parameters set by the 
Drawing Seed is shown. 
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21. Data Point in a blank area once the Named Boundaries dialog has been filled out as 
shown in the picture below 

 

22. Data point to progress to the next dialog. 
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23. In the Create Dialog set the Annotation Group, Add Sheets to the Cross Section 
Sheet Index, and select Open Model. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

22. Verify the the dialog is set up as above with the Sheet Index pointing to the Cross Section 
folder and then select OK to process. 
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23. Check in dgws. 

 

24. The Open Model option from the previous dialog when checked on will open a Cross-
Section drawing or Sheet Model after the processing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: In this example the tool opened the sheet model for the last cross-section.   
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25. When the Multi Model View is opened after processing the cross-section models there 
will be elements in the 2D view and shapes in the 3D view that represent the drawing and 
sheet model locations of the cross-sections.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: If the shapes do not show up, 
verify that the View Attribute > 

Constructions is turned on for each 
model view of the 2D and 3D models. 
Also, if the transparency to the shapes 

do not show, verify that the option 
View Attribute > Transparency 
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Viewing the Cross Section Drawing Models and the Sheet Models 

Cross-Sections are now created in individual MicroStation and sheet models. There are various 
ways to view and open these models but, in this exercise, we will use the Active View Groups 
tool that is located at the bottom left of the default MoDOT interface.   

26. Select the Set the Active View Group pull-down and navigate to 1+50 (Sheet View). 

 

27. Open the Sheet Index and verify that the Cross Section Models were added. 
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28. Open the Multi-Model view. 

   

Note: If there is no Multi-Model View select the Default 2D View and then select the F6 Key. 

 

Changing the Fill Slope: 
NOTE: The object of this part of the exercise is to change the fill slope on the 2 template drops 
within the Ramp 4 corridor located in the Corridors_Ramp-4_J5P3181.dgn file.  

29. Open the Roadway\data-8\Corridors_Ramp-4_J5P3181.dgn file. 

30. Select the Ramp 4 Pavement with Curb and Gutter template drop for the Ramp 4 
corridor, hover over the template drop and select Edit Template Drop from the heads-up 
tool.  

 

31. Open the Point Properties on point RT_Fill_Slope_1_B  
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32. Change the Slope Constraint value from -25% to -33.333% or -1:3 

 

33. Apply the change and close the Point Properties dialog. 

34. Close the Edit Template Drop dialog by selecting the Okay button 

35. Select the Ramp 4 Pavement with Shoulders template drop for the Ramp 4 corridor, 
hover over the template drop and select Edit Template Drop from the heads-up tool.  

36. Open the Point Properties on the following points RT_Fill_Slope_1_Mid, and 
RT_Fill_Slope_1_B 
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37. Change the Slope Constraint value from -25% to -33.33% or -1:3  

38. Apply the change and close the Point Properties dialog. 

39. Close the Edit Template Drop dialog by selecting the Okay button 

40. Reopen the Named_Boundary_ Ramp-4_XS_J5P3181.dgn saving and checking in the 
Corridors_J5P3181.dgn file when prompted. 

41. Open the 1+50 Drawing Model.  You will notice the slope does not have labels on it. 

a. Select the Remove Drawing Model Annotations option from the Model Annotation 
pull down. 

Note: You have to be in one of the Drawing Models to remove or add annotation. 
 

 

b. We will select Yes to All Drawing Models and Accept in a blank area of the screen. 

 

The annotation along with all grid lines will be removed from all the Drawing and Sheet 
Models. 

 

38.   Select the Annotate Drawing Model option from the Drawing Model Annotation pull 
down. 
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39. We will select Yes and Accept in a blank area of the screen to re-apply annotations to all 
the drawing and sheet models. 

40. This will open a heads-up display where we will navigate to the XS Grid w/o Grid in 
this example. 

 

 

41. Datapoint in a blank area to Accept the re-annotation on the model.  

 

 

End of Exercise 
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8.5 Group Exercise: Create Cut Fill Volumes Route 54 

The objective of this exercise is to show how to create a mesh surface for the cut and fill volumes 
and to calculate end area volume reports.  We will also learn how to create cross section models 
and label them with the end area volume quantities. 

The process of calculating for a single corridor or multiple corridors requires its own design file 
or the tool will calculate ALL corridors in the design file.  

Final Feature Definition (Design Stage in SS10)  

1. Open the Corrdiors_Route-54_J5P3181.dgn and verify that the Feature Definition is 
set to 1-Final x 1. This will ensure the most accurate earthwork quantities. 

 

Create an Earthwork File:  

Note:  In this step we are going to create a separate Route 54 Named Boundary File for 
Earthwork.  Typically the Designer would only calculate Earthwork in the Cross 
Section Named Boundary file.  We are not doing this because we feel it is easier to 
show how the tool works if we create a separate Named Boundary file for Cross 
Sections and then another for Earthwork. 

2. Within the Roadway\data-8 folder, create a new file named Named_Boundary_Route-
54_EAV_J5P3181.dgn  using the following seed file:  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 
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Attach the Coordinate System: 
3. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow  

Utilities Tab  Geographic Section. 

4. Select “From File” icon. 

 

 

 

 

 

 

5. Select the Terrain_J5P3181.dgn file in the data-8 folder. 

6. Verify the settings.  

 

 

 

 

 

Attach the Reference Files: 
7. Attach the following files as reference files” 

• Civil_Geometry_J5P3181.dgn 
• Corridors_Route-54_J5P3181.dgn 
• Terrain_J5P3181.dgn 

8. Change the Annotation Scale to 1”=50’ 

8. Make the Terrain_J5P3181.dgn the active surface 

9. In the Default model, select the F6 key to open the 3D model view  
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Create Named Boundaries: 
To run an Earthwork End Area Volume Calculation the User will need to have Cross Section 
Named Boundaries in place. 

9. Open  the Named Boundary tool by Right-Clicking and holding in a blank area of the 
Default 2D window (typically View #1) 

10. Select the Named Boundary  Cross Section Sheet 

11. For the Drawing Seeds select the XS Sheet – 20 Scale option (utilizing the widest XS 
section setting). 

12. Identify the Route-54 alignment 
• Start Location = Start of Alignment Route-54 
• Stop Location = End of Alignment Route-54 
• Left Offset =   -280 
• Right Offset =  280 
• The Interval =  100 

13. Check the Create Drawing and Show Dialog box, then left click in the 2D plan view to 
accept the settings. 
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14.  When the Create Drawing, dialog opens set the following settings: 
a. Change the Annotation Group to XS Annotation w/o Grid 
b. Uncheck Open Model 
c. Select the OK button to start the processing of cross-section models   

Note: This will create all the sheet models and drawing models but leave you in the Multi-
model mode (both 2D and 3D windows opened) if the Open Model box was checked, 
then the tool will take you to the last sheet model created and will need to navigate to the 
Multi-model view to continue the process. 
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Create Cut and Fill Volumes: 
This process will create a mesh surface for each of the cut and fill material for extracting of 
quantities. 

15. Within the OpenRoads Modeling Workflow select the Home Tab  Model Analysis 
and Reporting Section  Civil Analysis Tools  Create Cut Fill Volumes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

16. The dialog will open and will allow the user to specify a Cut and Fill Feature Definition, 
the MoDOT default values should be already be set. 

 

NOTE: Compute Unsuitable, Custom and Substrata use feature definitions assigned to the 
component in a template and will be discussed more in depth in MoDOT’s Road 2 
Class. 
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17. Accept (left mouse clicks) in a blank area through each of the default options. 

And accept one last time to accept the selection. 

 
 

NOTE: After processing, a blue colored mesh will represent cut and a red colored mesh 
will represent fill. 

 

 

 

 

 

 

 

 

 

 

 

 

Notes: - The process of Creating Cut Fill Volumes will run throughout the existing ground 
and proposed corridors entirely. Meaning that all corridors will be calculated in this 
process. Therefore, one single corridor per design file is recommended at this time. 

- Meshes are not dynamic.  If something changes in the design, then the old 
meshes need to be replaced with new meshes using the Create Cut Fill Volume 
tool. 
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End Area Volume reporting: 
18. Within the OpenRoads Modeling Workflow select the Home Tab  Model Analysis 

and Reporting Section  Civil Analysis Tools  End Area Volume Report tool. 

 

 

 

 

 

 

 

 

 

 

 

 

19. Choose the Route-54 for the Named Boundary Group. 

 

20. In the next prompt, the tool will ask the User to define a Volume Exception by selecting 
the start and stop cross section named boundaries. Once the Volume Exception is defined 
or if there is no Volume Exception, the User can just Reset (Right-Click) to complete and 
create the End Area Volume report. 

  

Note: This will bring up a report that has many other volume reports that are created.  The 
importance of this report is that it creates an XML that is attached to each of the 
cross-section shapes that will allow for annotation. 
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Changing the Format Options of the Report: 
21. Select the Tools option in the top left corner of the report and then select Format Options 

 

22. In the Format Options dialog change the following: 
a. Station  ss+ss.ss 
b. Cubic Units Check the Convert to Cubic Yards box 

NOTE: Then close the dialog.  In SS4 this dialog was dynamic meaning that if you 
changed a setting it would immediately change the report but in ORD it is not so 
closing the dialog enables the changes made. 
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Adding End Area Volume annotation to cross-sections: 

23. Open a Drawing Model. We will open 615+00 R2 for this example. 

24. Apply End Area Volume Annotation by opening the Annotate Drawing Model tool. 

 

25. The Annotate dialog will open and again we will choose Yes to annotate All Drawing 
Models by either the up/down arrows or checking the box in the dialog  

 

 

 

 

 

 

 

 

 

 

 

26. Next, choose the triple dot box to open the Annotation Group pick list. 

27. Navigate by opening the Cross-Section folder.  

28. Open the Drawing folder to see the options for annotation 

29. First use the annotation group XS Annotation with Grid and then XS EAV Annotation. 
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30. Accept through the heads-up prompts to get the End Area Volume cell to be placed in the 
top right corner of the drawing model 
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31. Compare the report to the information in the earthwork cell 
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8.6 Individual Exercise: Create Cut Fill Volumes Ramp 4 

Final Feature definition (Design Stage SS4)  

1. Open the Corridors_Ramp-4_J5P3181.dgn and verify that the Feature Definition is set 
to 1-Final x 1. This will ensure the most accurate earthwork quantities. 

 

 

 

Create an Earthwork File:  

2. Within the Roadway\data-8 folder, create a new file named Named_Boundary_Ramp-
4 _EAV_J5P3181.dgn  using the following seed file:  

                    MoDOT_Roadway_Seed_2D.dgn seed file. 

Attach the Coordinate System: 

3. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow  
Utilities Tab  Geographic Section. 

4. Select “From File” icon. 

 

 

 

 

 

 

5. Select the Terrain_J5P3181.dgn file in the data-8 folder. 

6. Verify the settings.  
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Attach the Reference Files: 
7. Attach the following files as reference files” 

• Civil_Geometry_J5P3181.dgn 
• Corridors_Ramp-4_J5P3181.dgn 
• Terrain_J5P3181.dgn 

8. Change the Annotation Scale to 1”=50’ 

9. Make the Terrain_J5P3181.dgn the active surface 

10. In the Default model, select the F6 button to open the 3D model view  

Create Named Boundaries: 

11. From the Drawing Production tab select the Place Named Boundary tool 

12. Select the Civil Cross Section icon 

13. Select the D Size XS Sheet – 5 Scale option 

14. Identify the Ramp-4 alignment. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Start Location = beginning of alignment Ramp-4 
• Stop Location = 5+00 
• Left Offset =  -40 
• Right Offset =  100 
• The Interval =  50 
• Create Drawing = Check 
• Show Dialog = Check 
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15. Create Drawing dialog opens: 
a. Change the Annotation Group to XS Annotation w/o Grid 
b. Uncheck Open Model 
c. Select the OK button to start the processing of cross-section models 

 

Create Cut and Fill Volumes: 
This process will create a mesh surface for each of the cut and fill material for extracting of 
quantities. 

16. Select the Home tab 
17. Select the Civil Analysis pull down 
18. Select Create Cut Fill Volumes 
19. The dialog will open and will allow the user to specify a Cut and Fill Feature definition, 

the MoDOT default values should be already be set. 
20. Accept (left mouse clicks) in a blank area through each of the default options 

 

End Area Volume reporting: 
21. Open the End Area Volume Report tool:  

Home Tab  Civil Analysis  End Area Volume Report 

22. Choose the Ramp-4 Named Boundary option. 
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Changing the Format Options of the Report: 
23. Select the Tools option in the top left corner of the report and then select Format Options 

24. In the Format Options dialog change the following: 
a. Angular ddd^mm’ss 
b. Station  ss+ss.ss 
c. Cubic Units Check the Convert to Cubic Yards box 
d. Direction  ddd^mm’ss 
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Adding End Area Volume annotation to cross-sections: 
25. Open a drawing model. We will open 2+00 for this example. 

26. Apply an annotation by opening the Annotate Drawing Model tool. 

 

 

 

 

 

27. The Annotate dialog will open and we will choose “Yes” to annotate “All Drawing 
Models” by either the up/down arrows or checking the box in the dialog 

28. Next, choose the triple dot box to open the Annotation Group pick list 

29. Navigate by opening the Cross-Section Drawing folder.  

30. Select XS EAV Annotation  

31. Accept through the heads-up prompts to get the End Area Volume cell to be placed in the 
top right corner of the drawing model. 
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32. Compare the report to the information in the earthwork cell 
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PLAN SHEET CREATION HELP DOCUMENATION: 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-
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9.1 Exercise #1 (Group) Full Plan Sheets  

1. Create a new folder within data-9 called Plan_Sheets 

2. Within the data-9 folder open the Civil_Geometry_J5P3181.dgn 

3. Create a new file named: 

Named_Boundary_Full-Plan_Route-54_J5P3181.dgn  

using the: 

              MoDOT_Roadway_Seed_2D.dgn seed file. 

4. Open the Coordinate System tool by selecting the OpenRoads Modeling Workflow  
Utilities Tab  Geographic Section. 

5. Select “From File” icon. 

 

 

 

 

 

6. Select the Terrain_J5P3181.dgn file in the data-9 folder. 

7. Verify the settings.  

 

 

 

 

 

8. Reference in the following file: 

• Civil_Geometry_J5P3181.dgn 
• Corridors_ Route-54_J5P3181.dgn 
• Corridors_Ramp-4_J5P3181.dgn 
• Land_Boundary_J5P3181.dgn 

9. Change the Annotation Scale to 1” = 50’ 

10. MicroStation Fit View to the project location. 
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11. Turn on/off levels as desired before processing the plan sheets.  

12. In View Attributes, verify that the toggle is ON for Constructions. 

  

13. From OpenRoads Modeling workflow, select the Drawing Production tab and then 
select the Named Boundary tool.  

 

 

14. Select the Civil Plan method 

15. Select a Drawing Seed file 

16. Select a Detail Scale 

17. Select the alignment or baseline 
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18. In the Place Named Boundary dialog, change the options as desired to produce the 
clipping shapes for the plan sheets. 

• For class purposes, fill out as shown below. 

 
 

a) Clipping shape options - set to Civil Plan. 
b) Drawing Seed - select Design - D Size Full Plan 
c) Detail Scale – 50’ 
d) Name – defined by picking the alignment or user defined 
e) Start Location & Stop Location - can be typed in or dynamically placed in 

the dgn file  
f) Overlap – adds additional overlap area to Named Boundaries = 0 
g) Boundary Chords - set to 1 
h) Create Drawing - toggle ON (Off will mandate the use of the Named 

Boundary Manager to process sheets)  
i) Show Dialog – toggle ON (Off will require going through the Create Drawing 

tool again as there are important settings that need to be utilized) 
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Note: Length, Left Offset and Right Offset options should not be adjusted after selecting 
the desired scale. Adjusting these will produce undesirable results on the final cut 
plan sheet. 

19. Once the Named Boundary dialog is filled out, you can now start the process to create 
the clipping shapes for the full plan sheets. 

(Optional) Select the alignment to place the clipping shapes along.  

 

20. Select the start location. 

Move along the alignment and left click once you have the desired number of clipping 
shapes created.  

Left click again in a blank area to accept the clipping shapes. 
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Note: The Start Location and Stop Location can also be typed in the Place Boundary 
dialog if desired. 

21. (Optional) Move the shapes as needed to get the correct area for the clipping shape.     

Note: Currently, the clipping shapes will not dynamically follow along the alignment.  
Also not supported is the ability to move the preceding and following clipping shapes 
when moving a clipping shape.  

22. Now that the clipping shapes are created, you can now start the process to create the plan 
sheet files by left clicking one last time to bring up the Create Drawing dialog box. 

23. In the Create Drawing dialog, change the options as desired to produce the plan sheets. 

• For class purposes, fill out the dialog exactly like the dialog below. 
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a) Name – Route-54_J5P3181_Plan_01 

• Sheets will need to be named to conform to the “file naming 
convention” for contract plans 

b) One Sheet Per Dgn - toggle ON and set location 
c) Folder – Allows the user to navigate to the Plan_Sheets folder to store the 

created plan sheets 
d) Annotation Scale (Drawing Model) - select the same scale as from the Place 

Named Boundary dialog 50 
e) Annotation Group - Allows the placement of match lines & a north arrow 
f) Detail Scale - same scale the Drawing Model annotation scale 50 

24. Select OK to create the sheet.  This will create separate sheet files in the location that you 
selected in the dialog box. 

25. After the sheets are created, select Update Server Copy on the “Check In” dialog box. 

 

26. In the next “Check In” dialog box, select the Check In option. 
 

 

 

 

 

 

 

 



OpenRoads Designer Road 1  Chapter 9 – Plan Sheet Production  
 

1/26/23 Missouri Department of Transportation 9-7 

27. Open the sheet files and review. 

In the Models tool, you will see that it creates a drawing model and a sheet model. 

 
The Drawing model is designed to add geometry like text, notes, dimensions, extra 
reference files, etc. to the file. The drawing model is still a 1:1 scale, so everything is the 
same scale as from the file that you cut the sheets from.   

 

The Sheet model takes what is in the Drawing model and scales it down to fit the border 
that is in the Sheet Model.  Adding geometry (except for the text that is needed for the 
border information) to the sheet model is not recommended or supported by CADD 
Support. 

 

End of Exercise 
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9.2 Exercise #2 (Group): Full Profile Sheets (Route 54) 

1. Create a new 2D file named Named_Boundary_Full_Profile_Route-54_J5P3181.dgn 
from the Civil_Geometry_J5P3181.dgn file located in the data-9 folder. 

2. From the OpenRoads Modeling workflow, Utilities tab, select the Coordinate System 
tool. Set the GCS to: NAD83 Missouri State Planes, Central Zone, US Foot using the From 
File or From Library option. 

3. Reference in the Civil_Geometry_J5P3181.dgn and Terrain_J5P3181.   

4. Turn on/off levels as desired before processing the plan sheets. (This will keep you from 
needing to open each created plan sheet to turn off unwanted levels.) 

5. In View Attributes, verify that the toggle is ON for Constructions. 

6. We will need to open a view/window (View 8) to place the profile into to create the Profile 
sheets. 

7. In the plan view (View 1), select the desired alignment (Route 54) that has a profile 
assigned to it. From the heads-up tools, select the Open Profile Model option. 

Select the bottom view (View 8) to apply the profile model in that view. 

 

 

8. From OpenRoads Modeling workflow, select the Drawing Production tab and then 
select the Named Boundary tool.  
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9. In the Place Named Boundary dialog, change the options as desired to produce the 
clipping shapes for the full profile sheets. 

• For class purposes, fill out the dialog exactly like the dialog below. 

 
a) Clipping shape options - set to Civil Profile.  
b) Drawing Seed - select Design - D Size Full Profile 
c) Detail Scale – 1” = 50 scale for the clipping shapes 
d) Name – Route 54 Proposed or user defined 
e) Method - set option as Station  

• Station Limits - option will allow you to dynamically place the 
clipping shapes along the proposed profile. This will also use the Start 
Location & Stop Location if they are locked.   
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• From Plan Group - option will place the profile clipping shapes at the 
exact same location as the plan clipping shapes. 

f) Start Location & Stop Location – Beginning station or can be typed in and 
locked to get exact station limits for the profile sheets 

g) Vertical Exaggeration - set to appropriate scale 

• 2 – 20 Scale 

• 5 – 50 scale (for this exercise) 

• 10 – 100 scale 

• 20 – 200 scale 
h) Create Drawing - toggle ON 
i) Show Dialog – toggle ON 

Note: Length through Profile Shifts options should not be adjusted after selecting the 
desired scale. Adjusting these will produce undesirable results on the final cut 
profile sheets. 

 

10. Once the Named Boundary dialog is completely filled out, you can now start the process 
to create the clipping shapes for the full profile sheets. 

Select the profile to place the clipping shapes along.  
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11. Select the start location by moving the mouse left or right along the profile.  

• Optional – Start Location and Stop Location can be typed in and locked to lock in the 
exact station limits for the profile clipping shapes 

Move along the alignment and left click once you have the desired number of clipping 
shapes created.  

Left click again in a blank area to accept the clipping shapes. 

 

 

12. (Optional) Move the shapes as needed to get the correct area for the clipping shape.  

The Adjust Profile Name Boundary tool will allow you to adjust the clipping shape 
VERTICALLY while keeping clipping shape locked in horizontally.  

 

 

 

Note: Currently, the clipping shapes will not dynamically follow along the alignment 
and there is no option to move the preceding and following clipping shapes along with 
the clipping shape being moved.  

When placing the profile clipping shapes using the From Plan Group method, there is no 
option to lock the profile clipping shapes with the plan clipping shapes.  So, if you move 
the plan clipping shape, the profile shape will not follow along with it. 
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13. Now that the profile clipping shapes are created, you can now start the process of creating 
the full profile sheet files by left clicking one final time to advance to the Create 
Drawing dialog box. 

14. In the Create Drawing dialog, change the options as desired to produce the full profile 
sheets. 

• For class purposes, fill out the dialog exactly like the dialog below. 
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a) Name – Route-54_J5P3181_Profile_01 

• Sheets will need to be renamed to conform to the “file naming 
convention” for contract plans 

b) One Sheet Per Dgn - toggle ON and set location 
c) Annotation Scale (Drawing Model) – 1 “ = 50’ select the same scale as from 

the Place Named Boundary dialog 
d) Annotation Group - Profile Grid – 50 Scale set to same scale the Drawing 

Model annotation scale 
e) Detail Scale – 1” = 50’ (By Named Boundary) same scale the Drawing 

Model annotation scale 

15. Select OK to create the sheets.  This will create separate sheet files in the location that 
you selected in the dialog box. 

16. After the sheets are created, select Update Server Copy on the “Check In” dialog box. 

  

 

17. In the next “Check In” dialog box, select the Check In option. 
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18. Open the sheet files and review. 

In the Models tool, you will see that it creates a drawing model and a sheet model. 

 
The Drawing model is designed to add geometry like text, notes, dimensions, extra 
reference files, etc. to the file. The drawing model is still a 1:1 scale, so everything is the 
same scale as from the file that you cut the sheets from.   
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The Sheet model basically takes what is in the Drawing model and scales it down to fit 
the border that is in the Sheet Model.   

NOTE: Adding geometry (except for the text that is needed for the border 
information) to the sheet model is not recommended or supported by CADD 
Support. 
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End of Exercise 
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9.3 Exercise #3 (Group): Plan-Profile Sheets (Route 54) 

1. Create a new 2D file named Named_Boundary_Plan-Profile_Route-54_J5P3181.dgn 
from the Civil_Geometry_J5P3181.dgn file located in the data-9 folder. 

2. From the OpenRoads Modeling workflow, Utilities tab, select the Coordinate System 
tool. Set the GCS to: NAD83 Missouri State Planes, Central Zone, US Foot using the From 
File or From Library option. 

3. Reference in the following files: 

• Civil_Geometry_J5P3181.dgn 
• Corridors_ Route-54_J5P3181.dgn 
• Corridors_ Ramp-4_J5P3181.dgn 
• Land_Boundary_J5P3181.dgn 
• Terrain_J5P3181.dgn (make active) 
 

4. Turn on/off levels as desired before processing the plan sheets. (This will keep you from 
needing to open each created plan sheet to turn off unwanted levels.) 

 

Creating the Plan portion of the Plan/Profile Sheets 

 

5. In the Place Named Boundary dialog, change the options as desired to produce the 
clipping shapes for the plan view of the plan-profile sheets. 

• For class purposes, fill out the dialog exactly like the dialog below. 
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a) Clipping shape options - set to Civil Plan. 
b) Drawing Seed - select Design – Plan-Profile – Plan 
c) Detail Scale – 1” = 50’ 
d) Name - user defined 
e) Start Location & Stop Location - can be typed in or dynamically placed in 

the dgn file  
f) Overlap - adjust as needed to get additional area 0 
g) Boundary Chords - set to 1 
h) Create Drawing - toggle OFF 
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i) Show Dialog – toggle Ghosted out 
Note: Length, Left Offset and Right Offset options should not be adjusted after selecting 

the desired scale. Adjusting these will produce undesirable results on the final cut 
plan sheet. 

6. Once the Named Boundary dialog is completely filled out, you can now start the process 
to create the plan view clipping shapes for the plan-profile sheets. 

Select the alignment to place the clipping shapes along.  

 

7. Select the start location. 

Move along the alignment and left click once you have the desired number of clipping 
shapes created.  

Left click again in a blank area to accept the clipping shapes. 

 

Note: The Start Location and Stop Location can also be typed in the Place Boundary 
dialog if desired. 
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Note: Currently, the clipping shapes will not dynamically follow along the alignment.  
Also not supported is the ability to move the preceding and following clipping shapes 
when moving a clipping shape.  

Creating the Profile portion of the Plan/Profile Sheets 

8. In the plan view (View 1), select the desired alignment (Route 54) that has a profile 
assigned to it.  From the heads-up tools, select the Open Profile Model option. 

9. Then select the view (View 8) to apply the profile model in that view. 

 

10. Now create the Profile view clipping shapes. 

In the Place Named Boundary dialog, change the options as desired to produce the 
clipping shapes for the full profile sheets. 

• For class purposes, fill out the dialog exactly like the dialog below. 
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a) Clipping shape options - set to Civil Profile.  
b) Drawing Seed - select Design - D Size PlanProfile – Profile View 
c) Detail Scale - select the same scale from the plan clipping shapes = 1” = 50’ 
d) Name - user defined 
e) Method - set option as desired = From Plan Group 

• Station Limits - option will allow you to dynamically place the 
clipping shapes along the proposed profile. This will also use the Start 
Location & Stop Location if they are locked.   

• From Plan Group - option will place the profile clipping shapes at the 
exact same location as the plan clipping shapes. 
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f) Start Location & Stop Location - can be typed in and locked to get exact 
station limits for the profile sheets 

g) Vertical Exaggeration - set to appropriate scale 

• 2 – 20 Scale 

• 5 – 50 scale 

• 10 – 100 scale 

• 20 – 200 scale 
h) Create Drawing - toggle OFF 
i) Show Dialog – toggle Ghosted out 

 
Note: Length through Profile Shifts options should not be adjusted after selecting the 

desired scale. Adjusting these will produce undesirable results on the final cut 
profile sheets. 

11. Once the Named Boundary dialog is completely filled out, you can now start the process 
to create the profile view clipping shapes for the plan-profile sheets. 

Select the profile to place the clipping shapes along.  

 

 

 

 

Left click again in a blank area to accept the clipping shapes. 
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12. (Optional) Use the Adjust Profile Name Boundary tool to vertically move the profile 
clipping shapes as needed while keeping clipping shape locked in horizontally. 

 

 

Note: Currently, the clipping shapes will not dynamically follow along the alignment 
and there is no option to move the preceding and following clipping shapes along with 
the clipping shape being moved.  

When placing the profile clipping shapes using the From Plan Group method, there is no 
option to lock the profile clipping shapes with the plan clipping shapes.  So if you move 
the plan clipping shape, the profile shape will not follow along with it. 
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13. Open the Named Boundary Manager to process the Plan/Profile sheets. 

 

14. Open and select either the Plan Group or the Profile group for Route 54.  

15. Check on Show the Create Drawing Dialog  

16. Select the Create Plan/Profile Drawing. 

 

 

 

17. In the Create Drawing dialog, change the options as desired to produce the plan-profile 
sheets. 

• For class purposes, fill out the dialog exactly like the dialog below. 

• Left side options are for the Plan view clipping shape (top section of the sheet) 

• Right side options are for the Profile view clipping shape (bottom section of the 
sheet) 
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a) Mode - set to Plan and Profile 
b) Name - Route-54_PlanProfile_J5p3181_01 

• Sheets will need to be named to conform to the “file naming 
convention” for contract plans 

c) One Sheet Per Dgn - toggle ON  
d) Folder – Path to the data_9 > Plan_Sheets folder 
e) Annotation Scale (Drawing Model) (Both Sides) - select the same scale as 

from the Place Named Boundary dialog = 50 
f) Annotation Group (Lt. Side only) - set to Plan Annotation 
g) Annotation Group (Rt. Side only) - set to same scale as Drawing Model 

annotation scale = Profile Grid – 50 Scale 
h) Detail Scale (Both sides) - same scale the Drawing Model annotation scale 

(By Named Boundary) 

18. Select OK to create the sheet.  This will create separate sheet files in the location that you 
selected in the dialog box. 

19. After the sheets are created, select Update Server Copy on the “Check In” dialog box. 
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20. In the next “Check In” dialog box, select the Check In option. 

 

This will open the last sheet file created.   

In the Models tool, you will see that it creates a plan drawing model, profile drawing 
model and a sheet model. 
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The Drawing model is designed to add geometry like text, notes, dimensions, extra 
reference files, etc. to the file. The drawing model is still a 1:1 scale, so everything is the 
same scale as from the file that you cut the sheets from.   

 

 

 

The Sheet model basically takes what is in the Drawing models and scales it down to fit 
the border that is in the Sheet Model.  Adding geometry (except for the text that is needed 
for the border information) to the sheet model is not recommended or supported by 
CADD Support. 
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End of Exercise 
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9.4 Exercise #5 (Group): Editing Plan-Profile Sheets (Route 54) 

1. Open the Route-54_ Plan-Profile_J5p3181_02.dgn file from the data-09/Plan_Sheets 
folder 
 

2. Open the Drawing Model (the drawing model is where the plan sheets should be edited) 

 
 

Moving text in reference files: 
 

3. Open the Reference Dialog, Identify the reference of the text/geometry 
 

 
 

4. In the Reference Dialog, Select the Civil Geometry file, right click and choose the option 
to Exchange. This will open the Civil Geometry file up at the location that you are 
zoomed to. (Check in the previous file after you select Exchange) 
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5. Verify that the Graphic Group Lock is toggled on so when we grab the text the whole text 
cell moves as on. Hover over the icon (located at the bottom right of the MicroStation 
Window) and it will show all the locks that are currently being utilized.  

 
 

(Optional) If the Graphic Group is not on, select the pad lock icon and then select the 
Graphic Group icon 

 
 

6. Reference in the Corridors files for Route 54 and Ramp 4 for reference locations of 
geometry and text. 
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7. Moving the Text cell: 
a) Select the Text cell (In this case the curve data) 
b) Left click and hold the button down to drag the cell to a location where it won’t 

interfere with other geometry or text. 
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8. Open the Route-54_ Plan-Profile_J5p3181_02.dgn file from the data-09/Plan_Sheets 
folder. Once opened you will see that the text cell has been moved. 

 

Adding a North Arrow using the MicroStation AccuDraw Tool  
9. Verify that the Drawing scale is set to 1” = 50’ 

 

 
 

10. Activate the MicroStation AccuDraw tool by selecting it from the Quick Menu or 
through any of the other ways you may prefer. 
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11. Navigate to the North Arrow cell by changing the Workflow to MoDOT CADD 
Detailing Standards 

 

 
 

12. Select the Design tab.  Select the Graphic Scales button to open the pull down Select 
the North Arrow. 

 
13. Once the North Arrow has been selected it may be displaying straight up and not as “true 

north” of the project 

 
14. Select the AccuDraw banner of the dialog.  Type the letter T to change the direction of 

the North Arrow to the project’s True North.  Type the letter V to change the direction 
to the view’s North.  
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Place the North Arrow by data pointing (left mouse click) in a clean unused area within 
the white border of the Drawing Model shape. 

 
NOTE: Clean and organized plan sheets are the desired look so avoid placing elements, 

cells, and text over other each other when at all possible. 
15. Adding a Graphic Scale to your plan sheet: 

a) From the MoDOT CADD Detailing Workflow, select the Design tab,  
b) Select Graphic Scales – Patterns – North Arrow button on the ribbon,  
c) Select the Graphic Scale 1” = 50’ 

 
d) Data point the desired location to place the Graphic scale cell, 
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e) Right click to reset the tool 

 

Masking items from the plan sheet 
16. To remove/mask items from a reference file as in any elements follow the next few 

steps:  
a) Open the Sheet Model 
b) Change the Workflow back to OpenRoads Modeling 
c) Select the Drawing tab 
d) Select the Fence tools 
e) Change Fence Type to Block or Shape  
f) Create a block or shape around the stationing to be masked  
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g) Open the Reference dialog 
h) Open the Hierarchy Tree 
i) Select the + (plus sign) to open the Drawing Model reference 
j) Right click on the Drawing Model reference 
k) Select the Clip Mask option 

 
l) Accept (Left click in a blank area) 
m) Accept in a blank area again to drop the fence (or hit F 4 on the keyboard) 
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n) This process will mask out the unwanted station from another alignment that is not 

needed to be shown in this set of plan sheets. 

 
 
NOTE: the goal is to produce clean plan sheets using the MoDOT standards.  Avoid 
placing notes, leaders, cells, linear elements over any other items to achieve clean and 
readable plan sheets. 

 
 

 
 

 

End of Exercise 
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10.1 Objectives 

The purpose of this chapter is to show the user how to use the multiple tools to place 
pavement markings including symbols, stop bars, centerlines, edge lines and more.  

• Point Tools to Place Symbols such as Left Turn, Stop Lines, etc.  

• Linear Pavement Marking through Standard Templates 

• Linear Pavement Markings through custom Template points 

• Linear Pavement Marking through Horizontal and Vertical Geometry Tools 

• Reports for Pavement Marking (Points and Linear) 

10.2 Point Symbols – Typical Pavement Markings 

Pavement Marking symbols are MicroStation Cells that can be placed on Civil Points and 
given elevation.  The elevation will create the Cell and place it in the 3D model.  This is 
possible in ORD with new elevation options which will be described in this section. 

10.2.1 Placing Pavement Markings 
To place a standard MoDOT Pavement Marking, utilizing the Civil Geometry Point tool: 

1. Open the Tab Geometry from the Ribbon 

2. Select the Point tool 

 

3. The Point dialog box opens.  The Feature Definition area allows for the selection of a 
pavement marking.  Click the down arrow next to Feature Definition. 

4. The Pavement Marking cells are located under: 

• Point 

o Design 

 Design Standards 

• Pavement Markings 

Select a Pavement Marking (Ex. Left Turn Arrow) 
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5. Once Selected, Choose the Elevation Mode.  To allow for a Pavement Marking to show 
on the corridor’s 3D surface, select Plan Element. 

 

6. Choose a Plan element such as the Baseline or Centerline.  Place a positive number in 
the Elevation Offset to make sure the Pavement Marking is above the corridor surface. 
For example, Ramp 4 alignment elevation and 6” above that elevation. 

 (if known, you can enter the Value of the Elevation by choosing Value for your Elevation 
Mode and keying in the elevation.) 
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7. Next, select a Rotation for the cell.  None, Absolute Value, or Relative to alignment.  If 
Relative to Alignment is chosen, then select a Reference Rotation Alignment. For 
example, Ramp 4. 

 

8. Move out on to the drawing screen.  The prompt will read Enter Offset. This will be the 
vertical offset from the alignment elevation.  If you have keyed in the elevation offset in 
the dialog, you can accept that value with a Left Click.  If you did not fill it out in the 
dialog, this is where you can key in the value (example: 0.5) and Enter. 

 

9. Next Enter Data Point.  At this prompt you can place your cell in the drawing.  This can 
be placed using Civil Accudraw with station and offset, or just by Left Clicking a 
location. Left Click to place. (Cell can be moved later as well). 

10. After the location is given, the prompt will move to Select Rotation. This can be a 
dynamic rotation by moving the mouse, or Key In a specific rotation.  Since this example 
is based on Ramp 4 centerline, the cell can be placed perpendicular to the alignment by 
keying in N90E and hitting Enter. 

 

11. Accept the value with a Left Click. 
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10.2.2 Modifying Pavement Marking Points 
There are several methods for modifying a point after it has been placed. 

• Using the Element Section to select the point and move to a new location. 

• Select the point and open the Properties Dialog and make any changes. 

• Use the Modify Points tool in the Geometry > Horizontal > Points tools. 

By the Element Properties dialog 

1. Locate the point to be modified. 

2. Select the point (Pavement Marking) with the Element Selection tool. 

3. Open the Properties dialog.  (it may already be docked on the left of the screen)  

4. In the Properties dialog, modify any field to the desired result. For example, change the 
cell being used, the scale, the feature name or feature definition or rotation and elevation. 
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The ORD tool Modify Point is under the Geometry Tab > Horizontal > Points > Modify 
Point.  This tool is used to change elevation and rotation of a point.  

1. Open the Modify Point tool    

2. Choose options to change in the dialog 

 

3. Accept the dialog settings with a series Left Clicks on the screen 

4. Select the Pavement Marking to modify 

 

5. Reset (Right Click) to finish. 
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10.2.3 Pavement Marking Symbols Report 
There are a number of reports that may be used for gathering information from pavement 
marking symbols that have been placed with he Civil Points method described in this chapter. 
Perhaps the most common report is the Point Feature Station Offset Elevation Report for those 
that are looking for location based on alignment.  The Horizontal Point Report works as well 
and gives an X,Y,Z format. 

 

1. From the Geometry Tab > Reports choose Point Feature Station Offset Elevation 
Report 

2. Using this report requires a baseline. At the Locate Baseline Element, choose the 
alignment to base the information on. For example, Ramp 4. 

3. Then at the Locate Offset Element, select each of the Pavement Markings you wish to 
have displayed in the report. They will all show station and offset from that alignment. 

4. Reset (Right Click) when finished. 

The Report will load with the information.  This can be saved off in PDF or Execl. 
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10.3 Linear Pavement Marking through Standard Templates 

ORD offers a component that will draw EOP, CL and other Linear Pavement Markings, by 
adding the component to the roadway section template.  By adding the component to the 
template and applying the correct Feature Definition, linear Pavement Markings will draw 
automatically.  These Feature Definitions can be changed at any time to accommodate 
changes in striping for a given area.  This section explains the Pavement Marking templates 
that are supplied in the MODOT.ITL for use with MODOT Standard Templates.  

10.3.1 Pavement Marking Templates 
Templates have been set up with MODOT Pavement Marking Features to match the points in 
a Standard MODOT Template for 1, 2 and 4 lane pavements.  These work with asphalt or 
concrete pavements. 

In the MODOT.ITL Locate the Pavement Markings folder. 

 
Each component in the Template is assigned an XS_PM feature that is tied to a 2D and 3D 
Linear element.  They are set to draw in the plan view.  Each point is tied to an EOP or CL 
point that is defined in the other MODOT Standard Templates.  The next section will discuss 
how to use these Templates. 
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These Templates can be Drag and Dropped onto the CL point of existing Templates.  Then EOP 
points can be merged.  When the EOP points are merged, the Pavement Marking components 
automatically change the parent points to the existing EOP points that remain after the merge. 
 

10.3.2 Assigning Pavement Markings to Corridor Templates 
Pavement Marking Templates are meant to be placed on an existing Corridor Template.  They can 
be placed on your Template Library Project Templates or in the DGN Templates in-use by the 
corridor.  The Pavement Markings are drawn in the Plan view on specific levels for Pavement 
Markings, so they can appear in sheets that you need them to show.  This example will show how 
to add Pavement Markings to the Templates already in use in the DGN. 
1. Open the Template that is to receive Pavement Markings, either from the DGN or in the 

Template Library.  For this example, we will do this in the Template Library.   

 
2. In the Template Library, locate the Template to be updated and open it in the Template 

Editor window on the right. For this example: “J5P3181 Asphalt Pavement 2 Lane w/ Agg 
Base Concrete Shoulder” 



ORD Road 1           Chapter 10 – Pavement Markings  
 

9/6/22 Missouri Department of Transportation 10-9 

3. Locate and expand the Pavement Markings folder in the Library List. 
4. Open the folder 2 Lane 
5. Select (One Left Click) on 6” White Edge Lines – Double Yellow Center Line 

 
6. This will place it in the Preview Window.  Notice the Green Point in the Preview Window. 

This is the point that will match up to the Green Point in the open template. 
7. Drag the 6” White Edge Lines – Double Yellow Center Line to the Green Point 

(AsphSurf_T_CL) and let go. 
8. On a Standard MoDOT Template the EOP points may automatically merge, causing the RT 

and LT Pavement Markings to be based on the EOP points in the existing Template. 
 
Note:  You may have to Merge the EOP points, removing the ones that come from the PM 
Template.  This can happen when points do not have the same name as the PM template.   If 
lanes are greater or less than the standard 12’, it may be necessary to remove the constraints from 
the newly placed EOP’s, Move the points to the EOP’s in the current Template, then Merge. 
 

 
 

10.4 Custom Pavement Marking Templates 

Using ORD Template Components, you can make your own Linear Pavement Markings 
through the Corridor Templates.  This section will discuss how to set up the component to 
have the template place 2D and 3D Pavement Markings in a modified or non-standard 
Corridor Template. 
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10.4.1 Adding the Pavement Markings to a Corridor Template 
These are the steps to add Pavement Markings to a Template in the Template Library for use in a 
new corridor or when synchronizing a template that resides in the DGN or directly modifying a 
Template in-use in the DGN. 
1. Modifying a Template using the Edit Template Drop 

 
2. In the Template Editor, Right-Click and Select Add New Component 
3. Choose Circle from the list of options 

 
4. Left-Click a Center of Circle Location 
5. Left-Click on the same location for a 0 Radius Circle 

 
6. Double Left-click on the new point to open the point dialog properties 
7. Name this the Pavement Marking Type, for this Example – LT_6in_Solid 
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8. Add constraints to the new point.  Example, a Horizontal from the CL of -1.5 and a Vertical 

of 0.1 from the CL. 

 
9. Apply and Close 
10. Click OK to the Template Drop Editor 
11. Notice the new Pavement Marking on the Corridor for the added point 
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10.5 Civil Geometry Pavement Markings 

Pavement Markings may be drawn using the various Civil Geometry tools, such as, Complex 
Element and Line Between Points.  Civil Offset tools may be used to offset the EOS inside 1 
foot to show a 6” White Pavement Edge for example. 
To create Pavement Markings with this method, simply set the active Feature Definition to a 
Pavement Marking of your choice and draw the line work.  Stations may be given to the lines 
as well for reporting purposes. 

10.5.1 Adding the Pavement Markings By Civil Geometry 
These are the steps to add Pavement Markings to a Corridor by Civil Geometry. 

1. Set the Feature Definition to the desired Pavement Marking.  For example Linear > Design 
> Pavement Marking > Single Solid > Pavt Marking 6” Yellow Solid 

2. Set it Active 

 
3. With the Feature Definition active, you can choose any Horizontal Geometry Tool to create 

the Pavement Marking.  For example, choose Geometry > Horizontal > Complex by PI 
4. Create a Horizontal Element 

 
5. This will show in the 2D view for Pavement Markings. If you wish for it to also appear in the 

3D view on the Corridor, you may apply a profile based on the corridor surface Plus a .5 
Elevation Difference. 
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a. Open the Profile Model in View 8 for the Pavement Marking 
b. Make sure the 3D model of the corridor can be viewed. Either F6, or have the 3D 

model on in the 2D view.  For this example, we will use the 3D Model Default-3D. 
c. From the Geometry > Vertical ribbon, choose the Profile Creation > Profile From 

Surface 

 
d. Set the dialog up to profile the entire element with a Vertical Offset of 0.5 as shown 

in the image.  You may also give it a name for the profile. 

 
e. Locate First Element to Profile:  Select the Horizontal Pavement Marking 
f. Right-Click in a blank area to reset 
g. Locate Reference Surface by choosing the pavement from the 3D model. 

 
h. Right-Click in a blank area to reset 
i. Lock to start and end as shown in the dialog and accept the remaining prompts by 

Left-Clicking on the screen. 



Chapter 10 – Pavement Markings  ORD Road 1  
 

10-14 Missouri Department of Transportation 9/6/22 

j. Horizontal Offset of 0 when prompted and Enter (you could also lock this at 0 in the 
dialog) 

k. Take a look at the 3D model and the Pavement Marking should now appear over the 
Corridor. 

 

10.5.2 Adding Start Station to Pavement Markings 
If the stationing needs to be something other than 0+00 for the start of a pavement marking, you 
can use the Start Station tool to set the stationing.  
1. From Geometry > Horizontal > Modify choose Start Station 
2. Select the Pavement Marking to station 
3. Move the mouse to the desired location to add the stationing and Left-Click 
4. Key in the new station 
5. Reporting will now use the new stationing for the Pavement Marking. 
 

10.6 Pavement Marking Reports 

Pavement Markings may be Linear or Point markings for the various reports to work.  There are 
reports for each type.  Some are MoDOT created reports, others can use the built in Bentley 
reports.   

10.6.1 Point Pavement Marking Reports 
Point Markings are pavement markings such as turn arrows, lane drops, straight arrows, etc.  they 
are placed using the Civil Point Placement tools.  The Feature Definitions of these points allows 
them to be reported on using the Civil Reports. 
1. From the Geometry > General Tools ribbon, expand Reports and select Point Feature 

Station Offset Elevation Report 
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2. Locate Baseline Element:  This is what the report will use for station and offset of the 

pavement marking.  In this example, Ramp 4. 

 
3. Next, Locate Offset Element, will be each of the Pavement Marking Points to be included in 

the report.  Select each Pavement Marking Point. 

 
4. When finished selecting items, Right-Click in a blank area. 
5. The report will display with the standard Bentley Report. 
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10.6.2 Linear Pavement Marking Reports 
Linear Markings are pavement markings such as Edge of Pavement, dashed or solid centerlines, 
double centerlines etc.  These lines can be reported on as well.  There is a MoDOT created report 
that simplifies the reporting and puts it in a format that’s easily used. 
1. From the Geometry > General Tools ribbon, expand Reports and select Horizontal 

Geometry Report 

 
2. Locate First Element:  Select each of the lines that you wish to report on 
3. Right-Click when Finished 
4. Left-Click to accept None for the Event Points option 
5. Left-Click to accept the None for Profile 
6. The Report will be generated.  In the left pane, expand MoDOT 
7. Click on the MoDOT_Pavement_Markings style sheet to display the Pavement Marking 

report. 
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10.7 Group Exercise – Ramp 4 Linear Markings 

In this exercise, we will work together in the class to place baseline and edge of pavement 
markings on Ramp 4.   

1. Open the file Corridors_Ramp-4_J5P3181.dgn from the data-10 folder. 
2. Hit F6 to show both 2D and 3D views (if not already displaying) 
3. Open the J5P3181.itl in the data-10 folder from the Corridors Tab  Template Tools  

Create Template . 

 
4. Check to make sure the Pavement Markings folder is in the list of folders.  This will also set 

the current ITL, so that we may choose the pavement marking templates. 

 
5. Review the current 2D and corridor view 
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6. Locate the first template drop (purple dashed line shown in step 3). From the heads-up 
display choose the Edit Template Drop tool. 

 
7. Once the Template Drop appears in the editor, locate the Pavement Markings folder on the 

left panel and expand it out. 
8. Expand 1 Lane (Ramps) 
9. For this exercise, we will place a 4” Yellow Baseline and a 4” White EOP.  Select the 4" 

White RT Edge -4" Yellow Baseline to show it in the Preview Pane. 
10. Drag this template to the editor window and Right-Click while dragging.  Select Reflect. 
11. Drop the pavement marking template off on top of the Conc_CL point (It will turn white) 
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12. The Pavement Marking point and the EOP point are placed in the middle of the roadway.  
We need to move the EOP point to be on top of the EOP point in the Ramp 4 template.  
Right-Click on the new point AsphSurf_T_EOP and select Delete Both Constraints. 

 
13. The AsphSurf_T_EOP point will turn Green.  This indicates all constraints have been 

removed. 
14. Right-Click over the AsphSurf_T_EOP point and select Move Point. 
15. Move the point over the top of LT_Conc_T_EOP 
16. Right-Click again over the AsphSurf_T_EOP and click Merge Points 
17. Select the AsphSurf_T_EOP to delete 
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18. Since the point has been merged, now the RT_4in_PM_Edge_White point will change it’s 
parent point to the LT_Conc_T_EOP.  You can double click on the 
RT_4in_PM_Edge_White  point and review the point properties to see the change. 

 
19. Close the Point Properties dialog 
20. Click OK to the Editor box 
21. View the 3D model to see the pavement markings appear on the pavement. 
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22. Since there are 2 templates in this corridor, we must make the change to the second template 
as well.  Locate the 2nd template’s purple dashed handle and open the Template Editor for 
that template. 

 
23. Repeat steps 7 – 20 for the 2nd template to add the pavement markings to the remaining 

Ramp 4. 

 
Note: The points in Template 1 and Template 2 are named the same and will report back as one 

element for the full length of the corridor.  If for some reason you want the pavement 
marking to be separated for quantities, simply rename the point for the pavement marking 
by adding a number to the end.  For example: Change the point name on Template 2 from 
Centerline_Solid_Yellow to Centerline_Solid_Yellow2.  This will separate them out.  
You would then need to add a Start Station value to the 2nd set of pavement markings.  For 
this example, you would change the Start Station to 2+50. 

 
24. Run the report for the Linear Markings.  Geometry Tab  General Tools Section  

Reports Tools  Horizontal Geometry Report. 
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25. Select the White EOP Pavement Marking line and the Yellow Baseline for Ramp 4. 

 
26. Right-Click to end the selection process 
27. Left-Click to accept None for Event Points 
28. Left-Click to accept None for Profiles to include 
29. The report will display. Review the report. 

 
30. Close the Report 
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10.8 Group Exercise – Ramp 4 Point Markings 
In this exercise, we will work together in the class to place Point Markings. We will use Civil 
Accudraw to accurately place each point marking and base elevation off Ramp 4 baseline profile 
elevations. 
1. Continue (or open if necessary) in the data-10/ Corridors_Ramp-4_J5P3181.dgn 
2. Hit F6 to show both 2D and 3D views (if not already displaying) 
3. Zoom in to the area of Ramp 4 
4. Start Civil Accudraw with Station/Offset option selected 

 
5. From Geometry Tab  Horizontal Section  Point Tools  Point 

 
 

6. In the Point dialog, set the following:  
a. Elevation Mode: Plan Element 
b. Elevation Offset: 0.5 
c. Rotation Mode: Relative to alignment 
d. Rotation: N00d00’00’E 
e. Feature Definition: Straight Arrow 
f. Name: Straight Arrow 
g. Description: Straight Arrow 

 
7. At the prompt Locate Elevation Plan Element select Ramp 4 Baseline 
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8. Accept the Elevation Offset of 0.5000 that has been entered into the dialog. 
9. At the prompt Locate Reference Element for Rotation  select Ramp 4 Baseline 

 
10. Set the Civil Accudraw to be based off the Ramp 4 Baseline.  Tab down to the Offset Field 

in Civil Accudraw and hit the letter O. 

 
11. At the prompt Select a reference element… select Ramp 4 Baseline 
12. In Civil Accudraw Key in 0+50 for the Station and hit Enter to lock it in 
13. In the Offset field key in -9 and hit Enter to lock it in 
14. Left click in a blank area to accept the key ins 
15. Left click to accept the rotation of N00d00’00”E based on Ramp 4 direction 

 
16. Repeat the necessary steps to place Straight Arrows at the following locations: 

a. Station 2+50 Offset -9.00’ 
b. Station 4+00 Offset -9.00’ 
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17. Place a Left Turn Arrow at Station 4+50 with an Offset of -9.00’ Rotation N90E 

 
18. From the Geometry Tab  General Tools Section  Reports Tools  Point Feature 

Station Offset Elevation Report 

 
19. At the prompt Locate Baseline Element select Ramp 4 Baseline 
20. At the prompt Locate First Offset Element select the 3 Straight Arrows and the Left Turn 

Arrow. 
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21. Right Click to reset and automatically open the report 

 
 

22. Zoom around the 3D Model to view the Pavement Markings on the corridor 
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